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WELCOME
At this time of year, with Christmas fading into distant memory and 
summer still a lifetime away, things can seem a little gloomier than 
usual. But cheer up, because this issue of Computer Arts is jam-
packed with creative projects that’ll keep the winter blues at bay. 

First off, leading illustrator Derek Lea shows you how to recreate 
this month’s stunning cover image – his take on the ancient and 
mysterious green man, a motif that’s been used in art, design and 
architecture for centuries. Read all about it on page 25.

Elsewhere, we reveal how to give illustrations some amazing 
Escher-like 3D perspectives (page 60), take a look at how to exploit 
translucent ink effects (page 54), catch up with French design duo 
Superdeux (page 32), and discover the secrets behind Shell’s 
enduring red and yellow corporate logo (page 48). 

If all of that’s not enough, break open the cover CD and get 
cracking with our Corel Painter IX starter kit, build your own 
interactive CD-ROMs using the superb multimedia tool iShell 3 
(page 66) and check out our selection of stock images from Flat 
Earth. For further details, turn to page 102. Enjoy!

GILLIAN CARSON SENIOR EDITOR
gillian.carson@futurenet.co.uk
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EDITORIAL

ILLUSTRATION IN THE MAG
DEREK LEA
A spritely reinterpretation of the green man motif, which 
delivers a suitably vernal theme to this month’s cover.
Derek used design heavyweights Photoshop and Painter
to add vital textured layers and subtly “age” his work.
INFO: www.dereklea.com
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BEAT 13
We said blow your own 
trumpet, and that’s just what 
the Brum-based boys did…
INFO: www.beat13.co.uk

MARTIN FEWELL
Martin’s striking overprint 
effects conjure up a day-glo 
retro-world to brilliant effect.
INFO: www.martinfewell.com

POCKET LABORATORIES
Flash animations with bona 
fi de character. See it and weep.
INFO: www.pocket
laboratories.co.uk

TWELVE:TEN
Why can’t non-US buyers 
benefi t from a crashing 
dollar? Twelve:ten sums it up.
INFO: www.twelveten.com

SCOTT HANSEN
This month’s workstation 
Group Test is graced by the 
presence of a large crow…
INFO: www.iso50.com

LIANE WILCHER
Liane’s trademark skewing 
of familiar landmarks here 
takes on The Albert Hall.
INFO: liane.wilcher@virgin.net

BLACKPOOL AND 
FYLDE COLLEGE
Our expert hand picks new 
student talent – see p112.
INFO: www.blackpool.ac.uk

RICK LECOAT
Rick’s stylish movie player 
was built entirely in iShell, 
provided free on our CD.
INFO: www.sharkattack.co.uk
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P78 PHOTOSHOP ELEMENTS 3
This wallet-friendly, streamlined version 
of Photoshop will prove ideal for novices

P80 POPCORN 1.0
Slick cover-design software adds life to
an otherwise so-so DVD copying app

P81 EYE CANDY 5 NATURE
More terrifi c fi lters from the Alien Skin 
stable – Snow Drift is our particular fave

P82 TWIXTOR PRO 4.0
Create slow-mo/super-fast DV footage 
with the help of Re-Vision Effects’ plug-in

P83 MIMIC PRO 3.1
An affordable and effective lip-synch tool 
for pro and amateur character animators

P84 LEXMARK X7170
A keenly priced all-in-one printer, 
scanner and fax, ideal for everyday use

P85 CHARTBOT
This sterling plug-in whips up fi ne-looking 
charts and graphs in XPress or InDesign

P87 BOOKS
Everything you need to know about 
furniture and product design but were 
afraid to ask, courtesy of The Design 
Encyclopedia, plus other tomes

P88 WORKSTATIONS
Five specially tailored top-of-the-range 
PCs – the 3D Boxx, Precision 670MT,
3D Workstation, IntelliStation and RM 
Workstation – prepare for combat…

WHAT’S HOT 
AND WHAT’S NOT?

LEARN THESE GREAT 
TECHNIQUES

FIVE TITANS BATTLE
FOR THE TOP SPOT

070

040

064
UNIVERSITY 
CHALLENGE P112 
NEW! One brief, fi ve students. 
Find out how a group of aspiring 
young designers responded to 
a tricky creative challenge...

REVIEWS TUTORIALS

GROUP TEST

    
WHAT’S HAPPENING 
IN YOUR INDUSTRY?

FEATURES

032

P54 GET OVERPRINTING
Use Photoshop’s Overprint command 
to create vivid transparency effects

P60 PERSPECTIVE TRICKS
Reinvent The Albert Hall with digital 
photos, sketches – and Photoshop

P64 TOOL TIPS
NEW! Derek Lea advises on how to 
customise brush presets in Photoshop 

P66 CD TUTORIAL
Create your own mini movie player 
with the help of iShell 3, free on our CD 

P32 CA INTERVIEW
“Everything is heavily tinged with fun 
and irony – we enjoy combining a cute 
design with violent ideas,” Gallic design 
studio Superdeux admits

P48 ICON
The Shell logo: We trace the genesis
of what is arguably the petrochemical 
industry’s most striking logo

P70 GET STARTED WITH...
Self-promotion: Simple techniques to 
help you build up a great client base

P114 CURRICULUM VITAE
David Gentry: David is drawn to the 
macabre. No wonder Francis Bacon 
and Salvador Dali inspire him

NEW 
SECTION
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PAINTER IX STARTER KIT (MAC+PC)
Everything you need
to get started with
Corel’s multi-purpose
natural media and
illustration software

iSHELL 3 (MAC+PC)
The full multimedia 
CD-ROM creation tool
– turn to page 66 for 
an in-depth tutorial

TWIXTOR (MAC+PC)
Incredible slow-motion video plug-in

EYE CANDY 5 NATURE (MAC+PC)
Superb Alien Skin Photoshop fi lter-set trial. 
Includes fi re, smoke and fantastic snow

MIMIC PRO 3.0 (MAC+PC)
Create realistic facial animations and vowel-
perfect lip-synch with this powerful app

See page 102 for more details...

THIS ISSUE’S
SOFTWARE & 
RESOURCES

Turn to page 46 for full 
details of great savings

SUBSCRIBE NOW! 

ON THE CD

026

GET OVERPRINTING
Translucent inks can add incredible vibrancy to

your work, as Martin Fewell demonstrates with
this overview of Photoshop’s Overprint command

PAGE 54 Ë

PERSPECTIVE
TRICKS 
Break the rules with this bold, twisted vision of 
The Royal Albert Hall, as Liane Wilcher exploits
the power of Photoshop and collage

ÁPAGE 60
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Send your work to Computer Arts and be seen by thousands! 
EXPOSURE

RYAN FORSHAW
LOCATION  Manchester, UK
JOB  Retoucher & image maker 
CONTACT  www.ryuneo.com
SOFTWARE  Photoshop 7 

Ryan Forshaw started “playing around” 
with digital imaging when he was fi rst 
introduced to Paintshop Pro 6. A friend 
suggested he try using Photoshop 
instead back in 2003 and since then 
there’s been no looking back.

Forshaw believes that it’s the skills he 
has learned from books, magazines and 
websites that have enabled him to 
develop his design work and, in turn, 
“work with the big boys”. “I’m pretty 
much self-taught, but I have so much 
more to learn,” he says. 

“With the resources available today 
covering Photoshop techniques and 
design training I think anyone with a 
little talent can become successful. You 
just need a bit of luck – for the right 
person to see your work.”

So from where does he draw his 
inspiration and how does he like to work? 
“When I get a job, I look at the brief and 
then use Google to search for keywords 
from within that brief,” he says. 

“Once I have a few ideas up my sleeve 
I get to work. The re-touching process is 
hard to describe, as once I get started on 
a piece one thing just fl ows into another 
until the fi nal piece looks complete. The 
hardest part is knowing when to stop.”

1

2

3
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EXPOSURE

To fi nd out more about this section, please 
go to www.computerarts.co.uk/gallery/

1. Waterleaf  “I was inspired to create this image by an Echner piece 
called Dewdrop, 1948. I wanted to create a metallic leaf with the illusion 
of butterfl ies emerging from droplets of water.”

2. Blue Healey  “With this image I wanted to create a scene that 
refl ected the coolness of the blues in the car. A dark blue sky was 
chosen to enhance the exhaust fumes and in turn illustrate how cold 
the scene was.”

3. Red Healey  “I created this piece for a classic car website. I placed the 
car on a dark mountain scene with a dramatic red sunset so that the 
colours of each element complimented the other.”

4. Autumn Face  “This image was created for a digital photography 
magazine. Her skin had a leaf texture applied to it and part of her face 
was blended into the tree to combine all the elements. I used a variety of 
blending modes and layer masks to combine the elements together. 
I fi nd that these are the most powerful Photoshop tools when you’re 
attempting to create realistic composites.”

5. Fuse Time  “I created this camera image to illustrate the theme 
“time”. The theme was represented by the fuse slowly burning down to 
the camera across each section of the fi lm strip.”

4

5
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MICHA LEESE
LOCATION  Cheltenham, UK
JOB  Illustrator & fashion assistant
CONTACT  www.mochi1045.com
SOFTWARE  Photoshop 7

1. Milky Flavour  “I created this image 
by scanning original sketches into 
Photoshop and then adding colours 
and new elements. To achieve the 
deep-layered effect I printed the image, 
reworked on top of it, printed it out 
again and then scanned it once more.”

2. Kumera Chips  “This piece, created 
after travelling through New Zealand, 
is based on the joy of fi nding new foods 
and connecting each memory with 
those foods. Kumera chips (sweet 
potato) remind me of being on the road, 
being free, happy, and a little lonely.”

3. Tiger Style  “Tiger Style was created 
using paint, stickers and tape. I then 
added characters from Micha’s World – 
children’s books that currently make 
up part of my personal work.” 

4. Dirge “This image combines mixed 
media. Acrylic varnish, transfer paper 
and staples were scanned into 
Photoshop to achieve a layered, 
textured effect.”

5. Grandpa Bear “This design is being 
used in a range of limited edition 
T-shirts available soon from my website. 
It started with a sketch scanned from 
my sketchbook. I then coloured and 
cleaned it up in Photoshop.”

1

2

3

4

5
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Send your work to us, along
with an explanation of your 
techniques and software, 
the titles of each piece, your 
website details and email 
address. Images should be sent 
as PC or Mac TIFF or JPEG fi les, 
on CD or DVD. A hard copy is 
also a great help. We will 
endeavour to return all entries 
that provide an SAE. All 
contributions are submitted on 
the basis of a non-exclusive 
worldwide licence to publish, 
both in print and electronically. 
Post hi-res fi les for print to:  
Exposure, Computer Arts, 
30 Monmouth Street, 
Bath, BA1 2BW.

1

PETRA STEFANKOVA 
LOCATION  Slovakia 
JOB  Graphic designer & illustrator
CONTACT  
www.illustration.animacia.sk
SOFTWARE  Illustrator, Photoshop, 
InDesign and Corel Draw 

1. Allianz  “For this calendar 
illustration for Allianz I used a well-
known symbol of luck – a chimney 
sweep. I hate boring commercial 
calendars, so I decided to create 
something that everyone would 
want to hang on their wall.”

2. On the Beach  “I created this 
image on a cold winter’s day when 
I longed for intensive warm 
sunshine and energy. The process 
made me feel much better!”

3. On Guard  “I decided to create a 
series of images using a different 
idea, but the same creation principle, 
mood and colours as On the Beach 
(3). Sometimes I start with a pure 
circle, rectangle or square, then 
duplicate and modify them until I am 
happy with the result.”

4. Macha Styri  “These illustrations 
form part of my children’s picture 
book about the relationship between 
cat, dog and mouse. At the start 
each one loves the other, but the 
situation soon changes for ever.”

2

3

4
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SOFTWARE POLITICS
My software vendor told me that it’s no 
longer possible to upgrade my German 
version of 3ds max 4 to 3ds max 7. Why
is this? Although I only use it once or twice 
a month, it was my favourite program and 
I invested so much money last year on 
expensive updates and functions. Today, it 
seems, my 3ds max software and 3ds max 
know-how is worthless.

So now I’m forced to switch to other
3D applications, such as Messiah: studio 
(which is cheaper), and continue using 
Pixologic’s great ZBrush. Can you explain 
what’s going on, please?

I’m intrigued to hear what you think 
about all this software politics!
Thomas Heidenberger, 
Munich, Germany

+ Discreet spokesperson Alex Micallef  
responds: I’m sorry that any confusion has 
arisen over this, Thomas. It’s entirely 
possible to upgrade from 3ds max 4 to 3ds
max 7. The German version of 3ds max 7 
has been available since mid-December 
and is receiving fantastic feedback from 
our customers. Upgrading to 3ds max 7,
you’ll see a great deal of difference in the 
application that has developed over the four 
years since 3ds max 4 was released. The 
price of the upgrade is 1,750 euros 
(plus any applicable local taxes).

I’ve just spent the last three days extracting 
the fonts from the cover CD of Computer

Arts Projects 66 – The Typography Issue. Much 
of this time was spent reading the same 
convoluted licensing agreements...

I have some 15,000 fonts installed on my 
computer, and I’m sorry but when I’m working 
on a project I cannot mess about trawling 
through folders, websites and email addresses to 
get the necessary permission, or make sure my 
$5 goes to whoever it’s supposed to. For this 
reason, anything that didn’t say I could use it for 
commercial purposes, I just deleted.

Yes, I believe in shareware and, yes, we need 
to support and encourage artistic talent, but why 
don’t these people just get together, put their fi les 
on a CD, and sell it for $10 (or however much 
they want)? Surely it’s better to sell the lot for 
$10, whether or not people are going to use 
them, rather than ask the same amount for a 

particular font when someone suddenly fi nds 
they have a use for it?
Mark Taylor, Essex, UK

+ Computer Arts
Mark, you have a good point, but those licences 
are there for a reason. Font creators are creative 
designers who often earn a living from their 
work. Some of the fonts on our cover CD 
would’ve been a real labour of love, so a 
donation to support the designers’ work is
hardly too much to ask. However, we do agree 
that font designers would defi nitely benefi t
from “teaming” up. In fact, this is how most
type foundries are formed – when a group of 
like-minded font designers get together to 
showcase their work as a collective.

STAR LETTER: NO TIME FOR SHAREWARE LICENSING

As the Star Letter winner this month, Mark Taylor has won a copy 
of Rookledge’s Classic International Typefi nder, by Christopher 
Perfect and Gordon Rookledge. Highlighting the essential 
characteristics of over 700 typefaces, this book helps designers to 
identify many of the most popular fonts currently in use across 
the globe. Rookledge’s Classic International Typefi nder is 
published by Laurence King and costs £24.95.

PRIZE: Rookledge’s Classic International Typefinder

IT’S A DESIGNER’S LIFE…

You can buy Brad Guigar’s new book, The Everything Cartooning Book, at www.everythingcartooning.com
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  NEXT ISSUE IN
PHOTOSHOP • SOFTWARE • TUTORIALS • NEWS • REVIEWS

ON SALE THURSDAY 17 MARCH

TRIPPING THE
LIGHT FANTASTIC
Transform your art from dowdy work-in-progress to fi nely lit 
masterpiece with the help of our expert Photoshop tips and techniques 

All contents are subject to change

PLUS...
NEWS ALL THE TOP STORIES AND RELEASES
REVIEWS TOP PRODUCTS TESTED IN OUR LAB
TUTORIALS 26 PAGES OF THE BEST EXPERT ADVICE
FREE CD JAM-PACKED WITH RESOURCES AND SOFTWARE
PROFILES EXPERT DESIGNERS REVEAL THEIR SECRETS
EXPOSURE BE INSPIRED BY OTHER READERS
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TYPOGRAPHY ISSUE
You asked for feedback from the 
Typography issue of Computer
Arts Projects 66. In a word: 
fantastic! As the most basic 
staple of design, typography 
needs covering more than most 
subjects, particularly as it has 
been around the longest and is 
now, in the main, ignored.

I’ve had several type designs in my head for years and this issue 
made me sit down with a pad and draw them out, using many of the 
tips in your mag. I now have around ten distinctive new designs, 
although it’s funny how you start seeing “your” designs in existing 
typefaces soon afterwards.

I look forward to more typography specials soon.
Philip Jansseune, Bristol, UK

+ Rob Carney, editor of Computer Arts Projects, responds:
Thanks for your comments, Philip. Why not put your designs to 
good use and enter our Monotype competition, where you can win 
the entire Monotype collection, worth £2,999? If you wow the 
judges, your font could be included with the collection, joining the 
likes of Gill Sans, Cartier Book, Mundo Sans and Baskerville.
See www.computerarts.co.uk/competitions for more details.

CA FORUM FANATIC
This month, we wanted to 
showcase the work of new 
forum member Corvus Flies, 
aka Melanie West of Maine, 
New England. Melanie is a dab 
hand with Corel Painter and 
created this image of a rusted 
car which reminds us of the 
work of Edward Hopper. 
Nice one, Melanie – and we 
hope you enjoy this month’s 
Painter IX starter kit, included 
on the cover CD. Check out

 www.melanieweststudio.com.

CORRECTIONS
We’ve been asked to point out a few inaccuracies within our reviews 
of NewTek Video Toaster 4 and LightWave 8, printed in issue 105. 
The LightWave review listed a special offer price of £995. The 
correct price is £1,056. We also said that LightWave was launched in 
1995, when it was, in fact, launched in 1989. Please also note that 
shadow caching feature was actually added in version 6.0. Finally, 
our review of Video Toaster stated that the original Video Toaster
could be run on Amiga emulators, which it cannot.
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Despite being noticeably 
light on announcements 
from the major creative 
software houses, Macworld 
San Francisco, the early 

highlight of the 2005 Mac calendar, had 
plenty to get the faithful frothing at the 
mouth, as well as some shrewd tactical 
launches designed to strengthen Apple’s 
market position and persuade as many PC 
users as possible to cross to the other side.

Away from the headline-grabbing iPod 
shuffl e, the loudest cheers during Steve Job’s 
Macworld keynote rang out for the budget 
headless Mac mini, costing just £339. Many 
believe this impressive piece of kit will be 
crucial to Apple’s future success, specifi cally 
in terms of wooing iPod-using PC owners 
and cautious consumers previously put off 
by the cost of the Mac platform. 

“People who are thinking of switching 
will have no more excuses,” said Jobs. “It’s 
the newest and most affordable Mac, ever.”

But not everyone is convinced. Some 
market watchers are already warning that the 
headless computer is far more 
expensive than its light-weight 
price-tag suggests.

“I don’t think it changes the 
world,” said Brian Gammage, 
vice-president of research at 
analyst group Gartner. 

“Although this is cheap for an Apple 
computer, it’s still expensive compared to 
many PCs which come with a monitor, 
keyboard and mouse.”

Aside from the hardware, Jobs also 
announced an overhaul of iLife and some 
interesting new features for iWork – among 
them a new app named Pages, which aims 
to help users create well-designed 
documents and appears to offer similar 
functionality to low-end, consumer-
orientated graphics packages.

Other announcements lost in the iPod 
shuffl e and Mac mini furore include an 
overhaul of Final Cut Express. The software 
has been given High-Defi nition Video 
compatibility and direct timeline support for 
Apple’s recently released Motion application. 

One announcement still notable by its 
absence, however, was our old friend the G5 
Powerbook, which, according to the Apple 
fansites, is either way down the agenda or 
due to make an appearance during the 
second quarter of the year. Watch this space.
INFO www.apple.com/uk
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  ONLINE HEAVEN
THIS MONTH’S ROUND-UP OF
THE GREAT AND GOOD ONLINE

AGAPE CHURCHES
www.agapechurches.org
Now here’s an unusual way to get 
designers interested in religion. Agape 
churches have ministries throughout a 
number of US colleges and universities 
and clearly know how to market to a 
young, design-savvy audience. This is 
religion, 21st-century style. Hallelujah!

FANTASTIC FOUR 
www.fantasticfourmovie.com
Another year, another blockbuster and 
massive marketing campaign. A sci-fi  
Flash intro sets the scene and the rest 
of the site is crafted with the production 
values you’d expect from a mega-
budget movie. Whether the fi lm’s a hit 
or not, the site has caught our attention. 

PHOTOS.COM
www.photos.com
Royalty-free stock image libraries are 
ten-a-penny, but Photos.com runs an 
interesting subscription-based service. 
You can either pay per download or 
subscribe to an “all you can eat” monthly 
service and download at your leisure… 
The choice, as they say, is yours.

PITCHFORKMEDIA
www.pitchforkmedia.com
Pitchfork media is a leftfi eld music site 
that successfully marries great design 
with strong editorial. The website is 
jam-packed full of content to take in, 
but thankfully it’s all easy to read, 
thanks to a really clean layout and 
sympathetic colour scheme.

BLAU GALLERY
www.blaugallery.com
If you’re looking to buy the best in 
contemporary photography and 
illustration, check out the Blau Gallery. 
Featuring works from Computer Arts 
regulars Scott Hansen and Simone 
Legno, this is a great site if you’re after 
a little something to brighten your walls.

ALSOP ARCHITECTS
www.alsoparchitects.com
Visionary architect Will Alsop has hit 
the UK headlines with his controversial 
visions for a new Metropolis in the 
north of England. Take a look at the 
more grand designs on display on his 
ironically unassuming website.

Mac frenzy
MACWORLD Steve Jobs uses a keynote address at Macworld San Francisco to 
unveil some impressive new kit, but there’s still no sign of the G5 Powerbook

The Mac mini: 
“the newest and 
most affordable 
Mac, ever”.
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This month’s predicted multiplex blockbuster – the 
Dennis Quaid-starring action adventure remake of 

Flight of the Phoenix – will feature stunning visual effects 
work courtesy of US CG wizards CafeFX. 

Exploiting some back-breaking particle animation work, 
one of the movie’s most exciting and visually impressive 
scenes – a terrifying sandstorm and plane crash sequence – 
proved particularly challenging. The CafeFX team relied on 
3ds max, LightWave and a Sitni Sati d.o.o AfterBurn plug-in 
to pull off the shots required.

“The sandstorm comprised some 59 shots, which CafeFX 
animators in Santa Maria and Santa Monica handled in 
tandem,” says CafeFX’s visual effects supervisor Scott 
Gordon. “One of our biggest challenges was to make the 
plane visible through a solid wall of sand. Director John 
Moore and vfx supervisor David Goldberg wanted to have a 
cavernous look inside the storm, with walls of cloudy sand. It 
needed to look claustrophobic and dangerous, yet depict all 
the important action taking place.”
INFO www.cafefx.com

› GOOD MONTH 

New faces at the top Both Adobe and 
Macromedia have been busy recruiting for their 
top jobs. Shantanu Narayen takes up the 
presidential position at Adobe, while Stephen 
Elop becomes CEO at Macromedia.

How very non-PC Macromedia’s web design 
technology will soon be coming to a digital 
display near you after embedded systems 
specialist Vibren signed a deal with the 
company to use Flash in a wide range of non-
PC devices.

fi BAD MONTH 

The suing of Nicholas Ciarelli 
The creative industry’s favourite tech company 
has suffered a serious sense of humour failure 
and sued the 19-year-old editor of Apple fansite 
Think Secret over its spot-on pre-Macworld 
product announcement scoops.

Software pirate is jailed US-based pirateer 
Kishan Singh has been sent to prison for 18 
months and had computer equipment seized 
after he was found guilty of distributing pirated 
Adobe and Macromedia software worth an 
estimated $120,000.

Qwerty’s days are numbered The 130-
year-old keyboard layout standard is under-fi re 
from a US manufacturer which has developed 
an alphabetical alternative with just 53 keys 
instead of 101. The company claims the current 
universal keyboard design is outdated and was 
actually developed to slow fast typists down. 

‹ AND FINALLY 

Watch this space Enterprising graphic 
design student Andrew Fischer from Nebraska 
has hit upon the idea of making an innovative 
move into marketing by selling the space on his 
forehead for advertising purposes to the highest 
bidder on eBay. Surely there are easier ways to 
make a quick buck?

THE MONTH 
IN BRIEF
This month’s creative winners 
and losers, plus how one graphic 
design student is paying his way 
through college

With HP’s recent moves to develop paper-like 
displays well underway (see Computer Arts
issue 104), monitor giant Samsung has 

unveiled more technology fi rsts with both the world’s 
largest plasma monitor screen and a fi ve-inch (127mm) 
transmissive plastic TFT-LCD display for portable 
applications such as mobiles and notebooks.

Samsung’s plasma behemoth measures a staggering 
2.2x1.3 metres – some 255cm across the diagonal (near 
enough 100 inches!) – delivering a resolution of 
1,920x1,080 pixels. Presuming your offi ce or living 
room is big enough to accommodate it, the screen 
should be commercially available before this summer.

Samsung says that the technology for its fi ve-inch 
screens was developed by replacing the glass 

traditionally used in TFT-LCD 
screens with pliable plastic. Samsung predicts that the 
technology will appear in wearable displays, such as 
helmets, glasses and other fashion accessories.
INFO www.samsung.com

Little and large

Quark’s plug-in development 
community has been given a leg-up 

by the company with the introduction of 
QuarkXPress Markup Language (QXML) 
in a bid to make it easier for developers 
to create custom add-ons.

Quark’s decision to open-source the 
QXML scheme will lead, it hopes, to the 
development of more third-party 
XTension modules to widen the use of 
QuarkXPress and meet the needs of 
designers using the software.

The QXML Developer Kit is available 
immediately to certifi ed QuarkXPress 
XTensions developers.
INFO www.quark.com/partners/
xtdevelopers/desktop/requirements.
html

PASS THE SOURCE
SOFTWARE Quark throws open code for XTension builders

Rising from the ashes
FILM Special effects giant CafeFX pulls out all the 
stops for an amazing crash sequence

DISPLAYS Samsung takes the wraps off
exciting monitor technology developments 
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3D ANIMATION
POETRY IN MOTION
UK-based NaturalMotion has released 
endorphin 1.6, a 3D animation software 
package that delivers new and enhanced 
adaptive AI behaviours and a fully user-
defi nable character. In addition, video plane 
back projection and camera data import will 
allow you to see your endorphin characters as 
they interact with live-action footage in real 
time. endorphin 1.6 is available from $12,795.
www.naturalmotion.com

DIGITAL IMAGING
STITCHER EXPRESS
RealViz has announced the release of a 
Stitcher Express, an app aimed at pro and 
amateur photographers to help with the 
creation of panoramas from digital images. 
Stitcher Express is fully compatible with both 
Photoshop and QuickTime and is available in 
French and English for 99 euros (excl. VAT).
www.realviz.com

3D MODELLING
ANOTHER DIMENSION
Start-up company Creative Dimension has 
sealed a successful licensing deal with Canon 
to sell its 3D Software Object Modeller 
(3DSOM) technology, which enables 3D models 
of a real object to be created from digital photos 
for use on websites or other multimedia 
projects. Creative Dimension Software Ltd has 
already released a new upgrade featuring an 
improved model generation engine.
www.3dsom.com

MOTION GRAPHICS
APPLE MOTION PLUG-IN
Motion graphics specialist Boris FX has 
announced that its Continuum Complete 3.02 
now supports Apple Motion 1.01. The release 
is available as a free download for existing 
users of Continuum Complete Version 3 and 
offers over 150 
fi lters. The plug-in 
is on sale now 
for $795.
www.borisfx.com

ASSET 
MANAGEMENT
LOOK AFTER THE FONTS
Inside Software has upgraded its Font Agent 
Pro font management suite with release 3.0. 
New features include live searching and fast 
fi ltering of font metadata, user-confi gurable 
start-up sets and a new interface design. 
Available now for $99.95.
www.insider software.com

SOFTWARE

COMPETITION Microsoft throws open its doors to student innovation 

APPEAL Design industry puts weight behind charity book project

Tsunami disaster relief
UK-based design agency 
iLovedust and the 
respected graphics publisher 

Die Gestalten Verlag have teamed up 
to produce a book to raise money for 
victims of the Asian tsunami disaster. 

The book, currently entitled
Designed to Help, will feature 
illustrations, design work and art from 
a huge number of designers already 

lining up to help out, including the 
Designers Republic, Unit 9 and Tado. 

“Our idea is to produce a book of 
graphic design, art and illustration 
and we have received an 
overwhelming response,” iLovedust 
told us. “With this kind of support, 
we feel confi dent the project will be a 
total success.” 
INFO www.designedtohelp.co.uk

NEWS

There’s a cool, mathematical feel to Futura, a 
typographic family that seems to go in and out of 
favour in the States every couple of years. It’s 
amazing how a single, well-executed use can 
immediately ripple through the world of commercial 
and advertising design. 

The outline version of a lighter weight of Futura in 
all-caps that was used in the main logotype for Wes 
Anderson’s fi lm The Life Aquatic is in its ascendancy 
at the moment. You fi nd it on coffee cups, in 
magazine ads and on outdoor advertising boards, 
mainly in white against deep jeweltones. It certainly 

has an “of the moment” feel. But what does this 
mean? Perhaps it’s the ultra-ironic nature of The Life 
Aquatic that art directors are winking at, 
demonstrating their detachment from the work they 
produce, or maybe it’s the utilitarian nature of the 
face, the way it can pick up a personality or voice 
from virtually any surrounding context. 

Whatever the reason, Futura is totally inescapable 
right now, and the fact that I’m writing about it here 
in Chicago, means you’re probably too late to use it 
without seeming like you’ve missed the boat.
INFO www.coudal.com

GLOBAL UPDATE In the fi rst of our 
monthly reports from design gurus across 
the globe, Jim Coudal of Chicago-based 
design group Coudal Partners extols the 
virtues of the delectable Futura

Caroline Phillips, academic audience 
marketing manager for Microsoft UK.

Dissolving the boundaries

Microsoft’s Imagine Cup student competition, which recognises and rewards 
technology-connected innovation, is underway once again with prize money 

of $215,000 up for grabs and global fi nals scheduled for Japan in July 
This year’s broad range of categories includes web design, visual gaming, 3D 

rendering and short fi lm – with the theme “dissolving the boundaries between us”.
“The ability to combine creatively the art and science of telling a story is a very 

valuable skill,” says Caroline Phillips, academic audience marketing manager for 
Microsoft UK (pictured left). INFO www.imaginecup.co.uk 
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ASSOCIATION OF ILLUSTRATORS
LOUGHBOROUGH, UK
9 March, £15-£35
Seminar entitled “How to Survive as an 
Illustrator”, which provides in-depth 
information on all aspects of setting up a 
small business as a professional 
illustrator. Features details of how to 
promote your work, practical advice from 
art directors and the pros and cons of 
having an agent.
www.theaoi.com

FOCUS ON IMAGING
BIRMINGHAM UK
27 February-2 March, £6
Big annual imaging show, covering 
amateur and professional imaging, from 
capture through to output and beyond. 
Over 200 exhibitors and product launches 
galore – including all the very latest digital 

cameras and processing equipment.
www.focus-on-imaging.co.uk

GAME DEVELOPERS CONFERENCE
SAN FRANCISCO, USA
7-11 March, $150-$1,575
Enormous gaming industry hoe-down, 
conference and networking event, staged 
“by gaming developers for gaming 
developers”. Features over 300 lectures 
and panel discussions, plus an exhibition 
featuring current game development 
tools, platforms and services.
www.gdconf.com

COMGRAPHICS AND ANIMATION
SINGAPORE
14–17 June
Asian international trade showcase for 
computer graphics and animation 
techniques, products and services 

featuring a full conference programme 
and massive exhibition. 
www.biztradeshows.com/trade-events/
com-animations.html

ADOBE LIVE
BUSINESS DESIGN CENTRE, 
LONDON, UK
26-27 May
Following last year’s successful event, 
Adobe is setting up camp in the Business 
Design Centre for two days of training, 
speakers and break-out sessions for the 
creative professional.
www.adobe.co.uk

GLOBAL EVENTS 
Our round-up of design events worldwide
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  HARDWARE
STORAGE
BIG UP LACIE
Storage specialist LaCie has unveiled the 
Biggest F800 RAID subsystem – new hardware 
offering secure storage for up to 2TB data. The 
four-bay tower supports RAID levels 0, 0+1, 5 
and RAID 5 and features FireWire 800 and USB 
2.0 interfaces for use on Mac or PC. The 
Biggest starts at £1,059 for a 1TB model. 
www.lacie.com/uk/products/product.
htm?pid=10595

NOTEBOOKS
CHEAPER VAIOS
Sony has refreshed its range of VAIO notebooks, 
with a number of models aimed at the lower 
end of the market. The FS Series feature 
multi-format double-layer DVD drives, nVIDIA 
GeForce graphics capabilities and a slimline 
design. Prices range from £899 for the VGN-
FS115E to £1,344 for the VGN-FS195XP.
www.sony-europe.com

ACCESSORIES
CONTROL FREAK
Those who spend time 
watching DVDs and 
listening to music on 
their laptops are set 
to receive a gentle 
helping hand following 
the launch of Trust’s 
Multimedia Remote Control NB-5100P. With 
an infrared range of seven metres, Trust’s 
device costs just £20, but only works with PCs.
www.trust.com

CAMERAS
NEW FROM KODAK
Kodak has announced two new models 
designed to replace the DX7590 and DX6490. 
Both the 5-megapixel Z740 and the 4-
megapixel Z700 come with a 10x optical zoom 
and 5x optical zoom respectively, and are 
available as bundled options with the new 
EASYSHARE Printer Dock Series 3. Both 
cameras are available next month from £180.
www.kodak.com/go/easyshare

PRINTERS
PRICEY BUT PROFESSIONAL
EFI and Xerox Corporation have launched the 
high-end Xerox Phaser EX7750 colour laser 
printer, which is targeted at graphic arts 
professionals who need to produce complex 
colour documents, fast. The bundled Phaser 
EX7750 system includes the EFI Fiery EX7750 
colour server and Xerox Phaser 7750 colour 
printer for an estimated retail price of $17,899. 
www.xerox.com

Web designers ignore disability rights

Web designers are still failing to take into account 
disability discrimination laws passed last year 

when building new sites, an accessibility testing group 
has claimed. SciVisum says the problem is getting so 
bad, a two-tier internet is starting to emerge, comprising 
websites working with multiple browsers and those 
designed only to work with Explorer 6.0.

“Web designers are building increasingly complex 
sites optimised to work on a specifi c browser, typically 

Internet Explorer. Inevitably, the viewing experience is 
reduced with other browsers and so sites are 
increasingly locked down to work with limited browser 
types,” said Deri Jones, CEO of SciVisum.

Jones says designers must develop sites for “lowest 
common denominator” browsers and meet the needs of 
all visitors. “The basic tenet of accessible website design 
is that sites should be usable by the widest range of 
users,” he says. INFO www.scivisum.co.uk

NEWS

PROCESSORS Graphics capability of key Intel Centrino chip 
benefi ts from vital boost

Graphics chips on the move

Intel has promised its much 
trumpeted and improved Intel 

Centrino platform for notebook 
computers will boost performance 
benefi ts for both home and 
commercial users, particularly for 
those dealing with graphics.

First launched in March 2003, 
the Centrino platform is made up of 
a processor, chipset and wireless 

board. The new 915 Express 
chipset, previously code named 
Alvis, supports DDR2 (double data 
rate 2) memory, a new standard that 
promises to greatly improve speeds.

In terms of graphics, Intel says 
its own benchmarking tests have 
charted a 91 per cent improvement 
in performance. Just watch it go.
INFO www.intel.com

WEB DESIGN “Two-tier” internet develops as accessibility issues continue to lock out some users
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Computer Arts: What is the thinking 
behind Born Magazine?

Gabe Kean: Our focus is on collaboration. 
As an organisation, Born’s goal is to bring together 
talented people who don’t normally mingle in the 
same creative circles. We push them to work closely 
together to create experimental arts projects. 

CA: Who contributes to Born?
GK: Poets, short-fi ction writers, copywriters, 
interactive designers, programmers, musicians, 
fi lmmakers, animators, and more. Most of the pieces 
we have published online are collaborations between 
designers and poets, but we are now expanding our 
list of contributors to produce projects for public art 
installations. Help Wanted: Collaborations in Art is 
the best example of this.

CA: What’s the main difference between the Just 
Born section and The Birthing Room?
GK: The Just Born pieces are collaborative 
interpretations of poems and prose, in which the art 
team will use the written piece as a starting point. 
In The Birthing Room, we pair writers and artists 
to work from scratch. They propose a concept, 
and everything is written and developed to support 

that concept. This usually involves experiments in 
storytelling and with interactivity.

CA: How do you choose which artists will work 
with which writers for a project?
GK: We look at the artists’ past work and then make 
combinations that we think will output something 
new and unexpected. Admittedly, it’s an intuitive 
approach about who will work well together. It’s 
very similar to match-making in the dating context. 
You put people together who you think will gel.

CA: What do you think the various digital media 
have to offer the storytelling process?
GK: Interactivity and rich media are the biggest 
factors. Our hope is that new art forms will emerge 
from this experimentation. Writers get a chance to 

see their text turned into cinematic or participatory 
experiences, and artists have the chance to explore 
the still young web medium without boundaries.

CA: What plans do you have for the future as 
Born Magazine grows?
GK: Born has more plans to expand its reach 
beyond the World Wide Web. Help Wanted: 

Collaborations in Art is our fi rst step towards this. 
We see ourselves as an entity that will stir things up 
in both the literary and art worlds by bringing our 
ideas to a wider audience.

CA: Rob [Corradi], how did you get involved 
with Born Magazine?
Rob Corradi: I’ve had a long-held hope that I’d 
contribute a piece to Born Magazine one day. All 
the online people I’ve found infl uential have been 
involved at one point or another, so when I was 
asked to contribute, it was a real honour. I worked 
on interpreting Farah Marklevits’ How They Sleep.
The poem explores a romantic relationship in 
which the man and woman are not communicating. 
This breakdown affects them in different ways, 
and carries over into their sleep. I wanted to avoid 
representing the couple themselves in any way, so I 
could concentrate on the visions within their dreams. 

CA: How did you go about creating your piece?
RC: The imagery was created mostly from my 
own digital photographs, retouched in Photoshop,
with additional elements sourced via various stock 
libraries or rendered in 3ds max where required. 
I used a fractal music program to generate the 
soundtrack and to give it a disharmonious sound. 
This helps to emphasise the characters’ distance 
and confl ict. The other benefi t of fractally-generated 
music is that it’s copyright free!

INFO For more information on the brilliant 
Help Wanted: Collaborations in Art, visit  
www.bornmagazine.org/helpwanted.

“Admittedly, it’s an intuitive approach about
who will work well together. It’s very similar
to match-making in the dating context”

MAIN IMAGE 
(AND BELOW): 
Illustrations by
Rob Corradi – his 
interpretation of
Farah Marklevits’ 
How They Sleep.

 Born Magazine
Computer Arts talks to Gabe Kean, art director of Born Magazine, a new online collaboration between
writers and designers, and Preloaded’s Rob Corradi about his artistic contribution to the project

DESIGNER TALK GABE KEAN
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When new stuff comes out for my 
Mac, I want it, even if I don’t need it 

– or know I can’t afford it for that matter. 
Whenever there’s the slightest whiff of a 
system upgrade in OS X’s Software Update 
panel, I check it every fi ve minutes, and I’m 
proud to declare that I have one of the most 
up-to-date systems around. I always have the 
latest version of my core software: Adobe 
CS, Macromedia MX, Microsoft Offi ce,
even if that means fi le confl icts with users 
who are more leisurely about their upgrades.

It’s the same with hardware. When the 
“cheese-grater-from-space” G5 came out, 
I wanted one, even though my G4 was doing 
a perfectly good job. So I invented an excuse. 
I announced to my wife, who is also a 
designer, that she could have the G4 and I 
would have a shiny new G5, because... I want 
one. “Are you actually dribbling?” she replied. 

Needless to say, I got my way, just as I did 
with the fi rst generation iPod, an iBook and 
wireless networking for my home. I should 
point out in my defence, though, that I do 
actually use these things. I always fi nd some 
way of fi tting them into my work fl ow. 

This is why I’m normally in a state of 
great excitement when Steve Jobs makes a 
keynote speech, because you can bet your 
bottom dollar there will be new products or 

software announced. This time it was 
Macworld in San Francisco (or iPodWorld as 
one commentator ruefully put it, indicating 
Apple’s change of focus) and the time 
difference meant I could watch events unfold 
on my Mac at work. There was no live video 
stream, but I could read a transcript of what 
was happening on the Mac News Network. 

And what a keynote speech it was! 
Updates to iLife, a new iWork software 
collection, featuring new application Pages, 
Final Cut Express HD, Mac mini and 
the iPod shuffl e. I wanted them all! 

CHOICES, CHOICES
The one I’m most likely to get, however, is 
the iPod shuffl e. It’s cheap, no bigger than a 
packet of chewing gum and my fi rst 
generation iPod has fi nally bitten the dust 
due to overuse. Before MacWorld I had been 
toying with the idea of an iPod mini, but my 
experience with my older iPod was that I 

preferred to create a play list for the day and 
just play that. A fancy onscreen user 
interface was wasted on me.

I use Microsoft Word to open documents 
sent to me by email, but I prefer the 
simplicity of TextEdit and will often attempt 
to open Word fi les with that if I can. If I need 
something with a bit more visual oomph, 
I use InDesign. I can’t help it; it’s the 
designer in me. Trying to design something 
in Word is anathema to me, and I have to go 
for a lie down. However Pages looks very 
sleek indeed, and together with an upgrade to 
Keynote, it can only be a matter of time 
before I rush to the Apple Store on Regent 
Street and slap my credit card on the counter. 

What I want most of all though, and what 
I’m fi nding hardest to justify, is the new Mac 
mini. We have Macs coming out of our ears, 
and I can just imagine my wife’s face as I 
suggest we re-mortgage the house so I can 
buy some more gadgetry to clog up our 
home. But I really want one. I know that 
Windows users making a cheap leap from 
PCs to Macs are the real target audience, but 
plenty of Mac users will want one, too. My 
friend Rich rang me up the other day to see if 
he could use one as an email server. That’s 
how keen he was to get one! I’ve made a 
mental note to try that excuse. 

But budgets can only stretch so far, and at 
the risk of my wife’s eyes narrowing and 
shooting me with death rays, I think the Mac 
mini will stay just out of reach. Unless I pour 
coffee in the back of her G4 tower...

Jason Arber is a designer and co-founder of 

www.pixelsurgeon.com. He can be emailed at 

jason@pixelsurgeon.com. 

“I can imagine my wife’s face as 
I suggest we re-mortgage the 
house so I can buy more gadgets”

OPINION

FORUMS 
What do you think of 

the latest Apple kit? 

Tell us on our forum – 

visit http://forum.

computerarts.co.uk. 

I want that one
If you’re the type of person who dribbles over new software and constantly 
updates your kit, whether you need it or not, it’s hard to justify the expense

OPINION
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NEWS ANALYSIS

One of the main benefi ts of the steadily 
declining value of the US dollar against 

other currencies during the past three years 
has been, for those based outside the US at 
least, the massive savings to be made on a 
wide range of products.

With one US dollar currently worth 
roughly 53p, that’s a promise of huge 
savings for UK designers looking to save on 
the price of an upgrade of their favourite 
creative software package.

Unfortunately, it appears that UK punters 
are being forced to leave US websites 
empty-handed – and spend their high value 
sterling in UK web stores and reseller 

outlets instead. The reason? The big guns 
simply don’t want UK residents to pick up 
their products at US prices.

The situation is even blighting the 
hardware market, with the recent launch of 
Apple’s Mac mini drawing particular 
criticism from disgruntled European and 
UK consumers. 10,000 punters felt so 
strongly about the price difference that they 
added their names to an online petition 
demanding fairer prices.

“We’d like to make an appeal to Apple on 
the pricing of the new Mac mini in the 
European Union,” the petition states. 
“Based on the last long-term rate of 
exchange of US dollars to euros – which is 
1.3293 on the spot market – both of the 
announced prices of the Mac mini in 
Europe, 489 euros and 589 euros, 
respectively, are much too high.”

While Apple has responded to the 
petition in the UK by attributing prices to 
higher shipping costs and the need for a 
currency fl uctuation “cushion”, costs for the 

software industry are obviously different, so 
how do the vendors justify the current 
regime? And what’s the outlook for these 
price differences over the next six months?

HIDDEN COSTS
“Primarily, prices differ so much from 
territory to territory because the cost of 
doing business also differs,” Quark’s UK 
marketing director Gavin Drake, explains. 
“This includes staff costs, property prices, 
shipping and import duties, all of which can 
be substantial.”

Drake argues that the considerable 
investment required to localise software 
across a multi-lingual territory such as 
Europe does much to bump up costs.

Jussi Arovaara, EMEA & APAC business 
development manager for Corel, echoes 
Drake’s points. He too attributes high 
sterling and euro pricing for Corel’s 
products to “market conditions”.

“Most development is done in the US, but 
all the localisation which takes place is 

FORUMS 

Visit http://forum.

computerarts.co.uk  

to share your views on 

this topic and more 

with other CA readers. 

Where next for software pricing?
As the value of the US dollar plummets, software should be getting cheaper for us Brits, but it’s not – and the 
vendors are trying their hardest to make sure we don’t spend our money abroad. Why?  WORDS BY DOM HALL

IN DEPTH
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“A lot of European card companies 
will not cover users against
fraud when used on US sites”

carried out in the different markets in 
Europe. Our costs are very much tied to the 
local market and they are all higher than in 
the US,” he said. 

At Macromedia, EMEA communications 
manager Sarah Mowatt points out that
US prices do not include the routine VAT 
sales tax that is added in most European 
currencies, as well as special promotional 
pricing campaigns.

Fair enough perhaps, but why are the 
software vendors so keen to stop European 
punters buying directly from the US?

“In theory, it’s possible for a vendor to sell 
from the US to customers, regardless of 

where they are in the world, but in practice 
it’s complicated,” says Corel’s Arovaara. “If 
you’re just selling within the US, things are 
easy, but once you start selling from the US 
to the EU, you have to deal with tax laws 
and customs regulations. A lot of European 
credit card companies will also not cover 
users against fraud when used on US sites.”

For Quark, the issue is a little less clear 
cut. Drake says European users “can buy” 

software from the US webstore, but that 
“not all versions of QuarkXPress will run
on all operating systems. For example, the 
US English version will not run on an 
International English operating system.”

Of course, there’s nothing to stop a UK-
based punter buying from a reseller in the 
US, but the ever more localised nature of 
software highlighted by Drake may stop 
even this being an option. 

DIFFICULT MARKET CONDITIONS
While experts predict a gradual correction 
in the US and sterling exchange rate over 
the next year, in the short term the chasm in 
relative pricing is likely to remain an issue. 
Arovaara believes price differentiation 
throughout Europe may level off in the 
future, as the technology used to localise 
software becomes more advanced, but he 
remains less confi dent about global pricing. 

“There will be differences between US, 
European and Asian pricing for some time 
because the market conditions in those 
territories are so different,” he says.

Although it’s hard to have much 
sympathy for the powerful and dominant 

software companies currently suffering
at the expense of international exchange 
rates, the fact their positions and, more 
importantly, bottom lines are under fi re goes 
some way to explain their eagerness to 
maximise revenue in as many different 
countries as possible.

A recent report from analyst group 
META predicted software prices across the 
board would decrease for the fi rst time in 
over a decade during the next three to fi ve 
years. This shift is being fuelled by the 
pressures of new application providers 
entering the market, the growing infl uence 
of open-source solutions, and increased use 
of offshore labour.

Add to this the billions of dollars of 
revenue being lost through piracy and it 
becomes clear that the software industry
in general is defi nitely going to be keeping 
an eye on the pennies in the future, and is 
not going to let something as fl imsy as 
currency fl uctuations eat into its profi ts
any time soon. 

INFO 
www.quark.co.uk
www.macromedia.com/uk
www.corel.co.uk
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Digna was designed by South 
American designer Rodrigo Ramirez 

as part of the new visual identity for the 
Santiago public transport system. The city 
needed a font that would work well in a 
variety of sizes, from large-scale signage 
through to small timetables – and Digna,

Rodrigo Ramirez
Been to Santiago recently? Then you’ll already have seen the slick work of this Chilean typographer

a clean, fl exible and friendly font – fi tted 
the bill perfectly. The sans serif typeface 
comes in nine weights, and features 
dingbats that include many of the symbols 
created for the transportation system.

South America is producing some of the 
most interesting type design in the world 

FONT DESIGNERINFO

Web: Digna, alongside a 
huge range of other 
exciting fonts, is available 
exclusively from the 
UnionFonts website.

Price: £99 for the family
(nine fonts plus dingbats).

Info: For more information 
on UnionFonts, just visit 
www.unionfonts.com

right now, and Ramirez is a leading fi gure 
in this exciting new movement.

As well as creating his own fonts (check 
out the UnionFonts website for details), 
he lectures in type design at the School of 
Design at the Pontifi cia Universidad 
Catolica de Valparaiso, Santiago. 
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DESIGNER
NAME: DEREK LEA
LOCATION: TORONTO, CANADA
URL: WWW.DEREKLEA.COM

HOW WAS IT DONE?
Derek created this cover illustration on a G5 using 
Photoshop CS and Painter. “I started with a
simple portrait of a friend, as well as some
background textures, shot with a Fuji FinePix S2
Pro,” he explains. “I scanned in all the leaves using an 
Epson Perfection 3200 Photo scanner. To stop the lid 
crushing the brittle and dry leaves, I left the lid open and 
lay a single sheet of white paper on top the foliage. This 
enabled the scanner to calibrate properly, while also 
protecting the leaves.”

The resulting image clearly demonstrates Derek’s deft 
use of layers, channels and masks when it comes to 
creating each element. “I place the stack of layers for that 
element in a set and blend it into the main image by 
masking the set,” continues Derek. “I repeat this method 
for each element until the image is complete.”

While it’s a technique he uses often, each composition 
remains quite unique. “Certain core techniques appear 
again and again only because they are absolutely essential 
for creating fl exible compositions,” he says.

TURN OVER TO GET STARTED WITH THE COVER TUTORIAL...

  

COVER FEATURE
COVER ILLUSTRATION
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You may not recognise the face 
in the leaves, but undoubtedly it 

is familiar to you, for the green man 
motif is very old and particularly 
abundant within architectural detail. 
You’ll find the face in the leaves 
carved out of stone in columns and 
archways in some of the world’s 
greatest cathedrals and churches.

So when on an autumn day last year 
I looked at the ground and noticed the 
beautiful leaves beneath my feet I was 
inspired to make my own attempt at 
recreating the green man. I’m by no 
means the only modern artist to 

recreate this image, but the 
juxtaposition of scanned natural 
elements combined with an art form 
as virtual as digital image editing was 
just impossible to resist.

No-one knows for certain the 
meaning of the green man motif, but 
there is a huge amount of speculation 
that he represents the spirit of nature 
or the lover of the pre-Christian earth 
goddess. I took the word “goddess” as 
my cue and have changed the green 
man’s gender this time around. 

This tutorial will take you step-by-
step through the skills you’ll need to 
recreate the green woman pictured 
here. All the resource files you’ll need 
to get started have also been included. 
So perhaps, in time, you’ll see the 
green woman on the web and within 
the digital realm as often as her male 
counterpart appears in the tactile world.
 

Illustration and tutorial by Derek Lea 
www.dereklea.com

COMBINE  
PHOTOSHOP  
AND PAINTER
Derek Lea gives the world famous green man a modern twist, using 
Photoshop to build up textured layers of hand picked leaves and 
then Painter to add a range of authentic aged effects 

COVER FEATURE
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5 Use the Pen tool to draw a closed path 
around one of the pointed leaves and 

generate a selection from that path. Drag the 
contents of the selection into the working file 
as a new layer. Choose Edit>FreeTransform 
from the menu and resize, rotate, and position 
the leaf at the top of the girl’s head.

COVER

MBINE  
OTOSHOP  
D PAINTER

4 A number of leaves have been supplied 
on the cover CD. At this point it’s up to 

you whether you follow these steps exactly 
with the leaves provided or choose new 
leaves that appeal to you. Whichever you use 
the process will be the same. Open up a leaf 
file from the cover disc.

3 Choose Layer>AddVectorMask> 
Current Path from the menu to create a 

mask from the current path. Create a new 
Hue/Saturation adjustment layer, set the Hue 
to -6 and decrease the Saturation by 19 to 
minimise the yellow cast. Create a new Levels 
or Curves adjustment layer. Finally, tweak the 
curve’s endpoints or use the histogram to 
increase the contrast.

2 Open up the face.tiff file from the cover CD and drag the face image into the background file 
as a new layer. Position it over the lion carving at the left. Select the Pen tool and draw a 

closed path that surrounds the girl’s face and the bottom of her ears. Make sure that you 
exclude her hair and neck from the path.

LAYERING TECHNIQUES

1 Open BackgroundLayers.psd from the cover CD. The image is made up of a number of 
layers, so, rather than provide you with a flat version, the layers within the set have been left 

so that the more inquisitive among you can check it out in more detail. However, if system 
memory is an issue, flatten the image before you start.

DOWNLOAD

TIME LENGTH

5 hours

INFO

Derek Lea is an award-
winning illustrator and 
published author based in 
Toronto, Canada. His 

work 
includes 
disciplines as 
varied as 
traditional 
illustration, 

photography, 3D 
modelling, vector art and, 
of course, Photoshop. To 
view more of his work, 
visit www.dereklea.com.
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PHOTOSHOP • PAINTER

10 Control/Command-click on your alpha 
channel’s icon within the Channels 

palette to generate a selection from its 
contents. Now create a new layer in the 
Layers palette positioned above the other leaf 
layers and select the Gradient tool. Choose 
the Radial option and the Foreground to 
Transparent option from the Gradient Picker 
in the Tool options bar.

9 With your current 
selection active, hit 

Control/Command+P to 
paste your copied layer 
contents into the selection 
border. It is important that 
you follow this procedure 
exactly if the positioning of 
your channel is to match 
up with your layer contents. 
Go to Image>Adjustments 
> Brightness/Contrast 
from the menu to increase 
the contrast of the 
scanned leaf image.

11 Sample a lighter skin colour as the 
foreground colour. Click and drag 

within your active selection to create a series 
of small radial gradients on the new layer. 
Press Control/Command+D to deselect the 
active selection. Finally, create a new layer 
set and drag the leaf layers into it, one by one, 
from top to bottom.

8 Choose your original 
leaf layer in the 

Layers palette, press 
Control/Command+A to 
select the whole layer and 
press Control/Command+ 
C to copy it. Now Control/
Command-click on the 
layer icon to generate a 
selection based on the 
layer contents. In the 
Channels palette, click on  
Create New Channel.

7 Create a new layer 
and change the 

Blending Mode of the 
layer to Colour. Next use 
the Eyedropper tool to 
click on and sample the 
colour from an area of her 
skin, specifying it as the 
current foreground colour. 
Fill the selection on the 
new layer with the current 
foreground colour before 
reducing the layer opacity 
a little.

12 Click on the Add Layer Mask button in 
the Layers palette to add a mask to 

the set. Use the Gradient tool with the current 
settings and a black foreground colour to 
create radial gradients at the bottom of the 
leaf within the mask. Open another leaf file.

6 Duplicate the layer by 
dragging it onto the 

Create A New Layer 
button at the base of the 
Layers palette. Change 
the layer’s Blending Mode 
to screen and reduce the 
Opacity to around 65 per 
cent. Now Control (PC)/
Command (Mac)-click the 
layer icon in the Layers 
palette to generate a 
selection based upon the 
layer’s contents.
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Some of the leaves I 
scanned for this image 
were pressed flat in a 
book and allowed to dry. 
Others were left to dry 
unflattened to create a 
great three-dimensional 
appearance and give the 
image a sense of depth. 
However, these three 
dimensions proved tricky 
when it came to scanning 
as closing the lid crushed 
the leaves and ruined their 
depth. To avoid this, leave 
the scanner lid open and 
place a sheet of white 
paper on top of your 
leaves. This will provide a 
clean background when 
scanning and leave your 
objects undamaged.

SCANNING LEAVES
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13 Use the Pen tool to isolate another leaf from the cover CD and bring it into the working 
file as before. You can now use Free-Transform to rotate, resize, and reposition it across 

the girl’s eye. Change the Blending Mode of this layer to Luminosity. Duplicate the layer, change 
the Blending Mode to Screen and then reduce the opacity a little. Finally, generate a selection 
from the layer’s contents.

16 Adjust the position with the Move tool 
and edit the mask using the Gradient 

tool if necessary. And there you have it. This 
simple process duplicates leaf layers, adds 
them to sets, masks the sets and duplicates 
them to create a leaf effect across the 
model’s face. You can now open another leaf 
file from the cover CD.

14 Create a new layer with a colour Blending Mode and fill the selection with a foreground 
colour sampled from the girl’s skin. Reduce the Opacity and deselect. Now create a new 

layer set and add your three new layers to it in their current order. Add a Layer Mask and use 
the same technique as before to blend the set into her face.

15 With your set selected, choose 
Duplicate Layer Set from the Layers 

palette menu. Use the Move tool to drag it 
over to her other eye. Choose Edit> 
FreeTransform from the menu. Right-click/
Control-click inside the bounding box and 
then choose Flip Horizontal from the pop-up 
menu. Finally, press Enter and the 
transformation will be applied.

17 To add more leaves to the face, repeat 
the same process of creating sets for 

leaf components until you are happy with the 
results. Bring in a diverse range of leaves and 
position them in front of and/or behind the 
other layer sets. Feel free to merge layer sets 
to keep the file size down. Just select a set 
and press Control/Command+E.

COVER

Painter handles 
Photoshop layered files 
with ease these days. You 
can now successfully 
import Photoshop layered 
files into Painter IX with 
sets and editable masks 
intact. However, when 
you open up images with 
Photoshop adjustment 
layers such as Levels 
layers embedded, Painter 
will first need to 
deactivate them. You are 
warned when opening the 
image that the 
unsupported layer has 
been detected and you 
will be given the option to 
open the image without 
the adjustment layer 
effects. This is why it’s 
easier to flatten your 
image before importing 
it into Painter.

WHY FLATTEN?

You can fill the contents of 
a selection or a layer in 
Photoshop using the Fill 
option within the Edit 
menu, but there is a 
quicker way. By holding 
down the Alt (PC)/Option 
(Mac) key and pressing 
the Delete key you can fill 
the selection area or layer 
with the current 
foreground colour. 
Holding down the Control 
(PC)/Command (Mac) key 
and pressing Delete will 
fill the selection area or 
layer with the current 
background layer. You can 
invert the foreground and 
background colours by 
pressing the X key.

FILLING SHORTCUTS
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TUTORIAL

PHOTOSHOP • PAINTER

20 Enable the Pick Up Underlying Colour 
option in the Layers palette. Set the 

Opacity to around 20 and the Grain to about 
16. Specify a size of your choice. Now zoom-in 
on an area of the girl’s face. Sample a colour 
from her skin and paint a few strokes beside 
the sample area on the new layer.
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21 Repeat this process all 
over the skin to help 

smooth the girl’s skin and hide 
her freckles. Take your time and 
use plenty of small strokes, you 
don’t want her face to look 
rough. Once you are finished, 
create another new layer in the 
Layers palette and ensure that 
the Pick Up Underlying Colour 
option has been enabled.

22 Choose Blenders as your Brush Category and Soft Blender Stump 30 as the Brush 
Variant. Use this blender on your new layer to soften all of the brush strokes you 

created on the underlying layer until everything is perfectly smooth. Vary the Size, Opacity, and 
Grain settings as needed until you achieve the a look that you are happy with.

COVER

23 Open StoneDetails.psd from the cover CD and use the image to add a convincing rough 
texture to the girl’s face. Look carefully at the whole lion image and choose a section of 

its face that you think will work best within your green woman image. You can now raw a rough 
selection around the area using the Lasso tool. 

18 Create some new layers in-between 
the sets and flattened sets with the 

Blending Mode set to Multiply. Use a large soft 
brush with a low opacity setting to paint 
shadows on these layers and you’ll give the 
image a sense of depth. Now use dark colours 
sampled from within the image to create 
shadows. Once you’re done, flatten the image.

19 Save your file and then open it up in 
Painter IX. Select the Brush tool from 

the toolbox. Choose Artists’ Oils as the Brush 
Category in the Brush Selector Bar and select 
Wet Oily Blender as the variant. Click on the 
New Layer button in the Layer palette to 
create a new layer.The Painter toolset and 

workspace will seem 
familiar to those who have 
experience of Photoshop. 
There is also some 
familiarity within the 
keyboard controls and 
shortcuts. The best 
example in this tutorial is 
the temporary switch to 
the Dropper tool for 
sampling colour from 
your image. When you are 
using Painter’s Brush tool, 
hold down Alt (PC)/Option 
(Mac) to temporarily 
switch to the Dropper tool. 
Release the key and you’ll 
revert to the Brush tool.

SAMPLING COLOUR
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  CREATE OUR COVER EFFECT

Once you’ve finished smoothing 
the brush strokes in Painter, save 
the file and quit. In Photoshop, 
open the layered file. The layers 
will remain intact and the colour 
and quality of imagery will be good.

Revisit some of your leaf files 
and incorporate more sets to your 
image. Here, they have been added 
to the right-hand side of her face 
to create a subtle border between 

the primary visual element and the 
area on the right that was lightened 
to accommodate the text. Flatten 
the image and in Painter add some 
final smoothing and paint strokes.

24 Drag your adjusted image into the working file and reduce the Layer 
Opacity. Use Free Transform to adjust the size. Change the Layer Blending 

mode to Luminosity and duplicate it. Change the mode of the duplicate layer to 
Soft Light and reduce the Opacity. Create a set and add these two layers to it.

25 Finally, add a Layer Mask to the set and use a large soft brush to gently 
fade the set into the image. You can now remove any unwanted areas, 

such as the area overlapping the eye. Use this technique to add more sets 
containing sections of the other image to her face until you achieve a sense of 
rough, unpolished stone.
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The Superdeux team:

Sébastien Roux (left) and 

Stéphane Huleux spend their 

time formulating creative plans 

to conquer the world.
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Global graphics studio Superdeux 

boasts offi ces in France and New 

York as well as an international 

customer base, but there’s no 

sign of fl ashiness or infl ated egos. 

Superdeux has, it seems, carved a 

place for itself using just raw talent 

and the extraordinary potential of 

internet exposure

WORDS BY MIREILLE FRENETTE AND BENOIT GUERVILLE

PHOTOGRAPHY BY JAMES WILSON

     
   

CA INTERVIEW
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Ë
Back in 1999, Sébastien Roux 
worked in a communications agency 

specialising in web animation, games and 
video clips. But he spent much of his free 
time experimenting with the opportunities 
offered by a new, exciting vector animation 
tool named Flash. It was then that he built 
himself a personal website to showcase his 
work, superdeux.com. 

Initially, the site had no commercial 
aspirations, but Roux’s images rapidly 
circulated across the web and, by chance, 
caught the eye of Peter Thaler, whose own 
website featured the most interesting 
graphic artists on the web. Thaler’s site 
became increasingly popular, and, as a 
result, was transformed into Pictoplasma,
the design bible for advertising executives 
that is now respected the world over.

Appearances in Pictoplasma and other 
such titles drew the attention of millions 
of people across the globe to Roux’s 
inimitable style. And so, three years later, 
Roux left the communications agency to 
concentrate his efforts on Superdeux, 
which was already attracting work from 
clients. Roux teamed up with Stéphane 
Huleux who soon took charge of the 
studio’s technical side together with web 
programming and sound design and the 
rest, as they say, is history.

SUPERDEUX

Artistic concepts
Whether for print, web, animation or toy 
creation, Superdeux’s work is now 
characterised by a style that is simple and 
streamlined. “Our characters have very 
simple shapes, our images are very 
colourful, and everything is heavily tinged 
with fun and irony,” says Roux. “We enjoy 
combining a cute design with a violent 
idea, perhaps even an aggressive one, and 
this mix produces something slightly off-
centre that people seem to like.” 

Roux cites Japanese animé, street style, 
eighties culture and music as his main 
infl uences: “Music is very much present in 
the work we do. I often pick up and reuse 
phrases taken from hip hop tunes.”

For the last two years, the company has 
spent time formulating creative plans to 
conquer the world. How? Superdeux 
develops individual artistic concepts and 
then attempts to apply them to everything 
it produces. This process usually starts 
with the creation of a small character, 
which is then liberally stylised. 

Along with the character, a strong idea 
or a sentence is created, which forms a sort 
of signature or a slogan. “Once a concept 
has been developed, we work hard to come 
up with all the possible and imaginable 
ways it can be used,” explains Roux. 

CA INTERVIEW
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“From there, we contact the manufacturers 
directly and, if we can work out a deal, 
they execute the project.”

And that’s really as complicated as it 
gets. For his toys and T-shirts Roux has 
taken the chance to send his concepts to 
perfect strangers: “I only knew the people 
I contacted [about his work] through their 
websites. I had used their site but had 
absolutely no personal contact with them.” 

Sending your own designs away to a toy 
manufacturer on the other side of the world 
may seem a little risky but, as Roux says, 
“The only thing I had to lose was my 
designs, and I thought it was worth it.” 
And indeed it was. After several months of 
email communication, Roux fi nally signed 
a contract. “I guess it’s not very 

professional,” he admits. “We had already 
agreed on the terms, but I didn’t sign the 
contract until the toys were in production.” 

Superdeux’s sales technique is thus 
remarkably simple. With a simple email 
contact, Roux can subcontract all his 
projects, from toy manufacturers or textile 
specialists, even if they are located halfway 
around the world. It’s clear that much of 
the company’s success comes down to the 
optimal use of internet resources. 

From his offi ce in Lille, a city in the 
North of France that few non-French 
advertising executives could locate, Roux 
attracts business from Asia, deals with his 
customers in the United States, and uses 
the internet to communicate with 
graphic artists worldwide. 

CA INTERVIEW

 ABOVE: Army Of 
Death, the second 
series of Stereotype 
collectable adult 
toys, features fetish 
characters from the 
fi rst series (page 
36) reincarnated 
into creatures of 
destruction.

RIGHT: It’s all about 
advertising. Superdeux 
leaves its mark, and 
the Shikito face, on 
a New York Police 
Department car.

 

BELOW: Superdeux’s 
work is heavily 
infl uenced by music, 
particularly hip-
hop culture, as this 
character design for 
US DJ Freddy Fresh 
demonstrates.

These collectable toys were fi rst designed 
as graphics, shown above. Roux then 
worked intermittently on the project over 
two years and eventually contacted toy 
makers the world over to pitch the idea. 

A Hong Kong-based toy manufacturer 
loved the concept and subsequently agreed 
to produce the dolls. The fi rst series was 
so successful that Superdeux created 
a second, for which 10,000 copies were 

manufactured, including a limited edition 
sponsored by San Miguel beer.

“We usually develop two or three 
personal projects each year,” says Roux. 
“We put in some work here and there, 
when we are so inclined, just for the fun 
of it, and only when the project fi nally 
starts to take shape do we start contacting 
manufacturers. We work in exactly the 
same way for our Unchi label.”  

THE STEREOTYPE TOYS
THESE STRANGE LITTLE TOYS, PACKED RANDOMLY IN CLOSED PACKAGING, 
ARE JUST ONE OF SUPERDEUX’S RECENT SUCCESS STORIES
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ABOVE: Superdeux 
created this stylish 
character design for 
the French electro 
band, Auto. 

“The Superdeux touch”
Superdeux can now boast an impressive 
client list including huge names such as 
MTV, Universal Pictures, KidRobot, 
ITRangers, EA Sports and Sony. Another, 
Sony Ericsson, asked Roux to design a 
range of tiny pixel-art characters to be used 
as animation on phone screens. 

“Working with Sony Ericsson was 
actually not too different from working 
with smaller clients,” says Roux. “They 
wanted “the Superdeux touch”, so we were 
completely free to create, perhaps even 
more so than with smaller clients.” 

The characters, originally designed as 
low resolution Flash fi les, were then 
exported as animated GIFs before 
conversion to an image format compatible 
with mobile phones.

Technical matters proved a 
little more complicated during 
work for television network 
Comedy Central. “To 
make the short clips the 
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client asked for, I had to work with 
animators who used After Effects, an 
application I have yet to master,” says Roux. 
“At fi rst, I was only asked to draw the 
characters and they said their animators 
would do the rest. But then I mentioned that 
I could do the animation myself in Flash.” 

There were several technical issues – 
resolution, managing the frame rate and the 
colour space, for example. The animations 
were produced in Flash in RGB, and then 
transferred to Illustrator for conversion to 
EPS format in CMYK, where colours had 
to be tweaked. Everything was then 
exported to After Effects.

“The French have no guts”
In addition to the publicity gained from 
Pictoplasma, Superdeux has an agent 
responsible for drumming up interna-
tional business, particularly in the United 
States and Japan. Roux also keeps busy 
as creative director of Thunder Dog 
Studios (www.thunderdogstudios.com), a 
New-York-based design company, so he 
regularly travels to the States to work on 
location for a few months at a time. Being 
there gives him the opportunity to make 
new business contacts for Superdeux. 

While this international experience has 
increased the studio’s prestige, Superdeux, 
paradoxically enough, has virtually no 
French clients. “I guess our style just 
doesn’t suit them,” Roux concludes. “They 
have no guts,” adds Huleux, smiling. 

When asked what has been his most 
surprising experience, Roux immediately 
states that it’s disembodied 

CA INTERVIEW

SUPERDEUX

Another characteristic design for the ever 
expanding Unchi/Superdeux identity.

Shikito, the happy-faced character, is a logo 
designed by Superdeux for Bullshit, a creation 
under the Unchi label, which Superdeux is 
currently developing to promote the personal 
creations of Superdeux and their friends.

BELOW: Be My Slave 
was the fi rst series 
of Stereotype toys 
created by Superdeux. 
“We enjoy combining 
a cute design with 
a violent idea,” says 
Sébastien Roux.
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communication via the web that he fi nds 
the strangest. “There have been times 
when I have worked for months with a 
person before meeting them face-to-face. 
I fi nd this manner of working increasingly 
annoying. I miss the human contact.”

The future
Superdeux aims to substantially reduce its 
“made-to-order” jobs by developing its 
personal concept work. “Ideally,” says 
Roux, “we’d like large corporations to 
contact us and say “we would like you to 
do some work for us, but we don’t really 
know what”. From there, we could freely 
develop an entire range of products.”

To achieve this honourable goal, the 
team works by relatively modest means. 
Roux won’t be parted from his portable 
Sony VAIO and Huleux works on a PC he 
put together himself. Of course, their 
favourite software is Flash, but, at times, 
they also use Illustrator and Photoshop.

Right now Roux and Huleux are 
launching a parallel label to Superdeux, 
Unchi (the Japanese word for poo). 
“[Unchi] is intended to host all of our 
artistic creations as well as the ones from 
the people we love,” Roux reveals. “That 
way we can do exactly what we like and 
become masters of the universe which is, 
of course, our secret objective.” 
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NAME: Sébastien Roux (left)
ROLE: Creative director, designer 
and animator

INSPIRED BY: Music, advertising and 
art. Combining music with visuals 
is important, it’s the best way to 
communicate emotions and is probably 
what inspires me most.

FAVOURITE DESIGNER/ILLUSTRATOR: 
Murakami, Warhol and the Designer’s 
Republic. All the artists and designers 
that I like associate art with “marketing”, 
which is a process I’m interested in.

FAVOURITE WEBSITE: 
www.123klan.com because they’re good 
friends, www.freshnessmag.com for the 
info on art, sneakers and toys and 
www.kidrobot.com as that’s where I shop.

NAME: Stéphane Huleux (AKA TEPAT)
ROLE: Flash developer, web 
programmer and sound designer 

INSPIRED BY: PrayStation, yugop and 
moock (for Flash), d-i-r-t-y and nuloop 
(for music).

FAVOURITE DESIGNER/ILLUSTRATOR: 
I love Chickfree, rinzen and eBoy for 
their simplicity and graphic effi ciency.
 
FAVOURITE WEBSITE: I often visit 
www.computerlove.net (for the links).

SUPERDEUX Q&A

For more information about the 
Superdeux team, and what they’re up 
to now, visit www.superdeux.com or 
email info@superdeux.com. 

COMPANY INFOCOMPANY INFO

SUPERDEUX

LEFT: Meet Dunny, a 
new fi gurine created 
by Superdeux and 
distributed by Kidrobot.

ABOVE RIGHT: 
Superdeux’s creative 
director Sébastien Roux 
admits that he likes to 
use advertising industry 
lingo to create funny and 
provocative pieces.

RIGHT: Translated, this 
piece simply shouts 
the message, “Eat 
hedgehog, it’s so good!”
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FEATURE

BETTER CHARACTERS
FLASH MX
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The Pocket Laboratories team, the brains behind the brilliant morejamsandwiches.com, explains how best to adapt 
your Flash knowledge to master character animation, and draw attention to your work on the web

 There’s a huge emphasis on 
interactivity across the internet these 

days. Eye-catching, distinctive, interactive 
characters can be a valuable addition to any 
website. So if you are looking for an 
entertaining interruption to your day-job, 
some odd little web characters might just be 
the perfect distraction. Whether they exist 
in an interactive animation or an addictive 
little game, first-rate character-based 
websites gain cult and mainstream 
followings on the net and are a great way to 
draw attention to your web design work.

The secret to creating a successful 
interactive web character lies in the balance 
between fun and reality. No matter how 
insane or unreal your character becomes, 
you will reach a greater level of popularity 
if you add perfect mannerisms to bring that 
character to life, to build on the relationship 
between your character and the user. 

Interactive character-based sites can 
entertain and educate, there’s an open 
opportunity to charm children and adults 
alike. Characters can be produced in an 
endless array of styles and, if created 
skilfully, add a magic element to a website, 
be it corporate, conventional or contemporary.

This tutorial will teach you how to adapt 
your Flash knowledge to master character 
animation. Step-by-step you will learn how 
to take a character idea through the process 
of design, artwork, animation and 
interactivity, essentially bringing your 
character to life. The final product will be a 
fresh and interesting animated character with 
which the user can interact fully and directly.

Illustration and tutorial by Pocket Laboratories 
www.pocketlaboratories.com

DOWNLOAD

TIME LENGTH

2 hours

INFO

Pocket 
Laboratories 
is a London-
based 

company that produces 
design, animation and 
illustration to bring a 
fresh, fun and 
progressive outlook to 
the new media, print and 
television industries. Visit 
www.pocketlaboratories.
com to find out more.

1 Start by developing your character using some good old pen and paper. This may seem old 
fashioned, but it is important that your character is likeable and this preparation will help to 

give your character the originality it needs to stand out from the rest.

2 There are some important basics to bear 
in mind when designing your character. 

It’ll need an appealing body-shape, clear and 
simple arms and legs, and a characteristic 
yet simple face (whether it’s cute, dark or 
outrageous). As soon as you start to animate 
the face and limbs you will be thankful they 
were kept simple.

3 When developing your character in Flash, 
ensure you keep each element on a 

separate layer right from the start. This will 
make the animation process much easier. 
Generally, you should use a new layer for the 
body, each leg, each arm, the head and then 
different layers for the eyes and mouth, too.
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FEATURE

FLASH MX

7 Turn all the character elements (legs, 
arms, eyes, head and tongue) into 

graphic symbols. This will allow you to 
animate each element separately. Drag-
select the entire character, turn it into a 
movie clip, and name it “Dancing Man”.

8 Duplicate the Dancing Man movie clip five 
times and name the clips Don’t Touch 

Man, Crying Man, Chewing Man, Run to Shop 
Man and Listening Man. These movie clips 
will each be made into separate animated 
sequences. Place an actions layer and a 
labels layer at the top of each movie clip. 

9  Within each movie clip the animation will 
take place within the head while the 

arms and legs stay still. Go into each of the 
six movie clips and duplicate the head, 
renaming it accordingly (Dancing Head, Don’t 
Touch Head, Chewing Head etc). 

6 There are several movie 
clips of the sandwich, 

each with a different set of 
actions depending on what 
the character is doing. For 
example, the sandwich the 
character holds while dancing 
is a different movie clip to the 
sandwich the user drags 
around the screen while they 
interact with the website.
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5 A simple background can add so much to your scene and create a sense of space and 
depth within your web creation. When colouring the background, props and character 

bright colours are generally best, but it pays to steer slightly away from the primary colour 
palette for a fresher appearance.

If you need some 
inspiration when 
designing your new 
character, take a look 
at other web 
characters, comic book 
characters and 
animated characters 
on TV. Concentrate on 
what makes them 
likeable and appealing. 
Is it the body shape, 
colour or facial details? 
www.pictoplasma.com 
is a priceless resource. 
The company publishes 
books based on fresh 
character design and 
also holds international 
conferences on the 
character animation.

INSPIRATION

4 Uncomplicated and understandable interactive props are always effective. For this tutorial 
the prop will be a jam sandwich. The user will be able to interact with the character and 

jam sandwich individually and then make them interact with each other.
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12 Crying Man.  
To achieve a 

more natural reaction, 
animate a transition 
sequence to go from  
unhappy to crying, to 
looking unhappy again. 
The crying sequence 
should be a three to five 
frame loop that will 
repeat continuously 
until another action 
takes place.

13 Chewing Man. Use frame-by-frame 
animation to create a more realistic 

movement than you could achieve with 
tweening alone. Use the Onion-skinning tool 
to double check you have created the correct 
movement from one frame to the next.

14 Run to Shop Man. Now that he has 
eaten his sandwich your character will 

need another one. In the “run to shop” 
sequence use clouds of dust, movement lines, 
and alpha transparencies of the character to 
create the illusion of fast movement.

15 Listening Man. In this movie clip the 
user interacts with the character 

directly rather than involving the sandwich. 
Create a short transition sequence where he 
lifts his headphones followed by an animated 
loop of him dancing. Finish off by making him 
put his headphones back on.

FEATURE
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16  Add small characteristic touches such 
as blinking and lip licking to bring your 

sandwich man to life. Placing animated 
elements within the scenery will also add 
interest. Try animating the clouds, switching 
street lights on and off or maybe even adding 
background characters.

10 Dancing Man.  
This character will 

need to loop, so it is 
important that the first 
and last frames are 
exactly the same. Think 
through how it should 
move, taking into account 
its size and shape. Now 
Motion Tween the 
separate body parts in 
order to obtain the right 
dancing movement.

11 Don’t Touch Man. 
Now animate a 

sequence where the 
character changes from 
a happy expression to an 
unhappy expression and 
back again. Try playing 
around with different 
facial expressions, 
mouth and eye shapes as 
well as the character’s 
general posture.

17 Create a new movie clip named 
“sandwichMan”. Drag all six movie 

clips from the library onto the timeline in 
order and make sure that each movie clip is 
ten frames long. You will need to align all of 
the characters so that they are placed in 
exactly the same position on the stage.

Plan how your 
character is going to 
move before starting 
your animation and be 
sure how it will interact 
before you start 
scripting. Keep your 
library tidy while you 
work by placing all of 
the symbols you create 
into folders with 
relevant names. This 
will save time when 
you try to find them 
again later.

BEFORE YOU START
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FLASH MX

22 For varied interactivity you will need a 
series of actions attached to each of 

the sandwich’s instances. For example, the 
sandwich has to know what happens when 
the user rolls over, rolls out, presses, starts 
dragging and stops dragging or collides with 
another movie clip.

19 Drag the sandwich symbol from the 
library and make it into a movie clip 

called “draggingSandwich”. Place an invisible 
button on a separate layer. This will contain 
the action script that will allow the user to 
drag the sandwich around the screen and 
interact with the character.

24 Add speech bubbles to help the user 
interact with the characters. When 

you take the sandwich, a speech bubble 
should say, “I want my sandwich”, prompting 
the user to give it back. The speech bubble 
should be a movie clip that plays as soon as 
the character starts to cry.

25 Once the sandwich man has started 
to interact with his sandwich, try to 

introduce some props of your own. Add other 
characters to the scene and make use of his 
other body parts. You could also put into 
practice the skills you have learned while 
creating character-based games. 

23 The actions for the sandwich have a 
collision test, which allows you to test 

if the sandwich has been released in the 
mouth or hand. Both the mouth and hand will 
need a hit area to detect the collision. These 
hit areas are created from invisible buttons 
converted into movie clips.18 Select the labels layer and place a label at the first frame of each clip. Place a “stop()” 

action in the same frame on the actions layer. Give each movie clip sequence a relevant 
instance name – if the movie clip name is Dancing Man call the instance name “dancingMan”.

FEATURE

20 Most of the sandwich man’s actions 
will be contained within an invisible 

button. To create this, draw a white square 
and convert it into a graphic symbol called 
“White Square”. Transform this into a Button 
symbol called “Invisible Button” and place the 
square in the hit state only. 
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21 To make the character lift his 
headphones when rolled over, drag an 

instance of the invisible button onto a new 
layer in the sandwich man timeline. Add 
actions telling it to go to the “listeningMan” 
label when the users rolls over it and back to 
the “dancingMan” label when they roll out.

It’s worth taking some 
time to add //comments 
throughout your 
action script. Your 
scripting may make 
perfect sense to you 
when you are writing it, 
but come back to the 
same script a few 
weeks later and you 
may end up spending 
time trying to 
understand why on 
earth you wrote it that 
way. Making comments 
will save you time and 
make your file much 
easier for someone 
else to understand.

YOU SAID WHAT?
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ICON

Ë
Multi-national corporate logos tend 
to be pretty obvious beasts. If they’re 

not simply a stylised version of the 
company name – Microsoft, HP, IBM and 
BBC, for example – they’re often derived 
from the name itself, such as the world-
famous “golden arches” of McDonalds.

Some, though, dare to be different. 
Nike’s “swoosh” logo and the Coca-Cola 

emblem are two fi ne examples. To be 
successful, it seems that a logo must 
neither be obviously connected to the 
business, or even feature its name.

The Royal Dutch/Shell Group logo is 
instantly recognisable to millions of people 
worldwide, yet on the face of it breaks all 
these rules. Why, for instance, should a 
petrochemical fi rm feature a shell at all?

Its origin dates back to 1833, when 
Marcus Samuel and Co. was born. Samuel 
imported seashells to collectors in London 
– back then seashells were much in demand. 

In 1891, while collecting shells near the 
Caspian Sea, Samuel realised it would be 
far more lucrative to export lamp oil to the 
Far East. Thus, in 1897, the Shell Transport 
and Trading Company was launched. 

Work in progress
The original logo, created in 1900, was a 
rough representation of a mussel shell. It 
wasn’t until 1904 that the familiar scallop 
design, or Pecten, was fi rst used. 

A slight redesign occurred in 1909, 
although this Pecten was equally unwieldy. 
The same went for the 1915 version, 
though its shape was somewhat simplifi ed. 
This was also the year that the previously 
monochrome logo began to incorporate its 
characteristic red and yellow colouring. 

Again, the precise reasoning behind this 
chosen colour scheme has been lost to 
time. The most commonly quoted story? 
When the Shell Company of California 
fi rst began to build service stations, it 
needed to compete against other companies. 
Bright colours would help to attract the 
customer, without offending the 

Californians. Since many of the state’s 
original settlers were Spanish, red and 
yellow –  colours traditionally associated 
with Spain – were chosen.

Whatever the motives, these colours 
stuck, but over the following decades the 
logo underwent subtle changes. The name 
of the company was added in 1925 as the 
Pecten became ever more simplifi ed.

But by 1967, Shell had decided that the 
logo was too diffi cult to distinguish from a 
distance or in poor lighting. A major 
redesign was needed, and Raymond 
Loewy was the man to do it.

“The father of industrial design”
By then, Loewy had already made himself 
a name as “the father of industrial design”. 
Born in Paris in 1893, he later joined the 
French army and fought in World War I, 
before settling in New York in 1919. He 
started his career as a window dresser for 
stores such as Saks and Macy’s, but soon 
progressed to fashion illustration and 
started his own business in 1930.

As the effects of the Great Depression 
subsided, Loewy realised that Americans 
were clamouring for more stylish products 
in all areas of their lives. He designed and 
redesigned fridges, trains, cars, buses, 
packaging, logos and even cigarette 
packets, including the famous Lucky 
Strike box. One thing he didn’t create, 
however, despite popular misconception, 
was the classic Coca-Cola bottle, although 
he did admire it. The bottle was in fact 
invented by the Root Glass Company in 
1915; Loewy’s redesign in 1954 simply 
made it more streamlined.

SHELL 
BRANDING

1900 1904 1909 1930 1948
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It’s a familiar sight on garage 
forecourts the world over,

 but the rule-breaking Royal 
Dutch/Shell “Pecten” hasn’t 

always been so striking, 
as Ed Ricketts fi nds out

© SHELL LOGO REPRODUCED WITH THE 
PERMISSION OF SHELL BRANDS INTERNATIONAL AG

THE LOGO: 1900 to 2005❯❯❯❯❯❯ ❯❯❯❯

TEAM LinG - Live, Informative, Non-cost and Genuine!



ICON

1955 1961 1971 1995

HISTORY OF THE SHELL ICON
After the initial simplistic mussel shell 
design was abandoned, the logo’s shape 
remained similar from 1904 onwards. 
However, with each redesign the Pecten 
became ever more symbolic and simplistic, 
moving away from its almost photo-real 
origins. The company’s name fi rst appeared 
in 1948, was moved away from the central 
image in 1971, and was eventually removed 
altogether in 1999 when the logo became 
iconic enough to render it unnecessary.
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A fl amboyant and relentless self-publicist, Loewy 
had a penchant for producing clean, economical, yet 
elegant products. It took four years to create and test 
countless prototypes, but ultimately, Loewy took the 
ongoing simplifi cation of the logo to its logical 
extreme. He reduced the number of ridges on the 
Pecten from 13 to seven, and did away with the lower 
ridges. The crenellations on the shell’s edges were 
also removed, replaced with a simple semi-circular 
outline, which has since been considerably 
emboldened. Perhaps most signifi cantly, he moved the 
word Shell from the Pecten itself to beneath the logo.

This redesign was so successful that the company 
has used it ever since. By the late nineties, the image 
had become suffi ciently iconic that Shell was 
confi dent in removing the text altogether. The red 
and yellow colours alone, especially when combined 
with the distinctive shape, scream Shell and thus the 
Pecten fulfi ls the ultimate role for any logo: 
immediate, instinctive brand recognition.

A cultural symbol?
For illustrator John McFaul, the Pecten is both a 
symbol of childhood and a design triumph. “As a kid 
I remember sitting in my Dad’s Citroën as he fi lled 
up at a Shell service station,” he says. “I always 
preferred the yellow and red logo to the greens of 
BP. BP was more of an “institution” – very 
gentlemanly but defi nitely not as approachable.”

“It works on a number of levels,” says illustrator 
Derek Lea. “First, the colour is strong. You could put 
it against a dark or light background which makes it 
really versatile for ads and signage. It is also simple 
enough to work for very small reproductions, such 
as coupons or key chains.”

Lea concludes: “The logo doesn’t look dated to 
me. It has become a fi xed cultural symbol, and I 
really hope they don’t change it.” 
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ESSENTIAL READING

Shell’s now famous Pecten has always appeared in some form on the company’s adverts. In both of these examples 
(from 1923 and 1953), the colours, font and general placement of the logo varies wildly from the model. This would 
certainly be a no-no these days. However, the second advert does use the yellow and red colours that would go on 
to become the company’s defi ning scheme, and which were introduced just fi ve years earlier. 
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AUTHOR: Raymond Loewy
ISBN: 0-801187-211-1
PUBLISHER: The John 
Hopkins University 
Press (2002)
PRICE: $30

Raymond Loewy’s offi cial website, www.raymond 
loewy.com, is a somewhat patchy affair, but it 
does give a broad outline of his work. Meanwhile 
his autobiography, Never Leave Well Enough 
Alone, is well worth a look – although some parts 
are best taken with a generous pinch of salt.
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MISSED AN ARTICLE? 

WHAT DO I NEED? 
All tutorials are in PDF format. 
You’ll need Adobe Acrobat to open them, 
which you can download free from 
www.adobe.co.uk

Once you’ve paid for your tutorial, you’ll 
have 24 hours to download the fi le. You can 
then download all supporting fi les for the 
tutorial via a link embedded in the PDF

BT CLICK&BUY 
BT click&buy is a secure way 
to pay for online content. If you 
have a BT telephone, you can 
have the 99p charge added to 
your phone bill. If you don’t 

have a BT account, simply charge it to your 
credit or debit card. Both options are safe 
and secure ways to pay.

Don’t worry! You can download previous 
Computer Arts tutorials online with our 
secure, one-stop shop. Just go to 
www.computerarts.co.uk/tutorials 
to fi nd out more

 

THESE 
TUTORIALS 

FROM 
99p!

THIS
TUTORIAL

FREE!
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ISSUE 68: ON SALE NOW

PACKAGING

FOLDUP! 3D

Create fantastic 3D packaging m
ock-ups

THE ULTIMATE GUIDE TO

FULL  SOFTWARE WORTH $379
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TUTORIALS
Top tips and tricks from the experts

PHOTOSHOP P60
See how interior theatre designer Liane 
Wilcher creates this vivid perspective-skewed 
depiction of The Royal Albert Hall using digital 
photos, freehand sketches and Photoshop.
TUTORIAL FILES ON THE CD

PHOTOSHOP P54
Looking for translucent ink effects that 
capture the vibrancy of coloured acetate
gels? Martin Fewell reveals the power of 
Photoshop’s Overprint command.
TUTORIAL FILES ON THE CD

Did you know you that there are more tutorials 
available on our website? Premium tutorials can 
be bought online starting from just 99p. There’s 
also a range of tutorials available free of charge. 
Just visit www.computerarts.co.uk/tutorials.

TUTORIALS ONLINE

NEW SECTION TOOL TIPS P64
Fed up with your Brush presets? Then let 
award-winning illustrator Derek Lea show
you how to configure your own to better 
simulate natural media and exploit more 
traditional painterly techniques.

CD TUTORIAL ISHELL P66
Nick Lecoat creates a mini movie player using 
Tribeworks’ acclaimed multimedia authoring 
app. Now you can do the same with the full 
version of iShell 3 provided on the cover CD. 
TUTORIAL FILES ON THE CD
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TUTORIAL

GET OVERPRINTING
ILLUSTRATOR • PHOTOSHOP

By using basic Overprint techniques within your illustration and design work you can easily create stunning 
translucent ink effects. Martin Fewell gives the low down on Overprint, how it works, and how to use it to best effect
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 TUTORIAL

    Because Overprint effects happen 
during the printing process and not 

when you’re actually working in Illustrator, 
they have the ability to add a unique sense 
of craft to your work. Well executed use of 
Overprint techniques tempts the viewer to 
pick up an image and take a look up close, 
tilting it against the light as you would with 
a well executed spot UV. 

Throughout this tutorial you’ll learn the 
basic skills and techniques you need to add 
Overprint to your work. We’ll then reveal a 
range of ways to use the technique to 
excellent effect, starting with photographs 
and scanned imagery and building up to 
this multi-layered composition. You’ll then 
be able to transfer these techniques to 
anything you’re working on.

The most important thing to understand 
about the Overprint effect is the way that 
colours mix together. For example, if you 
take a blue circle and place a yellow circle 
set to Overprint over half of it you’ll 
produce a green colour where the two 
colours meet. It’s useful to think of your 
inks as sheets of coloured acetate placed on 
a projector, that way it’s easier to picture the 
affect your colour mixing will have. Once 
you understand that process, you can easily 
explore the use of Overprint through trial 
and error in your own work.

For this tutorial illustration Overprint 
techniques have been used to create a 
striking, multi-layered image with plenty of 
depth. So gather together some images of 
your own – scans and photographs – and 
follow this tutorial to find out exactly how 
these brilliant effects were achieved.

1Overprinting is a really easy process. 
Start by opening Illustrator and selecting 

an object that you wish to Overprint. Now 
select Window>Attributes, to open the 
Attributes palette, and choose to Overprint 
either the Fill, Stroke or both. You’ll now be 
able to preview the Overprint effect straight 
away by choosing View>OverprintPreview.

2 This tutorial uses Illustrator to create 
Overprint effects, but the process is just 

as easy if you’re working in Freehand. First 
go to the Freehand Preferences and then 
select Redraw from the list that appears. 
Check the Display Overprinted Objects box 
and press OK to set it.

3 Now select the object to be Overprinted, 
open the Object palette and set the fill or 

stroke as Overprint. Freehand doesn’t have 
the same preview feature as Illustrator. 
Instead, Freehand displays Overprint with a 
pattern of zeros on the objects. This will help 
you notice anything that’s been set to 
Overprint by mistake.

Illustration and tutorial by Martin Fewell
www.martinfewell.com

4 If you’re overprinting in QuarkXPress, go 
to Window>ShowTrapInformation. Next, 

set Overprinting using the drop-down menus. 
Trapping is a term used to describe the use of 
Overprint to search out any misalignment on 
the printing press, which could result in white 
gaps between objects.

DOWNLOAD

You’ll find all the files  

the folder marked 
Tutorial\Overprint on the 
cover CD.

TIME LENGTH

6 hours

INFO

Martin 
Fewell is a 
UK-based 
graphic 
designer 

who moves between 
print design, motion 
graphics and interactive 
media to stave off 
boredom. Focusing 
mainly on the youth 
industry, Martin also 
designs typefaces that 
are distributed via T26, 
Union and MyFonts.  
Go to www.martinfewell.
com to find out more.
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ILLUSTRATOR • PHOTOSHOP 
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5 The composition for this tutorial image 
was started using a selection of images 

already prepared by me. Gather together a 
varied selection of images of people, sticking 
to a theme if you wish. Scan your images into 
Photoshop, cut them out using the Pen tool 
and save each one individually as an EPS file 
with a clipping path.

8 Treat the second background image in 
the same way with the Threshold Filter 

to establish an effective background. You can 
now play around with the colour using a Hue/
Saturation layer. Go to Layer>NewAdjustment 
Layer>Hue/Saturation, check the Colorise 
box in the window that appears and use the 
sliders to alter the colour.

Overprinting is most 
effective when using 
solid colours such as 
CMYK or Pantone. When 
using these colours you 
get a clear acetate effect, 
which will help you to 
plan your colour 
combinations. You’ll also 
find that when working 
on a limited colour job 
you’ll be able to create a 
third colour from your 
two colours. Overprint 
works equally as well 
with metallic inks, so 
experiment and 
remember that spot UV 
should be set to Overprint 
to prevent you from 
knocking out everything 
underneath it.

USING SPOT COLOURS

9 Colour your photos using Adjustment 
Layers until you are happy with the 

general composition of your illustration. 
You’ll now need to start rebuilding your 
image in Illustrator using a range of 
Overprint techniques.

6 Although the final image is constructed 
mainly in Illustrator, it’s worth using 

Photoshop in the early stages to speed up the 
process. Import the background images from 
the cover CD. Working at 300dpi your illo 
should now be stylised and ready to take 
advantage of Overprint techniques.

7 Select the image of the background 
buildings. In the Layers palette, Alt+click 

on the layers Eye icon to turn off all the other 
layers. To stylise the photograph, and turn it to 
a single flat colour, first select Image> 
Adjustments>Threshold. You can now use 
the slider bar to alter the image until you are 
happy and then press OK.

10    Paste the background building layers into a new Photoshop document by Control-
clicking on the layer name and clicking on Duplicate Layer. Set your Destination as New. 

Convert the images to 1-bit Bitmaps by selecting Image>Mode>Greyscale and then go to 
Image>Mode>Bitmap. Finally, set the resolution to 300 pixels/inch and use a 50 per cent 
threshold as the method. Save the file a .BMP.
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14 Place the figure you’ve been working on back into its position at the front of your composition. Placing it slightly behind 
the building images creates a great effect. You could also import another background image at this stage.
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15 For this tutorial image, the photo of the 
couple was imported into a new 

Photoshop document as shown in step 10. 
The CMYK channels of the image were then 
split to create four greyscale images. Do this 
with an image of your own by choosing 
Window>ChannelsPalette. Save each 
channel as a Bitmap, making sure that you 
keep the colour name of the channel within 
the file names.

12 Once your images are embedded, 
colour them using a range of flat 

colours. In Freehand you can colour Greyscale 
images, which helps to create a more 
photographic look. But here we will focus on 
Overprint in Illustrator. Colour the bitmaps 
as you would a normal shape but use 
Overprint and Overprint Preview as shown in 
step 1. Contrasting colours will work best.

11   File>Place the Bitmaps into Illustrator, 
ensuring that you have embedded 

them. Do this by un-checking the Link box on 
the Import window or after importing by going 
to Window>Links and clicking the arrow on 
the Links palette. Look for a drop-down 
menu with Embed Image on the sixth line. 

13  Import one of your figures with a 
clipping path into Illustrator. 

Embedding the image frees the path from the 
EPS. Ungroup the mask from the image, Copy 
and Delete. Apply a gradient set to Overprint. 
Group the gradient with the image and press 
Apple+F to paste the mask back. Select the 
image/gradient group and mask and press 
Apple+7 to mask both the image and gradient.

16 Embed the four Bitmap Channels into 
Illustrator as before and re-colour 

them with Overprint, keeping their file 
names. This process effectively rebuilds the 
original CMYK image, but with a different 
effect. Now move them horizontally away 
from each other, to add interest.

Overprinting is often an 
experimental process, 
so ensure that you make 
your printer aware of 
any overprinting within 
your files. They can 
advise you in advance of 
any problems they may 
cause. Your printers may 
need to run the job 
through the machine 
several times or even 
change the ordering of 
the inks on the press to 
achieve the effects you 
want. Finally, before 
sending your Overprint 
work to print, always 
preview it by saving an 
EPS of the vector/page 
layout file and opening it 
as CMYK in Photoshop.

OVERPRINT AND 
PRINTERS
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20 You can now add any typography you feel appropriate. Subtle Overprinting is really 
effective when used with typography, but remember to keep it as simple as you can or 

your image will start to appear too complex. 

21 Add any other small 
details you wish such 

as line work, or textures and 
contrast Overprinted objects 
with regular Knockout 
objects. These small details 
will serve to give your 
illustration a real sense of 
contrast and scale.

22 Finally, you’ll need to 
make sure that your 

final Illustrator file is print 
ready. Save it as an 
Illustrator EPS by choosing 
File>Save As… and then 
selecting Illustrator EPS 
from the Format drop-
down menu. This file will 
now provide true Overprint 
effects. And that’s it. You 
should now have all the 
skills you need to experiment 
further with Overprint 
techniques within your 
illustration work.   

17 When working with Bitmaps and 
Overprint in Illustrator and Freehand it 

can be hard to see how your work really looks 
because the Bitmaps often don’t render well 
on screen. Save your file as an EPS and open 
it again in Photoshop as a CMYK file to view a 
more accurate rendered version.

19Your finished Illustrator composition 
should now match the original 

Photoshop version, but you’ll notice that its 
colours have altered a bit. Overprint colours 
can mix quite strangely, which is annoying. 
Unfortunately, the only way to combat this 
colour variation is to experiment. 

18 Save the remaining figures included in 
the composition as EPS files with 

clipping paths in Photoshop and then import 
them into your Illustrator document.

TUTORIAL

Software packages do 
their best to represent 
the Overprint effects on 
screen using their 
Preview features. But it’s 
impossible for the 
nuances of Overprint to 
be previewed exactly. 
Inks could blend 
strangely and paper 
saturation could change 
the effect during 
production, so, with that 
in mind, be cautious 
when using Overprint or 
speak to your printer. 
Alternatively, throw 
caution to the wind, have 
fun and experiment!

PREVIEWING IMAGES
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COMPETITION

FOR MORE INFORMATION VISIT WWW.ATI.COM

   HOW TO ENTER

Ë

TEXT YOUR ANSWER TO 84600

To win one of two FireGL V5100s, 
simply answer the following question:

Which high-bandwidth bus is the 
FireGL V5100 designed to work with?
a. PCI Express
b. DCI Express
c. PDF Express

Then choose one of three ways to enter:
1. Visit www.computerarts.co.uk/
competition
2. Send a postcard with your answer,
full name, address and phone number 
to: ATI Competition, Computer Arts,
30 Monmouth Street, Bath BA1 2BW.

3. Or send us a text. Simply send us a 
message that says “CA ATI” plus your 
answer – for example, “CA ATI B” – to 
84600. (Each entry costs 50p. If you’re 
not the bill payer, please seek 
permission before entering.)

The rules: The closing date for this competition is 16 
March 2005. Employees of ATI and Future, their agents 
and families are not permitted to enter. Multiple entries 
are not accepted. The editor’s decision is fi nal and there 
are no cash alternatives. No other correspondence will 
be entered into. If you are entering by post and do not 
wish any of the companies involved in this competition to 
contact you with further offers, please indicate on your 
entry. We will not pass your details on to third parties.

Does your PC need a graphical boost? Then feast your 
eyes on the delicious V5100, a prestige workstation 
graphics accelerator that aims to deliver unprecedented 
speed and image quality. Whatever your design 

speciality – from high-level fi lter work to 3D modelling – you can 
expect top-notch results, true cinematic rendering of complex 
geometry and compelling animation with the V5100.

Specifi cally designed for the high-bandwidth PCI Express bus, ATI’s 
outstanding card fully exploits its architecture to deliver outstanding 
results in real time, every time. In addition, the V5100 boasts two DVI 
connectors, for output to dual display systems, and a stereo 3D 
connector with quad-buffered support.

Better still, the V5100 is designed to accelerate 3D apps based on 
OpenGL and Microsoft DirectX 9.0. This makes it ideal for computer-
aided design, architecture, engineering and construction work, and all 
forms of digital content creation.

3D modellers will also be delighted to hear that Discreet has 
tailored its industry-leading 3ds max 7 to fully exploit the card’s ATI 
shader technology. Created for games developers, 3D visual effects 
artists and artists creating 3D cinematics, the co-developed 
technology makes a real-time 3D image rendered in the viewport 
appear almost identical to the fi nal 3D image or animation rendered 
offl ine. Meanwhile, Ashli technology facilitates the seamless use of 
real-time shaders and enables the real-time previewing of Normal 
Maps generated in 3ds max 7.

But enough eulogising. You want one, right? Then simply answer 
the brainteaser on the right – and good luck! 

WIN AN ATI FIREGL V5100
ATI is offering Computer Arts readers a chance to win one of two
FireGL V5100 workstation graphics accelerators worth over £1,170
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PERSPECTIVE TRICKS
PHOTOSHOP

1 Select a striking icon or location of interest and take a range of reference photos from 
different angles that clearly show any architectural detail. Combine these photos by cutting 

and pasting to create a scrapbook collage of the building. Alternatively, use the Albert Hall 
image supplied on the cover CD. You can now start to visualise it in 3D.

4 On a new layer, start to sketch shapes 
from your reference photos. Use circular 

forms and draw from an aerial view to give 
the building a broader bird’s-eye view. Using a 
broad hard round brush, start to work up 
some shapes. This process can take a while, 
but it’s important to find shapes, forms and 
movement that you are happy with.

2 In Photoshop, open a new document with 
dimensions of 35x35cm. Ensure that you 

are working at a resolution of 300dpi so that 
you can clearly see the detail. For me, the 
square format results in a pure shape from 
which you can create conflict and contrast 
using angles and perspective.

3 Using your photomontage for reference, 
start to pull the building apart. Make sure 

that you make the best of the building’s most 
striking elements. In the case of The Royal 
Albert Hall, it’s the circular oval shape and 
the organ within the dramatic tiered interior 
that make the most impact.

TUTORIAL
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With the help of a few basic Photoshop techniques, some freehand sketches and a smattering of visual resources 
such as digital photos, you can add a surreal 3D perspective distortion to your work. Liane Wilcher shows you how

 I come from a theatrical interior 
background and have learned to use 

Photoshop to construct surreal perspectives 
of given architectural icons. For this work,  
I need to rely on my own instincts and 
personal style, so I try to use Photoshop in 
a very basic manual and sketchbook 
fashion, to suggest that the work has still 
been created by hand.

This tutorial will take you through the 
initial stages of taking pictures and 
constructing a photo collage to use as 
reference material right through to the 
sketching and the creation of this final 
image. Although I’ll give you all the basic 
methods you’ll need, this kind of image 
relies heavily on personal instinct. So use 
my methods as a starting point and then 
establish your own taste and style.

The creation of a photomontage is a 
hugely useful process that will enable you 
to identify areas of shadow and light. The 
hardest part of any composition is making a 
personal decision regarding what works and 
what doesn’t. This process enables you to 
develop a style of your own and teaches 
you to understand the basics of perspective. 
Over time, you’ll also learn where you can 
break the rules and still create a convincing 
and impressive image.

I try to keep my style individual by 
adding surreal or humorous touches to my 
work. I tend to think of my images as 
miniature theatrical environments, so for 
this image of the Royal Albert Hall I added 
a Union Jack to the floor. It’s these small 
details that set your work apart from the 
rest. Have fun!

Illustration and tutorial by Liane Wilcher

DOWNLOAD

TIME LENGTH

20 hours

INFO

London based 
Liane Wilcher 
has spent 
the last 
seven years 

practising as a freelance 
set designer. She studied 
both interior design and 
theatre set and costume 
design, but illustration 
has always been a hobby. 
A selection of her 
illustrative 3D London 
images are available as 
greeting cards. Email 
liane.wilcher@virgin.net 
or call 020 7803 9889. 

TIME LENGTH

20 hours

INFO

London based 
Liane Wilcher 
has spent 
the last 
seven years 

practising as a freelance 
set designer. She studied 
both interior design and 
theatre set and costume 
design, but illustration 
has always been a hobby. 
A selection of her 
illustrative 3D London 
images are available as 
greeting cards. Email 
liane.wilcher@virgin.net 
or call 020 7803 9889. 
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PHOTOSHOP

7 Don’t worry if your line work appears 
too sketchy. This adds a hand-drawn 

appearance to your work, which in turn adds 
bags of character. Make sure that you pay 
attention to the detail, scale, proportion and 
dimension of each object you draw, including 
windows and architectural mouldings.

8 Break up your image by drawing line work 
on different layers so that you can add 

different levels of distortion to separate parts 
of your image at a later stage. For this image, 
the layers named Linework 1, 2 and 3 were 
used to break up the image. Distortion can be 
achieved by selecting an area, using the 
Freehand selection tool, and distorting the 
shape by choosing Edit>Transform.

9  Once you’re happy with the shape and the 
distortion of your line work, create a new 

layer below the line work layer and start to 
block in colour. Use any colour you like at 
this stage as this can be altered later using 
your photos as reference. Select a new layer 
for each colour so that you can alter the 
brightness and contrast at a later stage. 
First, start with the yellow. 

12 Now start work on the interior 
elements such as the organ and 

auditorium on separate layers. To give the 
image extra depth, use darker tones to give 
the impression of shadow inside the building. 
For the line work 1 layer, use the Dodge tool 
to lighten and give contrast.

6 Use your original sketch and the solid 
trace forms you created in step 5 to start 

work on your final line work. With the Brush 
tool, add as much detail as you like until you 
are happy with the way your image looks. 
Check that the angles and perspectives of 
the building are working effectively. 

10 It’s common to get the colours wrong 
at first, so you’ll need to spend time 

altering tones and adding affects. Blocking the 
colour layers is a simple way to separate the 
layers so that you can play around later on. 
Here, I used yellow as a base layer and then 
red as a secondary tone. I could then erase 
the red to expose the yellow detail below.

11 Finish blocking in the outside façade 
using a Medium to Fine round brush. 

Add in the pavement, veranda, keyboard and 
windows. Remember that you can always go 
back to alter shapes and add shadow later.

62 |  March 2005

5 Once you’ve completed your basic sketch, use solid coloured shapes on different layers to 
form a tracing base so that your freehand line work remains accurate. Here, I used circles 

that spiralled inside each other. Use the Circle selection tool and Fill tool to draw solid circles on 
different layers and then move and resize into position, adjusting your sketch as you go.

If you find it easier 
to sketch your initial 
ideas on a sketchpad 
then do. Sketching 
from scratch or using 
photographs for 
reference is a great 
way to ensure that 
you have successfully 
planned your image’s 
perspective and 
dimensions. Just scan 
your sketch, import 
it into Photoshop 
and you’re away. 
Alternatively, use a 
Wacom tablet and pen 
to draw your image 
electronically.

SKETCHING
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13 For the organ, continue blocking in 
detail and then start to emphasise its 

three-dimensional qualities using the Dodge 
and Burn tool. This should be set on a large 
airbrush with a diameter of 500, using 
midtones at 100 opacity. 

14 Now start to emphasise the three-
dimensional qualities of what is 

essentially a two-dimensional drawing. Look 
for areas where you can sketch in shadow 
and lights to add dimension. Start with the 
blue background with the Dodge and Burn 
tool set on a broad airbrush, using midtones 
to give a shadow under the swirl and the 
outer edges of the image. 

15 For the facade, select each layer and 
apply the effects of your choice. For 

the yellow base, use the Dodge tool set on 
Airbrush, to lighten the top section where the 
swirl starts to disappear. For the red layer, 
Dodge the inner parts where the walls meet 
the three entrances and Burn the walls until 
they appear 3D. Again, use the Dodge tool to 
add a reflection to the windows.

TUTORIAL
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16 Imagine the shadows that would be 
created by the organ and balustrade. 

Create a new layer and a new colour tone. A 
deep yellow or khaki will block in these areas 
and make the organ appear as if it’s floating. 

17 Select the organ layer and, with a 
broad airbrush, use a yellow colour to 

add a soft glow to the top. For the spotlight 
effect, create a new layer, select the Elliptical 
Marquee tool, fill and then deselect. Now add 
a Gaussian Blur to create a soft spotlight. 
Duplicate this layer and change the scale of 
each spot. Merge this onto one layer and 
name the new layer “Lighting”. 

18 You can now add a little surreal 
humour by introducing a stylised 

Union Jack to the floor. Create a new layer 
and roughly mark in a Union Jack shape. 
Once refined, select the middle section and 
cut and create a new layer leaving the outer 
part to be blurred on the first layer. 

19 Set up a new layer on top of your line 
work. Now use the Rectangular 

selection tool and Fill command to create 
some flying keys. Select the group of keys and 
Distort them so they appear to fly. Create a 
new line layer and freehand around each one. 
Go to Layer Style and set a Drop Shadow with 
a Soft Blur. Finally, use a soft airbrush to give 
each key a speed trail (glow layer).

20 Create a new layer and start to sketch 
in the orchestra. From that sketch, 

refine your freehand line work and block 
in the relevant areas on another layer 
(musicians). To make this task easier, design 
just one character and duplicate it.

21 Once you’re happy with the image, go 
through each layer and play around 

with its Colour and Saturation levels. Finally, 
merge all the layers and boost the entire 
image using the Contrast and Saturation 
controls to create the desired effect. 

It’s really important 
that you plan your 
illustration fully before 
you start, as this will 
allow for more 
flexibility later. Take a 
minute to plan layer by 
layer how your image 
will be constructed. 
Get it right from the 
start and making 
changes later on in the 
process will be much 
less time-consuming.

FLEXIBILITY

Once you’ve developed 
your final line work 
layer, feel free to 
transform and distort 
different parts of the 
perspective. You can 
then start blocking in 
the colour layers. Just 
select the whole layer 
or use the Selection 
tool to enlarge or 
reduce certain 
sections. This will 
give your image a 
slightly more surreal 
appearance.

DISTORTION
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TOOL TIPS       

1When creating a custom brush preset, 
it’s worth remembering that the Brush 

tool understands greyscale. Black areas
will apply paint and white areas will not. So 
convert your image to greyscale and then 
increase the contrast dramatically so that 
there is a marked difference between the 
areas of dark and light.

Ë
The Brush tool is capable of 
creating some really interesting 

effects that lend themselves nicely to 
natural media simulation and painterly 
techniques within Photoshop.

But it’s important to remember that 
you needn’t be limited to the brush 
preset libraries that ship with your 
software. You can actually create custom 
brush tips from sections of your own 
image fi les. They save time, aren’t 
diffi cult to set up, and add a genuinely 
personal stamp to your work. 

Rough areas of texture or small 
sections of images can be used 
effectively to create unique brush tip 

presets, enabling you to produce 
convincing natural and painterly strokes. 
Ideally, you’ll want to use greyscale 
images as your source fi les, and so this 
tutorial will teach you just how to tweak 
your selected areas to create some 
top-notch custom brushes. 

Once you’ve created a number of 
original custom brushes, take a peek at 
the Dual Brush option within the 
Brushes palette. This option will enable 
you to create a seemingly infi nite 
number of different looks and effects 
from your new custom brushes.

INFO
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An infi nite number of custom brushes can be created using just a few simple Brush tool features. Illustrator 
Derek Lea reveals the essential Brush techniques you’ll need to bring your Photoshop work to life

CUSTOM BRUSH PRESETS
PHOTOSHOP

NEW SECTION

Illustration and tutorial by Derek lea

INFO

Derek Lea
is an award- 
winning 
illustrator and 
published 

author based in Toronto, 
Canada. His work 
includes disciplines
as varied as traditional 
illustration, photography, 
3D modelling, vector
art, and, of course, 
Photoshop. To view
more of his work, visit 
www.dereklea.com.
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4 Once you click OK, open up the Brushes 
palette and you’ll notice that your new 

brush preset is added to the end of the list of 
current presets. Click on the preset to select 
it and you’ll see a sample stroke displayed at 
the bottom of the palette. 

TOOL TIPS

3 Choose Edit>Defi neBrushPreset from 
the menu. A box will appear as a prompt 

for you to name your brush preset. A 
thumbnail to the left displays the size of the 
captured brush preset in pixels. Click OK.

5 You can increase or decrease the size of 
your brush via the master diameter 

slider. But for greater variation on the tip 
preset, select Brush Tip Shape from the 
menu on the left-hand side of the palette. 
Here you can alter angle, roundness and 
spacing, as well as fl ip either axis.

2 Look around within your image and 
zoom in on an irregular black shape 

that is completely surrounded by white 
pixels. Use the Lasso tool to draw a rough 
closed selection around the shape. Be 
certain that you have included a white 
border within the selection area.

6 Altering these basic features will enable 
you to create an endless number of 

different strokes. For example, by reducing 
the spacing, you’ll produce a smoother 
stroke that looks like an oil pastel. Greater 
spacing creates a rougher look, similar to 
charcoal. The image above shows the effects 
you could create using the same preset.

7 Simple variations in colour, size and 
opacity can yield impressive results. 

Once you’ve altered your brush and decided 
that you like a particular variation, you can 
save that altered version as another preset. 
Simply choose New Brush Preset from the 
Brushes palette menu and add it to the list.

8 To go a step further, alter your custom 
brush preset by clicking on the Dual 

Brush option on the left-hand side of the 
Brushes palette. Now you can combine two 
brush presets to create an entirely new 
preset. Select a preset from the menu 
provided within the Dual Brush options.

9  The options in the Dual Brush areas 
control the secondary tip. You can alter 

the diameter, spacing, degree of scatter and 
the amount of brush marks applied to each 
spacing interval. There’s also a Blending 
Mode option at the top of the palette.

10   The Blending Mode option controls 
how the two brush tips are combined. 

If you go back to the Brush Tip Shape 
section, you can alter the primary brush tip 
independently of the secondary brush tip in 
the Dual Brush area. Again, as soon as you 
hit upon a winning combination, you can
save this Dual Brush preset, too. 
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ADDING PRESETS

There is a quicker way 
to add a preset to the 
list, other than adding 
a new brush preset via 
the Brushes palette 
menu. First, select 
Brush Presets from 
the column on the left. 
Although you can view 
the presets from other 
sections, this is the 
only section that 
enables you to add 
presets in this manner. 
Simply click in the 
blank area below or 
beside your brush 
preset thumbnails. 
The mouse pointer will 
temporarily turn into a 
paint bucket and your 
current brush will be 
added to the preset list.
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Tribeworks’ iShell is regarded within 
multimedia circles as a powerful but 

easy-to-learn competitor to Macromedia’s 
market-dominating Director. Much of this 
ease of use stems from the software’s 
object-based construction. For example, 
each project contains objects and events, 
and each object can contain other objects 
and events, ad infi nitum. 

This process may seem odd, but make 
the mental adjustment and you’ll soon fi nd 
yourself able to create complex projects in 
a fast, streamlined manner. Furthermore, 
iShell projects run on both Mac and PC, 
while updating an image is as simple as 
replacing it in the Finder.

Here, you’ll create a simple movie player 
with Play, Pause and Rewind buttons, plus 
a volume control. However, the process
will introduce several other key iShell
techniques and features, such as the 
Flipbook, which is an incredibly useful 
element and essential tool in any iShell-
user’s arsenal. You’ll also try using Global 
Variables to create conditional behaviours 
for objects, and see how using iShell
Messages can reduce the amount of 
programming you have to do. Finally, you’ll 
make the whole project run as a discreet, 
free-fl oating object, rather than a standard 
window or full screen, and package it with 
iShell Runtime for distribution.

Throughout this tutorial, it’s assumed that 
you already understand basic iShell terms, 
and can perform basic actions such as 
expanding objects in the outline, editing an 
object’s attributes and dragging elements, 
events, commands and fi les from the 
palettes or project window.

MINI MOVIE PLAYER
iShell’s fl exibility makes it ideal for creating complex multimedia projects, but it’s every bit as useful for building 
very simple tasks. Rick Lecoat takes the software through its paces to create a small, bare-bones movie player

iSHELL

ON THE CD

You’ll fi nd all the fi les 
you need to complete 
this tutorial in the 
folder marked Tutorial\
CD on the cover disc. 
Start with the Project 
File, located at iShell
Tutorial>media_
player>media_player.
xp. A complete version 
of the project has also 
been included. All
fi les are for training 
purposes only.

1 Copy the media_player folder from the 
CD to your hard drive, launch iShell 

Editor and open the media_player.xp project 
fi le. From the resulting project window, 
double-click the Main.xd fi le to open its 
outline view and then open its Layout view 
by choosing Window>Layout from the 
menu bar. You’ll see that some elements 
are already in place, grouped by a box 
element (see “Box clever”, page 69).

2 Expand the section of the project 
window that deals with window settings 

and change the minimum width and height 
to 281 and 191 pixels respectively, as shown. 
This will determine the size of your base 
image. Set the window’s Kind to Custom
and check the Floating box. Leave Menu Bar 
and Effect Screen unchecked.

3Locate the fi le named video.avi in the 
project window and drag it into the root 

Elements section of the Main.xd outline 
window. It’ll now appear as a movie element 
below the Pre-placed Images box. Select its 
name and change it to “Movie”. Expand it, 
view its attributes and set the X and Y 
positions to 42 and 18. Uncheck Enabled.

4 In the project window, select No Globals 
and use the contextual menu (Mac:

Ctrl-click, PC: right-click) to Add a Global. 
Rename it “playing?”. Globals are variables 
that can be referenced by any other part of an 
iShell project and can be put to many uses.

Tutorial by Rick Lecoat
Illustration composed from ©The Infi nity Collection 

TIME LENGTH

1-2 hours

INFO

Rick 
Lecoat
is the 
creative 
director

of Shark Attack, a north 
London design studio 
specialising in 
multimedia, record 
sleeves, corporate 
identity, websites and 
publishing. Visit www.
sharkattack.co.uk to 
fi nd out more.

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.sharkattack.co.uk
http://www.sharkattack.co.uk


CD TUTORIAL

iSHELL

68 |  March 2005

One of iShell’s 
strengths is that your 
projects will run on 
both Mac and PC. 
However, not all 
versions of the two 
operating systems 
handle fi le names in 
the same way. To 
maximise cross-
platform compatibility, 
try to restrict your fi le 
names to the lowest 
common denominator 
– use only alpha-
numeric characters
(A-Z, 0-9), hyphens
and underscores (safer 
than spaces). This 
applies to both project 
and media fi les.

WHAT’S IN A NAME?

5 Now to give your Global variable a 
starting value. Place a Loaded Event 

(set to Offscreen) at root level and attach a 
Set command with settings to assign the 
Global “playing?” a Boolean Value of False.

8 A fl ipbook is an image divided into equal 
areas that is set to show only one area 

(or cell) at a time. For each of the fl ipbooks 
in step 7, expand the attributes and set Kind 
to Flipbook and #Rows to the fl ipbook’s 
number of image tiles (ie, two).

11    Attach a Set command to the 
Message event with the following 

parameters: Global/playing?/As Boolean/
Value/False. This will pause the movie 
(hence the message’s name) and update the 
Global variable, keeping a project-wide track 
of whether the movie is playing or paused.

9 In the Pause fl ipbook’s attributes, set Cell 
number to 2. This determines the cell 

initially displayed. Now position each fl ipbook 
over its corresponding symbol on the player. 
Attach a Mouse Click event to each of the 
Play, Pause and Rewind fl ipbooks.

6 Select No Messages and use the same 
method as step 5 to Add a New Message. 

Rename it “set to pause”. Drag a Message 
event to the root Events section of the Main.
xd outline window. Now select “set to pause” 
from the event’s pop-up menu. You’ll return 
to this Message event in steps 12 and 13.

7 Now place the remaining elements. Drag a Box from the Elements palette to the root of 
the outline window. Rename it “Controls”. (This box is purely an organisational aid.) Into 

this box, drag (from the project window) the “pause”, “play”, and “rewind” fl ipbooks. Arrange 
them within the layout so that they don’t overlap, as shown above.

10    Select the pause_fl ipbook’s Mouse 
Click event and attach a Run 

command (set Movie to No) and a Send 
Message command (select the Set to Pause 
message). Give the Movie a Finished event 
using the same commands, but activate the 
Run command’s Rewind box. Both of the 
preceding events will now trigger the 
Message event from step 6.

12 With the same Message event, tell 
the control buttons whether they 

should be illuminated/dimmed by attaching 
three Set Flipbook commands – setting 
play_fl ipbook to the fi rst cell (dimmed), 
pause_fl ipbook to the last cell (illuminated), 
and status_light fl ipbook to cell 2 (yellow). 
That’s the pause button fi nished.
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iShell projects can 
become very complex 
very quickly, so it’s 
important to keep 
them organised. The 
Box element has 
myriad uses, but excels 
as a grouping container 
for other elements. A 
box with zero size can 
be renamed and 
treated in the same 
way as a Photoshop 
layer set, grouping 
objects together, and 
be closed to keep your 
window tidy. Just 
remember that objects 
within that box are 
positioned relative to it.

BOX CLEVER

14 The Rewind button is more diffi cult, 
because it only lights up briefl y 

when clicked. Alongside its Duration 
attribute, uncheck the None box and assign 
a duration of 40 ticks. Attach Set Flipbook 
commands to its Mouse Click event, to set 
itself to its last cell, and the statuslight_
fl ipbook To Cell 1 (red).

13The Play button will be the opposite 
of the Pause button, so you can 

simply copy the commands that you placed 
in the Message event and paste them 
directly into the play_fl ipbook’s Mouse 
Clicked event. Just reverse the settings (Yes 
becomes No, true becomes false, First Cell 
becomes Last Cell) and set Statuslight_
fl ipbook To Cell 3 (green). Lastly, add a Run 
command (Movie>Yes).

15 Now attach two Run commands to 
the Mouse Clicked event. The fi rst will 

pause the movie; the second (with Rewind 
checked) “runs” the rewind_fl ipbook itself, 
using the 40-tick duration as a timer. After
40 ticks, the fl ipbook’s Finished event will
be activated. It doesn’t have a Finished event 
yet, so attach one now.

16 Now to instruct the Finished event.
A Set Flipbook command dims the 

button again (set to First cell). But further 
actions depend on whether the movie was 
playing or paused when the button was 
clicked. This is where your Global comes in. 
Attach an If command that checks if the 
“playing?” Global is true or false, followed
by an Else command.

17 If true (ie, the movie was playing
when the button was clicked), set

the statuslight_fl ipbook To Cell 3 and Run
the movie (Yes) from the beginning (check 
Rewind), placing these commands inside the 
If command. The same commands with their 
opposite settings (Run: No, Flipbook To Cell 2) 
will populate the Else command.

20 Finally, add the iShell Runtimes and relevant supporting fi les (according to the 
platforms you’re targeting) to the media_player folder. This project folder can now

be distributed. (See iShell documentation for more details about distributing projects.) 

19Drag the document volume.kd from 
the project window to the Controls

box in Main.kd, placing it above the three 
fl ipbooks and deselecting the Enabled check 
box (this inserts the volume slider). There 
isn’t space here to describe how we made it – 
just use the same techniques outlined above.

18 To free the project from the traditional 
window, add a Set Window command

to the Loaded event from step 6. Choose 
Custom, and specify Playermask for Shape 
and Playerdrag for Drag. The effect will be 
seen in the Runtime only.
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Having the design skills is one thing, but telling the world about 
them is quite another, argues Jerome Turner. So how do you go 
about targeting your work towards those who really count? 
ILLUSTRATION: BEAT 13

GET STARTED WITH… 

SELF-PROMOTION

Designers face challenges every day, but maybe the 
hardest part of the job is getting your work seen by that 

all-important client base. When work dries up, how do you 
keep your momentum going? And if you’re starting out on your 
own, how do you build that momentum in the fi rst place? 

If you’re about to start promoting yourself, your clients will 
want to know who you are and what you do, but before you can 
tell them, you’ll need to fi nd out for yourself. Assess your 
background, your skills, your unique qualities – and the 
services you plan to offer. Even if you think your artistic style 
is similar to others, maybe your manner of working and hitting 
deadlines is exemplary. If so, you need to shout about it.

As long as you’re critical in a positive, constructive way, this 
will boost your confi dence, as well as give you an idea of what 
sort of brand identity would best suit your work and whom to 
approach as potential clients. If you’re currently working with a 
studio, or already have steady work and are on the verge of 
starting your own practice, this will also let you double-check 
that going solo is the right choice for you.

This self-assessment technique could also be used to identify 
your skills before going for an internship or job interview. And 
in the long term – if you’ve just started out – an internship could 
be just the thing to establish your reputation for the future, as 
designer R. Kyle Everett of www.staticframe.com explains: Ë
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Even if the work isn’t there to back it 
up, it still shows to potential employers
that you can function well in real 
world situations, outside of an 
academic environment.”

ESTABLISHING A REPUTATION
They say there’s no such thing as bad 
publicity, but we all know that isn’t 
true. No client will want to speak to a 
designer who is known for blanket, 
unfocused marketing. However, if 
your promotion is considered and 
personalised to the interests and needs 
of each client, they will be more 
inclined to sit up and listen. So that 
basically means no spam emailing,
no random fl y-posting – and no junk 
mail. It may take a little more time to 
make each approach personal and 
well researched, but it’ll be well worth 
it in the long run.

A clear CV and portfolio website 
featuring your best work is essential, 
of course, but these days that alone 
won’t push your head above the 
crowd. “You can’t depend on the 
website alone to land you a job,” says 
Everett. “It really needs to be there as 
a reference so that you can plaster the 
URL on anything you send out. Some 
people will look at your website, some 
people won’t; it all depends on 
personal preference.

“The two strongest methods for 
promoting yourself on the internet
are through job sites and site linking,” 
he continues. “Some employers 
actually do surf job websites such as 
AIGA design jobs, Corofl ot, and 
Creative Hotlist looking for new 
talent, so it helps to get your resumé 
and portfolio up on as many of those 
websites as possible.”

STYLE VERSUS CONTENT

A portfolio site, in the same way as 
any website, is a balance of two 
things – content and design. Your 
designs will need extra special 
attention, so the website’s design 
should show off your talents 
without overpowering the content. 

If you’re a Flash animator, try 
something fun and innovative, but if 
your skills lay in HTML and CSS, 
you should perhaps display your 
work in a simpler, clearer layout. 
It’s a question of showing the client 

what you can do, not what you think 
they will want to see. 

As far as content goes, be clear 
and concise. Pick out your best 
projects with a few supporting 
images and probably no more than 
50 words to describe each. Do you 
need a CV link? This depends on 
your intention. If you’re a student 
looking for an internship, it might 
be appropriate, but freelance 
designers should allow their 
commercial work to carry them. 
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Take a look at some of the better-
known design sites (see left) and 
you’ll soon see why and how they 
refl ect their brand accurately. 
2advanced.com is a great example, 
and one of the most talked about 
portfolio sites. Many would say the 
über-techno animation and design 
is overblown, but it does well to 

promote 2advanced’s style and 
illustrate its work. On the other 
hand, presstube.com is a simpler 
“black lines on white” affair and 
refl ects James Paterson’s “hand-
drawn” animation style. 

Another famous site, praystation.
com (now rebranded as 
joshuadavis.com) is rendered in 

sleek, elegant shades of grey,
and reveals a layout and animation 
style often refl ected in its client 
work. Compare www.808inc.com 
with www.joshuadavis.com – 
maybe the client saw the site and 
asked for something similar? 
A perfect example of promotion 
through a website.

PROMOTE YOURSELF ONLINE

2advanced.com, still one of the most talked 
about portfolio sites in the design community, 
vividly showcases the studio’s key strengths.

“The most important thing you can get 
out of an internship is not necessarily 
the work, but rather the experience. As 
a student, it is really important that you 
have that experience on your resumé. 

Presstube.com exhibits James Paterson’s 
clean-lined work to excellent effect.

Joshua Davis Studios was commissioned to design www.n-gage.com/worms, the mini-site to promote Worms World Party for Nokia’s
N-Gage gaming device, on the strength of its online portfolio. See www.joshuadavis.com (formerly praystation.com) for details.
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Computer Arts: How did Black 
Convoy start?
Richard May: McFaul and I had been 
saying how great it would be to get a 
number of people together for an 
exhibition. There was no name back 
then – just an idea.

John McFaul: I’d known Rich for a 
little while and we felt the same way 
about where our careers were 
heading. We wanted Black Convoy 
as a vehicle to pull us into other 
design disciplines. 

Computer Arts: How did you fi rst 
promote yourself?
RM: The promotion just happened by 
chance. McFaul and I are members 
of Pixelsurgeon, which helped get 
this something rolling. We have 
captured people’s imagination 
purely through word of mouth and a 
“quick” website.

Computer Arts: How has Black 
Convoy helped you pull in work?
JM: There has obviously been huge 
interest since we hinted at the show 
a few months back. Rich, Jon 
[Burgerman] and I have had to deal 
with The Arts Council bid and other 
associated bits and bobs both in the 
UK and USA, so I’m sure all this can’t 
be doing us, as individuals, any 
harm. The direct relation between 
Black Convoy and a commission isn’t 
necessarily there, but the desire 
from interested parties to work with 
us has been astounding.

FEATURE

So get the basics right, and then 
consider how you can make your 
services known to the clients you’d 
most like to work with. Use creative 
self-promotional techniques that 
reference back to your site, or enable 
you to offer the client a printed CV, 
and think of both CV and portfolio
as your backbone. 

EVERYONE’S A WINNER
Entering competitions and, more 
importantly, winning them can earn 
you huge kudos within the design 
community, but, professionally 
speaking, this route might only be 
worth pursuing if your clients learn of 
your awards, too. They’re probably not 
too bothered by your Photoshop tennis
skills unless that relates to the services 
you’re offering them. 

Olly Moss, a UK-based designer, 
has had two T-shirts printed as a result 
of the www.threadless.com T-shirt 
design competitions. “Freestyle 
competitions, such as Threadless,
help to inspire and produce quality, 
commercially viable work that 
functions equally well as an 
advertisement for the designer 
himself,” he explains. Moss’s work is 
recognised via the site by the design 
community, but, more importantly, it 
is also mass-produced and worn, 
which distributes his brand to a much 
wider audience. “I’ve had a few 
interesting emails that could well lead 
to further business, including 

WE CATCH UP WITH 
BLACK CONVOY’S 
RICHARD MAY AND 
JOHN MCFAUL 

DESIGNER TIPS

“There should be a 
consensus as to the
goals and needs that

your collective sets out to achieve. 
Make sure there’s open dialogue 
between all members, as much 
as possible.”
Dushan Milic, illustrator 
www.replessabandon.com

“To be interesting – to me
at least – a project must be 
“different” and international. 

International, because it’s important 
to take part in collaborations with 
designers from around the world, 
and because I believe in the power 
of networking.”
Giuseppe Contaldo, designer
www.neuville.it

“Saying that you have 
actually won competitions is 
always a big hit – they can 

add serious clout to your CV.”
Olly Moss, design student

Olly Moss’s striking T-shirt design for the Threadless competition site (www.threadless.com) 
has been worn all over the world – what better advert for your work?

Giuseppe Contaldo’s postcard design was 
used to promote the Lost Paradise Galleries 
project – and, in turn, his own work. 

Power in numbers: the work of Dav Bordeleau, co-founder of Repless Abandon, an 
illustrators collective, has helped to promote the collective as well as his own work.

Ë
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ensure that people know exactly who’s 
created the work (you) and how they 
can contact you (through your URL). 
If the project can be affi liated to a 
famous and respected brand, it won’t 
do your own reputation any harm, as 
Contaldo found on a recent project: 
“For Lost Paradise Gallery, I created a 
three-postcard piece of art. The 
project was sponsored by Diesel and 
is a favourite piece in my portfolio.”

WITH A LITTLE HELP…
Students taking their fi rst steps into 
the world of competitive design can 
often fi nd that fi rst leap quite daunting 
– after all, why would a client care 
about just another graduate when so 
many professional designers are 
already out there eager for work? 
Clever promotion at this stage, 
therefore, is essential.

“We were just a group of 
illustrators graduating from Sheridan 
College three or four years ago,” 
remembers illustrator Dushan Milic. 
“There was a group of about 15 of us 
who were really good friends, brutally 
honest and constantly pushing each 
other’s work. So, we graduated and, 
after attempting to do some promos 
on our own for a while and fi nding out 
how expensive it was, Dav Bordeleau 
and I decided to start calling in our 
other illustrating friends.” And so the 
Repless Abandon collective was born. 

Milic says that around 50 per cent 
of his work comes through Repless 
Abandon (RA), but the benefi ts aren’t 
as obvious as they might seem. There 
is now the added kudos of being part 

of something “big”, but the collective 
also works as a sharing community. 
“We’ve got plenty of clients through 
other members. On numerous 
occasions, Repless Abandon has had 
work from multiple members 
featured in the same publication/issue, 
or have had multiple members bidding 
on larger projects.”

GET OUT MORE
A good promotional product or site is 
great, but sometimes it takes a bit 
more effort, so try getting out more. 
“The best way to get anywhere is still 
good old-fashioned networking,” says 
Everett. “Go to events held by the 
design community to mingle with 
other designers. If you see a lecture of 
someone you admire, don’t be afraid 
to talk to them afterwards. You’ll stick 
out in their mind.” 

With a little research, you will 
probably fi nd a group or organisation 
locally that encourages this kind of 
networking and business promotion. 
They should be able to fi nd you 
information about events, seminars 
and networking nights. In the UK, the 
Arts Council (www.artscouncil.org.
uk) is a good place to start. Not every 
handshake and business card will lead 
to work, but a face and winning smile 
to match is far more memorable than 
any email or CV, and people, by 
nature, will talk. A friend of a friend 
of someone you chatted to on the 
phone a month ago might just be
your next big client. 

one from the drummer of the band 
Less Than Jake,” he admits. “I have 
found, however, that the rewards are 
decidedly more indirect. Other than a 
deluge of traffi c to my website, the 
effects of winning are more noticeable 
when padding out my portfolio.” 

Competitions encourage designers 
to work with an understanding of the 
wider creative community, and, as a 
result, collaborations and non-profi t 
projects can spring up quite easily. 
But can they be justifi ed if they’re not 
always directly connected with 
commercial, money-making work? 
Well, there are other benefi ts...

“You increase your website 
visibility, but this works in the short 
term only, so it’s not a very important 
issue,” says designer Giuseppe 
Contaldo (www.neuville.it). But,
as everyone knows, the web is 
worldwide, so what better way to 
reach a wider audience? Contaldo 
agrees: “You get an international 
positioning that enables you to work 
out of your local network.”

Collaborations are also an effective 
way to promote your work. Word of 
mouth, and the ability to build good 
relationships with people and clients, 
will enable you to work as a freelancer 
in a world of freelancers. It pays to be 
careful, though. If this kind of non-
commercial work is taking up your 
time, make sure you use it wisely – 

ANOTHER WAY? 
THINKING OUTSIDE 
THE BOX

Eric Barlettani’s idea for the 
promotion of his design service 
(www.madewild.com) was inspired 
by a project he’d heard about in 
Boston: a free art gallery where 
visitors could help themselves to 
the sculptures, pictures and 
canvases on display. 

Barlettani transported this idea 
to an art event in his hometown, 
leaving his own hand-painted 
canvases for people to pick up. 
“Instead of glorifying paint 
splotches, it was about promotion. 
The message kind of turned into, 
‘Yeah, we are creative, and we have 
business sense, too.’ The people 
who found the canvases around 
town were enthusiastic, fi rst 
asking, ‘Is this free? Whose is this?’ 
My URL was on the back, written 
small inside the frame.”

FURTHER READING

Title Business Cards: The Art of Saying Hello 
Author Michael S. Dorrian and Liz Farrelly
Publisher Laurence King Publishing
ISBN 1-85669-386-4
Business cards help you promote your personal brand to the real world
– a palm-sized product that not only describes your work, but in the case
of graphic designers, shows off your skills, too. The Art of Saying Hello (see 
full review in issue 106) showcases over 300 innovative card designs, proving 
just how easy it can be to make an impact, even when space is really limited.
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● Create textures in Photoshop
● Set up a wireless iTunes server
● Generate an online photo album
● Get hands on with Apple Motion
 And much more!

How to... The best tutorials

PLUS! This issue, we bring you...

Save money with our round-up of the 
best £200 or less digital cameras. Plus, 
first review of the iPod shuffle and more! 

Reviews The best tests

It’s the place to come for solutions to 
your Mac questions. Just write in!

Q&A The best advice

ON SALE FEB 9

Small is beautiful

Get the full low-down

on the new Mac mini

and iPod shuffle

this issue!

www.macformat.co.uk
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REVIEWS
All the latest kit, put to the test

HARDWARE
LEXMARK X7170 P84

SOFTWARE
PHOTOSHOP ELEMENTS 3.0 P78
POPCORN 1.0 P80
EYE CANDY 5 NATURE P81
TWIXTOR PRO 4.0 P82
MIMIC PRO 3.1 P83
CHARTBOT P85

All our products go through rigorous testing and 
only truly outstanding and essential pieces of kit 
receive the coveted fi ve-star rating.

REVIEWS

GROUP TEST: WORKSTATIONS
3D BOXX P90
PRECISION 670MT P90
3D WORKSTATION P91
INTELLISTATION P91
RM WORKSTATION P92

BOOKS
THE DESIGN ENCYCLOPEDIA P87
THE BEST OF BROCHURE DESIGN 8 P87
PHOTOSHOP CS TRICKERY AND FX P87
SHADER X3 ADVANCED RENDERING
WITH DIRECTX & OPENGL P87

RECOMMENDED
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REVIEW

ELEMENTS HAS PROVED POPULAR 
WITH CASUAL PIXEL PUSHERS KEEN TO 
HARNESS THE POWER OF PHOTOSHOP

Adobe’s popular Elements title 
should need little introduction. 

Offering the core functionality behind 
the industry standard Photoshop 
software, Elements has proved 
popular among casual pixel pushers 
keen to harness the power of 
Photoshop but unable to justify the 
professional price tag. 

Needless to say, at roughly a tenth 
of the price, Elements is scaled 
down somewhat but that doesn’t 
mean that the software is lacking.

The previous Elements 
iteration boasted an interface that 
remained largely faithful to the more 
fully featured Photoshop CS. And 
although some new users were 
baffl ed by the array of palettes, with 
some perseverance it did provide a 
useful stepping stone towards the 
full version. However, more casual 
users failed to warm to the interface 
and many of Elements’ tools 
remained unused.

The main point of interest with 
release 3 is the noticeable difference 
between versions for Mac and PC. 
Although many of the key editing 
functions remain, the Windows 
version boasts additional utilities 

with organisational aspects in the 
shape of Adobe’s Album software, 
which allows users to view and 
organise their fi les.

Mac users don’t receive such 
enhancements, mainly because the 

Apple OS includes similar features 
through the likes of iPhoto. This may 
go some way to explain the price 
difference, as well as the more 
noticeable disk space requirements.

The Mac version provides a File 
Browser, a feature familiar to 
Photoshop users, complete with 
available Metadata and editable 
keywords. The Windows version, 
however, uses the more newbie 
friendly Organizer component 
introduced via the Album software. 
This provides the same basic 
functionality but through a much 
simplifi ed interface that will appeal 
to the more casual user. But once an 

image has been opened, Elements’ 
core purpose, editing bitmap 
images, comes into play and the 
features and interface of both Mac 
and Windows versions appear to be 
virtually identical.

The interface draws on Photoshop 
CS for influence, although it is now a 
little more accessible to the less 
experienced user. Numerous Wizard-
based effects take good care of 
routine adjustments, which are then 
further simplified by dual edit modes. 

In Standard Edit mode, you get 
full access to all the standard 
features, although even these might 
prove a little tricky for most 
beginners. But switch to Quick Fix 
mode and you can toggle the 
interface into a much more 
immediate environment with sliders 
to control fundamental elements 
such as light and colour adjustment.

MAC Yes    PC Yes

PRICE

MAC £57.58 (£45.83 upgrade)
PC £69.33 (£52.88 upgrade)

  
CONTACT

Adobe
020 8606 1100
www.adobe.co.uk

FEATURES

•  Spot Healing Brush and 
Healing Brush tools

• Camera Raw support
• 16-bit image support
• Quick Fix mode
• Shadow/Highlight feature
• Improved print features
• Red Eye Removal tool
• PDF slide show creation
•  Improved asset 

management
•  Adobe Album integration 

(PC only)
 
SYSTEM

MAC: PowerPC G3, Mac OS X 
10.2.8 or 10.3, 256MB of RAM, 
200MB HDD
PC: Pentium III 800MHz, 
Windows XP SP1/2000 SP 4, 
256MB of RAM, 600MB HDD

FOR

•  Costs a fraction of the price 
of Photoshop

• Easy to use
• Instant results
 
AGAINST

•  May be too limiting for 
professionals

•  Some Wizards lack control
•  Album features not 

available to Mac version

VERDICT

            

Although not as powerful as the 
full version of Photoshop, 
Elements 3.0 provides a useful 
way for novice designers to get 
to grips with core functionality. 
Plus, with the integration of the 
Album tools, PC users will fi nd 
an extensive suite of image 
management tools, too.

RESOURCE

The Adobe 
website offers a 
range of tutorials 
for Mac and PC 
that will help you 
master grouping 
shots, creating 
slide shows and 
sharing your 
images. Just visit 
www.adobe.
co.uk/products/
photoshopelwin/
main.html.

  A GREAT PACKAGE FOR CASUAL USERS LOOKING FOR PHOTOSHOP TOOLS, WITHOUT THE HEFTY PRICE TAG 
 

78 |  March 2005

When size matters, 
Apple’s 30-inch high-
defi nition display is a 
real must have.

LEFT: In Quick Fix mode you 
can choose to work with 
Before and After views to 
gauge how your adjustments 
alter the original image.

Photoshop Elements 3.0
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You can still use a more manual 
approach. The Spot Healing Brush 
and Healing Brush, for example, 
introduce popular Photoshop 
retouching features that allow the 
instant removal of marks from your 
photographs. A new Red Eye 
Removal tool reduces the guesswork 
of such tasks with just a single click.

The Shadows/Highlight feature, 
another popular Photoshop tool, 
allows you to transform your images 
by altering shadow, highlight and 
midtone balance to rescue fi ne detail 
from your original photographs. 
For users with higher demands, the 
introduction of a Histogram palette 
will allow you a more accurate 
overview of your image’s colour 
composition. Support for 16-bit 
images and Camera Raw format 
will defi nitely fi nd favour among 
keen photographers.

A raft of special effects will help 
you turn even the most average 
snapshot into something a little 
more adventurous, whether you’re 
constructing creative composites, 
simulating natural media or adding 
punch through common effects such 
as drop-shadows, bevels and glows.
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Output options include regular 
print and email varieties such as 
automated image optimisation, 
while PDF support allows you to 
create a universally accepted PDF 
slide show in minutes. Alternatively, 
you could choose to create a web 
gallery using customisable templates 
and upload them to your web server.

Adobe has been quick to identify a 
distinct market for reduced 
applications such as Photoshop 
Elements and Premiere Elements 
1.0, the popular video-editing tool for 
the home camcorder user. But when 
compared with Photoshop itself, 
professional users will fi nd 
Photoshop Elements limiting. 

Photoshop has long ruled the 
roost among raster image-editing 
apps. Its massive, comprehensive 
toolset caters for almost every 
eventuality. But such an extensive 
range of options is unnecessary and 
confusing for the casual user. 

Elements successfully focuses on 
the more fundamental options, 
choosing to simplify the whole image 
editing process with direct tools and 
automated controls to make working 
with digital imagery a breeze. 

The noticeable difference 
in price and installation 
size between the Mac 
and Windows versions of 
Photoshop Elements 3.0 
highlights a key difference 
between the related titles. Mac 
users may be more inclined to use 
their OS X iPhoto utility to manage 
their growing image libraries 
while Windows users can take 
advantage of Organize, a title that 
derives from the previously 
available Adobe Album. 

With infl uences taken from 
Photoshop’s File Browser, the 
software provides a more obvious 
method of managing your images 
into collections, viewing images 
by dates, associating keywords 
with images and carrying out the 
most basic adjustments.

ORGANISING ASSETS

1
2

3

5

4

THE INTERFACE

1. The Elements interface introduces 
some sensible simplifi cation. The 
tool bar icons populate the left-hand 
side of the screen with a range of 
familiar menu items.

2. The Windows version of Elements 
includes additional icons, which 
transfer your work to related 
components of the Elements suite.

3. The main working area allows 
plenty of room for your images while 
common commands such as Levels 
and Curves can be adjusted using 
methods similar to Photoshop.

4. The inclusion of Quick Fix and 
Standard Edit modes means you can 
now toggle the available options to 
suit your experience.

5. Like Photoshop, a range of 
palettes can be found to the right of 
the interface. These include Help 
topics and Effects in addition to the 
regular Layers and History options.

Despite other noticeable differences between Mac and PC 
versions, the core Elements interface remains identical 
between platforms.

The Windows-only Organizer replaces the Photoshop 
File Browser and introduces features previously only 
found in the stand-alone Adobe Album software.  
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REVIEW

COPY SPEEDS WILL 
DEPEND ENTIRELY ON 

YOUR DVD DRIVE  

There’s no point pretending that 
Popcorn is anything more than a 

one trick pony. It does a good job of 
copying DVDs, and that’s it.

From just one simple interface 
screen you can choose to create a 
DVD directly from a disk, from a 
video_TS folder or a disk image file. 
You can also copy from a disk to a 
video folder or disk image on your 
hard drive or choose to copy either 
the entire disk or just the main movie.  

Options to customise the copy are 
fairly basic, too. Once you set the 
software in motion, the speed of the 
process will depend entirely on your 
DVD drive speed (ours took around 
45 minutes for a full disk).

When it comes to compression, 
Popcorn does the job, but isn’t nearly 
confi gurable enough. It’ll take a 
standard shop-bought DVD (which 
can contain up to 9GB of data) and 
compress it to fi t onto a blank DVD of 
just 4.7GB. This compression is of a 
pretty high standard, and the program 
automatically adjusts so it fi lls the 
disk without over compressing. But 
you can’t control it, so it’s impossible 
to put more than one fi lm on a DVD, 
or create a VCD or S-VCD disk.  

Popcorn 1.0

Popcorn isn’t really designed to 
produce non-DVD copies of your 
movies (coding them as AVIs, or 
recompressing them to other 
qualities, for example). It simply 
produces a mirror image (or a 
slightly reduced quality version) of 
your original disk. We think a few 
compression adjustment tools would 
be a welcome addition.

One of Popcorn’s unsung features, 
however, is it’s rather neat cover-
design software. This set of 
templates and text tools allows you 
to produce DVD covers and disk 
stickers quickly and easily. There’s a 
selection of backdrops as well as a 
few basic painting tools and a text 
path function, which automatically 
lets you bend text around a disk 
label. This isn’t ground breaking and 
you could do the same in Photoshop, 
but it’s all set up for you and you can 
be ready to print a cover in minutes.

Popcorn won’t copy protected 
DVDs, which includes the vast 
majority of commercially available 
disks, and if you try to make illegal 
copies a helpful pop-up displays a 
warning message and underlines 
that Roxio will not condone the 
download of decrypting programs to 
assist the production of illegal 
copyrighted fi lms and DVDs. 

Now that DVD has become the 
medium of choice for anyone 
producing video, copying and 
distributing material can be a bit of a 
chore. But whether it’s enough of a 
chore to make this package 
desirable will depend on just how 
much copying you plan to do.

MAC Yes    PC No

PRICE

£34.99

CONTACT

Roxio
01908 278100
www.roxio.co.uk

FEATURES

•  Duplicate DVDs
•  Quickly copy DVD fi les to 

your hard drive
•  Create DVD videos from disk 

images on your hard disk
•  Design covers and labels
•  Compress commercial disks 

to standard 4.7GB DVDs
•  Copy whole disks or choose 

to leave out menus, subtitles 
or special features

•  Use dual layer disks 
(hardware permitting)

•  Share DVD burners over 
a network

SYSTEM

Mac Power PC G3 or later, Mac 
OS X v10.2.8, 15GB disk space 
(for copying), DVD burner

FOR

•  Fast
•  Easy to use
•  Good label-printing software

AGAINST

•  Disk compression cannot
be adjusted

•  There are plenty of free 
alternatives available

  A SIMPLE, NO-FRILLS WAY TO COPY AND PACKAGE DVDS WITH MINIMUM FUSS
 

RESOURCE

Most commercial 
DVDs include copy 
protection. As a 
result, Popcorn 
won’t create 
backups. Online 
applications such 
as MacTheRipper 
will make copies, 
but stress that they 
should only be 
used to create 
backups of DVDs 
you already own.
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VERDICT
This cheap and easy program 
boasts great label and sleeve 
creation tools, and it can easily 
compress 9GB disks for a 4.7GB 
recordable. But everything you 
can do with Popcorn you can 
do for free. So do you do enough 
DVD copying to make Popcorn’s 
convenience worthwhile? 

ABOVE: Popcorn makes copying 
DVDs really easy. Just choose to 
copy the whole disk, or just the 
main feature, and you’re away.

RIGHT: The software boasts a 
useful set of text tools designed to 
make easy work of creating sticky 
labels for your DVD.

The great cover-design software 
provides a range of presets to make 
light work of packaging your DVDs. 
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REVIEW

A lien Skin is onto a winner
with its Eye Candy series of 

Photoshop plug-ins – the original 
Eye Candy was released way back
in 1994 under the name Black Box. 
Eleven years later, the brand is still 
going strong – and the second 
instalment in the latest Eye Candy 5 
series has now arrived.

The fi rst in the series, Textures 
(reviewed in issue 102) was all about 
generating interesting effects such 
as fur and metal for use in 2D and 
3D illustrations. Nature, however, 
takes a slightly different tack, 
generating ten different kinds of 
natural phenomena. The plug-in 
features four new fi lters – Icicles, 
Ripples, Rust and Snow Drift – and 
six reincarnated and improved Eye 
Candy “classics”.

The interface has seen little 
change. It’s simple and user-friendly 
and Alien Skin continues to let the 
effects take centre-stage. A large 
preview window features a tabbed 
system containing presets, basic 
controls over each fi lter effect and, 
in most cases, lighting controls.

So on to the effects. Icicles is 
hardly an everyday affair, but the 

fi lter does have its uses, especially 
when combined with the other 
effects. For example, you could use it 
with Snow Drift to “freeze up” your 
illustration or photo. The effect 

works with selections, too. Just 
select the area of your image from 
which you wish icicles to form and 
then use the sliders to adjust their 
length, width, density and shape. The 
preview updates in virtual real-time, 
although the more complicated the 
image (and this goes for all the Eye 
Candy effects), the longer the 
preview will take to render.

Ripples creates reasonably 
convincing rippled water effects, 
and the presets are great if you’re 
starting from scratch. The same 
goes for Fire, Corona, Smoke and 
Squint, the latter providing a wide 
range of blur effects to give the 

impression of squinting or 
double-vision.

But undoubtedly Eye Candy 5 
Nature’s most impressive feature is 
Snow Drift –  it’s one of the best 
fi lters we’ve seen in a long time. It 
does a blinding job of coating your 
image with a covering of frost or 
snow (using the dusting settings) to 
create a convincing winter scene 
with just a little extra Photoshop 
work (check out the cottage image 
above if you don’t believe us). This 
process would take days in 
Photoshop alone.

Rust, a little unconvincing in its 
output, is a small glitch in the Eye 
Candy package, as is Water Drops, 
which should be used sparingly to 
create a realistic effect. But all in all, 
Eye Candy 5 Nature is a decent plug-
in. Its effects won’t be to everyone’s 
taste, and using them within 
professional artwork requires 
careful consideration, but, like
any effect, used sparingly they’ll 
greatly enhance your imagery and 
productivity. Alien Skin has 
impressed us with the fi rst two 
releases in this series, and we look 
forward to the fi nal instalment.

MAC Yes    PC Yes

PRICE

£79.99

CONTACT

Alien Skin
020 8358 5858 
www.alienskin.com

FEATURES

Simulate natural
phenomena, including:
•  Fire
•  Icicles
•  Ripples
•  Rust
•  Smoke
•  Snow Drift
•  Squint
•  Water Drops
•  Corona
•  Drip

SYSTEM

Photoshop 7, Elements 2, 
Paint Shop Pro 8, Fireworks 
MX 2004 or later
MAC: 500MHz G3, 256MB 
RAM, OS X 10.2.6 or later
PC: 1GHz Pentium III, 256MB 
RAM, Windows 2000 or XP

FOR

•  Original and
high-quality effects

• Excellent Snow Drift effect
• Relatively inexpensive

AGAINST

• Some effects appear a 
    little cheesy

VERDICT

            

Used sparingly and sensibly, 
Eye Candy 5 Nature can add 
some amazing effects to
your imagery. Snow Drift, in 
particular, is outstanding.
Everything is so easy to apply, 
and at £80 it’s pretty good value, 
too. If you’re into effects, this is 
a really worthwhile buy.

  THE LATEST INSTALMENT OF ALIEN SKIN’S SEMINAL EYE CANDY AIMS AT THE NATURALIST (NOT NATURIST) IN ALL OF US
 

RESOURCE

Check out the 
Alien Skin website 
at www.alienskin.
com for more 
examples of what 
Eye Candy 5: 
Nature can do.
In addition, you 
can easily 
download Alien 
Skin products
as 30-day, fully 
functioning trials.

SNOW DRIFT IS ONE 
OF THE BEST NATURAL 

FILTERS WE’VE SEEN 
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ABOVE: Snow Drift is by far our favourite
Nature effect. Believe it or not, this shot of a 
country cottage was taken mid-summer.

LEFT: Other Nature effects can deliver 
convincing results as long as they’re used 
sparingly. Here, we’ve applied Squint to create 
the impression of double-vision. 

Eye Candy 5 Nature
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REVIEW

SLOW MOTION HAS THE 
LOOK AND FEEL OF 

OVER-CRANKED FILM

It is often said that the only way to 
accurately speed up or slow down 

footage is to use a fi lm camera. 
Although many video editors happily 
change the speed of a clip in After 
Effects, the results are often jittery, 
and never achieve the fl uid 
appearance of slow-motion fi lm. The 
Twixtor plug-in changes all that.

Twixtor Pro 4.0 has several uses, 
including the ability to change frame 
rates to create a “fi lm-look”, but the 
most impressive aspect is it’s ability 
to speed up or slow down a clip.

By carefully tracking each pixel, 
and doing calculations so impressive 
most people couldn’t start to 
understand them, Twixtor creates 
new, smooth frames by warping and 
interpolating your interlaced footage. 
As expected, render times can be 
hefty, but not impractical.

You can speed up or slow down an 
entire clip, or change the pace at 
different stages. Imagine you’ve shot 
a fi ght scene, and you want to create 
an ultra-fast Crouching Tiger, Hidden 
Dragon effect, where the punches 
and kicks happen at supernatural 
speed. Twixtor enables you to speed 
up those exact moments with 
incredibly realistic results. 

Slow motion, usually so diffi cult to 
achieve in DV without fl ickering 
frames and overlapping images, has 
the look and motion of over-cranked 
fi lm. This, alone, justifi es the price. 

Changes to frame rates produce 
equally impressive results. You can 
take interlaced footage and convert it 
to the same frame rate as fi lm – 
24 progressive frames per second – 
which is essential if you want to print 
your DV to fi lm, or achieve a fi lm-
look on a TV screen. 

Most fi lm-look techniques and 
plug-ins simply reduce vertical 
resolution. Twixtor uses pixel-
tracking technology to generate 
motion blur and frame blending that 
looks like genuine footage. You can 
achieve a similar fi lm look with 
Magic Bullet, although Twixtor’s 
render times seem much faster.

One of Magic Bullet’s most 
appealing features, however, is that 

you can apply the filter, let it work out 
the best settings for you, and then 
start your render. Twixtor is far more 
complicated. It takes a good few hours 
to get to grips with the software, and 
unless you’re familiar with filters, 
frame rates, interlacing and 3:2 pull-
down, you might struggle.

In real-world use, Twixtor is fi ddly, 
and far from automatic. You are 
always required to intelligently input 
settings, sometimes more than 
once. But at least this gives you the 
option to track specifi c pixels in the 
foreground and background, and 
ensure that you get exactly the 
results you planned. 

The manuals are part of the 
problem, fi lled with annoying asides 
for each host application, and jargon 
that many users won’t understand. 
It’s surprising that a demo version of 
the software is available for 
download, rather than just sample 
outputs. We think some users might 
fi nd the Twixtor interface so 
confusing they will give up.

Twixtor is undeniably powerful, 
and it is worth ploughing through the 
manuals and fi ddling with the 
settings because the results really 
are impressive.

MAC Yes    PC Yes

PRICE

Twixtor 4 Pro £318.28
Upgrade (from any previous 
version) £141.76

CONTACT

Re:Vision Effects, Inc.
www.revisionfx.com
sales@revisionfx.com

FEATURES

•  Warping and interpolation 
of frames 

•  Smart processing of 
interlaced material

• Sequence stretching 
•  Calculation of motion 

vectors at each pixel
• Keyframeable re-timing 
• Motion blur removal 
•  Re-map audio and video 

using After Effects
•  Support for foreground and 

background separation 
•  Up to 12 tracking points to 

guide motion estimation

SYSTEM

MAC: Mac OS X or later
PC: Windows 95/98/NT 4.0/
ME/2000/XP
Host applications: After Effects 
5.0, Premiere Pro 1.0, Final 
Cut Pro 4.0, Combustion 3.04

FOR

•  The best results for time-
warped footage

•  Excellent frame-rate outputs
•  Ability to track motion 

manually on diffi cult clips

AGAINST

• Steep learning curve
• Complex interface
• Confusing manual RESOURCE

As Twixtor is so 
diffi cult to use, the 
tutorials at http://
www.revisionfx.
com/rstwixtor
tutorials.htm are 
well worth a look. 
They don’t exactly 
simplify things, but 
they do show you 
how to apply the 
fi lter to achieve a 
range of really 
impressive results. 

  REALISTIC SLOW MOTION, FILM-LOOK AND ULTRA-FAST FOOTAGE WITHOUT THE NEED FOR A CAMERA
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VERDICT
Twixtor is pretty complex, takes 
time to get used to, is tricky to 
use and creates hefty renders. 
But if you want to change frame 
rates, or the speed of a clip, this 
is the plug-in you’ll need. We 
think the results are beautiful 
and better than anything else 
currently on the market.

IMAGES FROM TOP:
The fast motion of this dancer is 
slowed down beautifully, with 
accurate motion blur and no 
fl ickering at all.

Diffi cult clips can be fi ne-tuned by 
tracking points that could otherwise 
by missed by the plug-in.

Changing the frame rate gives an 
output with a fi lm-like quality when 
viewed on a television screen.

Twixtor Pro 4.0
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REVIEW

Hollywood movies featuring CG 
characters that speak, emote 

and act, often inspire us to give 
character animation a go. But when 
the credits roll it soon becomes clear 
that it took an army of animators, 
working with expensive software, 
years to create the animated 
characters on screen. So for those 
working in rather more average 
situations, upstart DAZ Productions, 
developer of DAZ|Studio and the 
ever-popular, Poser-ready 
characters and props, has provided a 
unique solution – Mimic Pro 3.1.

One of the most tedious aspects 
of bringing a CG character to life is 
speech animation. Thus the basic 
concept behind Mimic is simple – 
import any audio fi le (WAV) or record 
your own with Mimic’s basic 
recording tools, and the Talkback 
engine will attempt to synch the 
audio to the appropriate mouth 
position by analysing the phonemes 
– the smallest units of spoken 
language – in the fi le, in a process 
otherwise known as lip-synching.

Mimic’s initial attempts at lip-
synching are a little rough, but to 
refi ne this the program can also 

Mimic Pro 3.1
analyse a phonetic text fi le in 
addition to audio fi les. The phoneme 
track in the timeline allows users to 
fi ne tune the position and strength of 
the phoneme morphs to easily adjust 

the lip-synching process, so there 
are no excuses for sloppy animation.

Mimic is more than just a lip-
synching tool. The timeline’s Gesture 
track, for example, allows the entire 
head and face to be animated with 
controls for blinking, winking and 
eye, brow and head movements. 
Additionally, users can drag-and-
drop editable expressions from the 
Expressions palette into two timeline 
Expression tracks to create 
emotions such as, anger, sadness 
and happiness, or to morph from 
one expression to another. For added 
realism or to copy mannerisms the 
Video window loads live-action video 

allowing side-by-side comparisons 
between live-action and animation.

A major upgrade from previous 
versions, Mimic Pro 3.1 is a stand 
alone app that’s capable of rendering 
basic animations and stills. However, 
the most practical way to render 
Mimic data is to export to a Poser 
PZ2 fi le. This fi le can then be easily 
applied to characters within Poser or 
DAZ|Studio and rendered. 
Applications such as Carrara 4 Pro 
and Shade 7 are capable of importing 
entire Poser scenes and animation 
data, thus providing Mimic users with 
better and faster rendering than is 
possible in Mimic or Poser. 

Lightwave users get the best deal. 
The Mimic 2 plug-in (£160.61) works 
directly within the Lightwave 
environment – no exporting or 
importing needed. Hopefully, DAZ 
will consider developing Mimic plug-
ins for other apps – 3ds max, 
Cinema 4D or even Carrara Pro – 
thus allowing users to bypass Poser 
or DAZ|Studio completely.

Mimic sports an easy-to-use 
interface, though it would be nice to 
see more preferences and 
improvements for scrubbing. 

MAC Yes    PC Yes

PRICE

Full version: £107.07 
Upgrade: £53.52 
Lightwave plug-in: £160.61 

CONTACT

DAZ Productions
www.daz3d.com
1-800-267-5170

FEATURES

•  Multiple timeline tracks for 
Phonemes, Expressions, 
Gestures and Audio

•  Fine control over gesture 
and phoneme morphs

• Import Poser characters
• Export PZ2 fi les 
• Movie and Flash export
• 3D lighting
•  Real-time video synch
• Enhanced camera controls

SYSTEM

MAC: Mac OS X, Poser (v3), 
G4 500MHz processor, 
128MB of RAM, sound card, 
speakers and microphone
PC: Windows 98, 2000, ME 
or XP, Poser (v3), Microsoft 
Windows Media Player, 
700MHz Pentium class or 
compatible, 128MB of RAM, 
sound card, speakers and 
microphone

FOR

• Facilitates facial animation
• Shallow learning curve
• Good documentation 
    and support

AGAINST

• Limited to facial animation
• Interface needs improvement
•  Lacks export options 

VERDICT

            

Although currently limited to 
facial animation, Mimic has a 
shallow learning curve and a 
comprehensive PDF manual. 
At only £53.52 for an upgrade 
and £107.07 for the full version, 
this great value app will free-up 
your time to focus on other 
aspects of animation projects. 

  AN AFFORDABLE LIP-SYNCHING AND CHARACTER ANIMATION TOOL FOR THE MASSES
 

RESOURCE

The DAZ website, 
www.daz3d.com, 
offers helpful 
forums for all 
DAZ software and 
products. The 
forums are 
moderated by the 
development 
team so it’s quick 
and easy to get 
answers to any 
technical issues. 

THERE ARE NO 
MORE EXCUSES FOR 
SLOPPY ANIMATION

March 2005   | 83

ABOVE: Open Mimic and you’ll fi rst encounter the 
Session Manager, which allows the user to 
select or record the audio fi le and the character. 

LEFT: Mimic’s interface is pretty easy to use. 
The Display window provides real-time 
feedback while the Timeline tracks allow fi ne 
control over lip-synching and facial expression. 
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REVIEW

THE SCANNER TAKES  
ON COLOUR AND MONO 
AT A REASONABLE PACE

The rise of the multi-function 
device over the past few years 

has found the major printer and 
scanner manufacturers doing their 
level best to cram as much 
technology as they can into a single 
package. The move makes sense, 
though, as improvements in 
technology continue to drive prices 
ever downwards.

The Lexmark X7170 falls straight 
into this hybrid category. It’s a neat 
and compact printer, scanner and 
fax all-in-one that comes in at under 
£200. It even fi nds time to help you 
out with the creation of PDFs. 

Aimed squarely at the small 
business or home worker, the X7170 
is certainly not looking to take on 
professional scanners or printers, 
hence it’s low price tag, but it does 
offer all the day-to-day functionality 
required by a small studio. 

But how does the X7170 perform? 
Printers are Lexmark’s key area of 
expertise, of course – and many have 
a reputation for speed – so you’d 
think the X7170 would perform just 
as well. Not quite. In fact, in terms of 
straightforward printing it was 
disappointingly slow, outputting 
pages at a draft speed of 15ppm 

Lexmark X7170
(colour) and at 22ppm (mono), with 
normal speeds of just 6ppm (colour) 
and 15ppm (mono).

Print quality, especially in colour, 
is hardly breathtaking, with 

smudging on mono prints and 
blurring in colour, but at this price 
and with all those extra features, this 
quality is perfectly acceptable. 

However, when it comes to 
scanning images, the X7170 does a 
much speedier job, taking on both 
colour and mono subjects at a 
reasonable pace. Mono pages 
appear in 25 seconds on normal 
settings and colour images take just 
over a minute. Results, again, are 
mixed, with some fi ne detail and 
shading lost along the way. 

One real bonus is the bundled 
Lexmark Productivity Suite, which 
offers a number of ways to create, 
share and manage your documents, 
including basic image enhancement, 

PDF creation and the ability to scan 
and edit text. This package may be 
basic, but it’s easy to operate and 
likely to prove useful. Using the 
Manage Photo feature, for example, 
you can resize, enhance and 
reposition images from within a 
library and then print them, fax them 
or turn them into a PDF fi le

In terms of overall design, the 
X7170 is housed in a sturdy silver 
and dark grey plastic shell, with a 
clip-in black plastic automatic 
document feeder that rests on top. 
The glass panel cover feels tough 
and opens stiffl y, making the X7170 
feel like a sturdy machine that will 
more than likely stand up to a good 
deal of everyday wear and tear.

The printer comes complete with 
a short set-up guide, but no manual. 
Still, it’s fairly easy to hook up and 
operate. It also comes with a 
standard one-year limited warranty, 
plus the option to phone a technical 
support line and seek help online. 

As a printer or scanner, the X7170 
is by no means the best performer in 
its price range, but as a versatile 
multi-function device for the cost 
conscious small business or design 
studio, it more than satisfi es.

MAC Yes    PC Yes

PRICE

£188

CONTACT

Lexmark
08704 440044 
www.lexmark.co.uk

FEATURES

• Four-colour inkjet printing
•  Up to 4,800x1,200dpi colour 

print resolution
• Up to 19,200x19,200dpi     
   enhanced scan resolution
• Fax functionality
• Productivity Suite software
• Sturdy design
•   150-page paper 
    input capacity
• USB 2.0

SYSTEM

MAC: Mac OS X 
PC: Windows XP

FOR

• Lots of functionality
• Cheap
• Robust, practical design

AGAINST

• Slow print speeds
• Disappointing print quality
• No manual

RESOURCE

Why not use some 
of the money you 
saved on the X7170 
to pay for an 
extended warranty? 
The Lexmark 
Service Pack can 
extend the 
warranty on your 
new purchase by 
up to four years. 
Visit the website or 
call 08704 440044 
to fi nd out more.

  LEXMARK DOESN’T QUITE LIVE UP TO ITS REPUTATION WITH THIS BASIC MULTI-FUNCTION DEVICE
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VERDICT
Although the X7170 disappoints 
in a couple of key areas, most 
noticeably in terms of speed and 
print quality, it still offers a great 
deal of functionality for just 
under £200, and will be of great 
interest to small offi ce users 
seeking a reliable, budget device 
for everyday use.

The X7170 crams an 
impressive amount of 
technology into its 
sturdy silver shell.
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REVIEW

Mention plug-ins to most 
designers and they’ll instantly 

begin to imagine faraway worlds, 
psychedelic patterns and a host of 
special effects to be criminally 
abused and overworked in 
Photoshop or After Effects.

But aside from the world of 
stunning visuals, a whole subculture 
of more restrained extensions and 
plug-in enablers also exist. While 
hardly exciting in visual design 
terms, these enable designers to 
automate and simplify many of the 
painstaking and tedious tasks that 
can make or break a job.

Chartbot, an app geared to work 
within InDesign and QuarkXPress, is 
one such device. It helps designers 
working on high-volume corporate 
briefs to create data-driven charts 
and graphs without ever having to 
leave their DTP program.

Usually, a designer would use 
Illustrator or Excel (perhaps even 
DeltaGraph) to prepare an 
Encapsulated PostScript (EPS)
fi le or PDF, then import the results 
into InDesign or XPress. A 
straightforward process, sure, but 
Chartbot’s developers reckon it’s a 

tad cumbersome for high-volume, 
low-cost print runs – with corporate 
brochures, for instance, where you 
regularly need to check and even 
manually rework fi les at speed. 

Because Chartbot works within both 
InDesign and XPress and uses EPS 
fi les, you don’t need to pop into 
another app midway through design 
– which should seriously speed up 
the process of chart creation.

Once you’ve opened up an 
InDesign or XPress document and 
created a box for your chart, you 
simply import a Chartbot EPS fi le 
into your document, select the type 
of chart you want (line, bar or 
pie), then label the chart axes, add 
values, edit text and so forth in a 
series of on-screen boxes. Chartbot 
now creates the graphic from 
scratch. This basic procedure covers 

only the most elementary of charts, 
but the plug-in does enable you to 
customise your graphic to make 
things more interesting. For 
instance, by entering particular 
commands, you can angle the chart, 
add 3D effects, even change the way 
a plotted graph looks, among other 
options. The pie charts and bar 
graphics are undoubtedly the best
of the bunch.

Although results can be good, 
creating charts isn’t quite as simple 
as all that. The lack of dropdown 
menus – oddly, data is input via a 
series of boxes – makes the 
procedure more diffi cult than 
necessary, and gives the package a 
rather old-school air. You also need 
to enter values in a very specifi c way 
to activate an effect, which leaves 
things wide open for error.

Still, Chartbot comes with a 
detailed 123-page PDF manual that 
explains exactly how to create all of 
the effects you’re likely to need, and 
the results certainly look impressive. 
It’s just a shame creating the graphs 
isn’t as straightforward as it could 
be. The steep learning curve 
certainly doesn’t help. 

MAC Yes    PC Yes

PRICE

£569

CONTACT

Xchange International
020 7490 4455
www.xchangeuk.com
www.chartbot.com

FEATURES

•  Create charts and graphs
•  One-step chart creation
•  Auto-layout of labels

and values
•  Variable depth and

viewing angles
•  Alter colour, dashing and 

width of graphics
•  Supports CMYK and

spot colours
•  Reformat text and labels

SYSTEM

Works with QuarkXPress 4.1 
through 6.0 and InDesign 1.5, 
2 and CS
MAC: OS 9 or OS X; for 
printing: PostScript Level 2
or 3 printer (or compatible) 
only; for PDFs: Acrobat 5
or 6.0 Distiller only
PC: Windows, a PostScript 
printer or Acrobat Distiller

FOR

•  Great graphics
•  Works within XPress

and InDesign

AGAINST

•  Steep learning curve
•  Expensive

VERDICT

            

Chartbot’s ability to work as a 
chart and graph-creating 
solution from within InDesign 
and QuarkXPress, obviating the 
need to boot up another app, 
should be applauded. The 
results are uniformly excellent, 
but the process is a little tricky, 
which may deter some users.

  CREATE FULLY CONFIGURABLE CHARTS AND GRAPHS DIRECTLY WITHIN INDESIGN OR XPRESS 
 

RESOURCE

To see how 
this plug-in 
reconfi gures stats 
“live”, try out the 
online demo at 
www.chartbot.
com/ChartBot
Demo.htm. Note 
how the app 
intelligently 
recalibrates
the chart to suit
your changes.

PIE CHARTS AND BAR 
GRAPHICS ARE THE 

BEST OF THE BUNCH
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ABOVE: Chartbot caters for all kinds of 
diagram, from simple bar charts, like this…

LEFT: …to more complex creations. You can 
defi ne many parameters, including colour,
the size and format of text, and so forth.

Chartbot
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THE WORLD’S BEST–SELLING CREATIVE MAGAZINE

SUBSCRIBE TO THE DIGITAL EDITION NOW
WWW.COMPUTERARTS.CO.UK/ZINIO

ALL 
TUTORIAL 

FILES 
INCLUDED*

•   Get the digital version of the world’s 
best-selling creative magazine sent 
straight to your desktop

•   Receive 13 digital issues for just 
$75 (around £42)

•  Subscribe online now!
     *Due to licensing restrictions we cannot include CD software
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Get your hands on these great design reads

BOOKS

THE BEST OF BROCHURE DESIGN 8
AUTHOR: Willoughby Design Group
PRICE: £29.99
PUBLISHER: Rockport
ISBN: 1-592-53121-0
The eighth instalment in this long-running 

series rounds up the best of international brochure design 
and provides a wealth of ideas for choosing type, layout and 
photo treatments. One of the most diffi cult areas of design 
fi nally gets the attention it deserves.

 ALSO RECOMMENDED 

 BOOK OF THE MONTH 

PHOTOSHOP CS 
TRICKERY AND FX
AUTHOR: Stephen Burns
PRICE: £22
PUBLISHER: Charles River Media
ISBN: 1-584-50297-5

A standard and lengthy guide to a range of Photoshop tricks, 
focusing on creating fantasy images, animal-to-human face 
morphing and sci-fi  scenes. Good step-by-step instructions, 
but most of the images created are pretty cheesy.

SHADER X3 ADVANCED RENDERING 
WITH DIRECTX & OPENGL
AUTHORS: Wolfgang Engel
PRICE: £28
PUBLISHER: Charles River Media

 ISBN: 1-584-50357-2 
This collection of articles by industry experts provides an 
array of practical, ready-to-use shader tricks and techniques. 
Well illustrated and easy to follow, it’s an indispensable guide 
for those needing help with vertex and pixel shaders.

THE DESIGN ENCYCLOPEDIA
AUTHOR: Mel Byers
PRICE: £40
PUBLISHER: Laurence King
ISBN: 1-85669-349-X

While encyclopedic tomes covering dusty 
academic subjects such as fi ne art, architecture, 
typography and graphic design are fairly thick on 
the ground, the area of product and furniture 
design has been less well served. 

Aiming to fi ll that gap and address the subject 
through a wide-reaching and scholarly work is 
The Design Encyclopedia – a hefty book by 
design historian Mel Byers that sets out to 
provide a one-stop reference guide.

Covering a period from 1870 to the present 
day and backing up the 3,500 entries with over 
700 colour illustrations, The Design Encyclopedia 
provides an overview of the fi eld, from Alessi’s 
iconic and ubiquitous lemon squeezer to 
Zanotta’s much copied infl atable armchairs. 

While strong on hard facts, background 
biographies, key work and awards, The Design 
Encyclopedia falls down somewhat in terms of 
analysis and comparison. A major designer such 
as Charles Eames, for example, is allocated a 
fair chunk of space, but in a lengthy biographical 
round-up we learn only that he is one of the 
most “infl uential furniture designers of the 20th 
century”. There’s a year-by-year breakdown of 
major and minor work, exhibitions and suggested 
further reading lists, but we would’ve liked to see 
more examples of Eames’s most famous work 
and contribution to design history. 

Where the book succeeds, though, is in the 
sheer breadth of the subjects covered – from 
cutting-edge high-tech designers such as 
Apple’s head of industrial design Jonathan Ive to 
vacuum cleaner guru James Dyson; Byers 
covers pretty much everyone who ever took it 
upon themselves to design something.

If you want analysis, there are more in-depth 
books on individual periods and designers, but 
for a thorough overview, this does a great job. ©
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WORKSTATIONS

3D BOXX P90

GROUP TEST

I f you work in the creative industry, your computer 
could be called upon to perform a vast range of 

tasks – photo retouching, web design, video editing, 
3D animation and audio restoration to name but a 
few. Some of these tasks can be achieved using 
processors that are up to two or three generations 
old, but there are some applications that make even 
the most powerful processor appear sluggish. So 
when you move into video rendering or 3D, CPU and 
GPU (central processing unit and graphics processing 
unit) power is at a premium.

CPUs have become much faster and more 
sophisticated as manufacturers realise that mere 
megahertz can no longer provide the required 
performance gains. Innovations such as hyper 
threading, 64-bit memory access, and optimised 
multimedia extensions all help to boost performance.

When it comes to graphics processors, more 
complex instructions, as well as more versatile 
rendering engines, help today’s leading edge 

graphics cards to get more done in each clock cycle, 
in turn enabling the cards to handle more detailed 
and realistic scenes in real-time.

Factors such as fast memory and hard-drive speed 
can also play a part in the creation of a computer that 
feels livelier and more productive to use.

We sought out fi ve of the leading workstation 
manufacturers and requested systems that would be 
ideal for serious creative users, ranging in price from 
£2,000 to £5,000. Although we didn’t specify an exact 
processor or graphics accelerator confi guration, it’s 
interesting to see that no one really agrees on what 
constitutes the perfect system. 

Some manufacturers opted for blistering 
performance, some chose more affordable systems, 
and others concentrated on the graphics sub-system. 
So read on to fi nd out who, in our opinion, provided 
the best workstation in town…

Illustration by Scott Hansen, www.iso50.com

PRECISION 670MT P90

INTELLISTATION P91

RM WORKSTATION P92 

3D WORKSTATION  P91
Today’s workstations must perform a multitude of tasks to satisfy the needs of ever-demanding 
designers, but just how powerful do they need to be? We test fi ve of the best to fi nd out
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W e at Computer Arts were 
interested to see how one of 

the biggest North American 
specialist manufacturers would 
compare to the best the UK had to 
offer and were immediately 
impressed by the custom case, and 
the presentation, of the 3D Boxx 
system. The machine, manufactured 
by Boxx Tech, is impeccably 
constructed and tidily assembled 
with no fl apping wires inside. There’s 
plenty of room for expansion too, 
with space for four extra hard drives 
and three 5.25-inch drives. 

The system uses dual 2.4GHz 
Opteron processors, the fastest 
Opteron-based solution in this 
round-up. In fact, when it comes to 
benchmarking, the Sandra 
Dhrystone MIPS (million instructions 
per second) and FPU MFLOPs 
(millions of fl oating point operations 
per second) tests placed it second 
only to the RM machine with its dual 
3.6GHz Xeon processors.

The system includes a Quadro FX 
4000, of which we had great 
expectations. After all, this card’s on a 
par with the 3Dlabs Realizm 800 and 
costs £1,500. True to form, the 
SpecView Perf 8 scores placed it 
second only to the ATI FireGL 7100 in 
the RM machine – something of a 
surprise when you consider that the 
7100 costs about half as much and 
offers 50 per cent more performance.

The system boasts 2GB of 
DDR400 memory confi gured in dual 
channel mode for optimum 
bandwidth, and four extra slots for 
further memory upgrades.

We were impressed by the hard 
disk sub-system, too. Two 
10,000RPM 74GB SATA drives are 
striped together via RAID to provide 
a group-winning 68MB per second 
of sustained transfer rate. 

This system has a long warranty 
of three years, but its return to base 
terms will mean great inconvenience 
should you need to use it.

A FUNCTIONAL BUT FEATURE-HEAVY PROGRAM THAT MIGHT JUST SURPRISE YOU
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Dell’s Precision 670MT is an off-
the-shelf workstation, with a 

few minor modifi cations, so you’d 
think that the machine would be as 
optimised as possible. But sadly not. 

The Precision uses the same dual 
3.6GHz Xeon processors as the RM 
workstation, yet for some reason it 
underperforms in both sets of 
processor benchmarks. But it’s the 
fl oating point tests in which the 
system fares particularly badly, and 
this shortfall results in a rendering 
time that’s some 25 per cent slower 
than the RM system. 

Whether this slow render time 
comes down to differences in 
motherboard architecture, memory 
confi guration, or some even less 
obvious factor, we can’t be sure, but 
the slow rendering feels almost as if 
hyper-threading has been disabled, 
although we wouldn’t expect this to 
factor in the FPU results.

The Precision workstation is the 
only system with 2GB of RAM and  

offers two 1GB sticks instead of four 
at 512MB. This increases your 
upgrade options – an important 
factor for a system that’s 
theoretically capable of addressing 
exabytes of memory thanks to its 
impressive extended memory 
architecture processors.

The system only comes with an 
FX1300 graphics card, which sits at 
the entry-level of nVidia’s 
workstation cards. It’s certainly 
capable, but many times slower than 
the group leaders. As a result, while 
this system can handle 3D perfectly 
well, you really wouldn’t want to 
handle large, complex scenes with it 
on a regular basis.

The Precision 670MT has a 
custom case that weighs a ton, and it 
appears to have a non-standard 
motherboard too, but everything you 
see inside is beautifully designed. 
However, from experience, Dell 
systems can be pretty pricey to 
repair if anything goes wrong.

3D Boxx

RESOURCE

To make the most 
of customer 
feedback, the Boxx 
Tech website now 
features the work 
of a range of 
designers who use 
Boxx kit. To view a 
range of movie, 
animation and 
special effects 
work visit http://
www.boxxtech.
com/asp/cproj.asp

MAC Yes  PC Yes     PRICE  £3,715

CONTACT   +1 512-835-0400  www.boxxtech.com CONTACT    0870 907 5818  www.dell.co.uk

If you weren’t buying this workstation for 3D work, you’d want to knock 
as much as £1,200 off the price of this machine and choose a lesser 
graphics card. But overall, the 3D Boxx is extremely balanced and its 
true 64-bit processors make it a very popular choice.

VERDICT             
The Precision is not as powerful as it should be when you consider the 
expensive processors it boasts. But the budget has been allocated in 
other areas – the twin 160GB hard drives and massive custom server 
case, for example. This is an overpriced all-rounder, rather than a 
strong 3D workstation.

VERDICT             

MAC No  PC Yes     PRICE  £4,205.33

Precision 670MT
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B ased around dual Opteron 
processors, on fi rst sight the 

IBM IntelliStation seems an ideal 
workstation solution. The Opterons 
provide performance which – clock 
speed for clock speed – exceeds the 
Intel processors. 

There’s just one problem. While 
the Opterons are available at speeds 
of 2, 2.2 and 2.4GHz, Intel’s Xeons are 
now available at speeds approaching 
4GHz. But of course it’s not all about 
speed, it’s about internal 
architecture. With its 64-bit design, 
the Opteron offers substantial 
improvements in memory handling 
in the correct environment. 

So, in terms of measurable 
performance, how does this system 
actually fare? Its raw processing 
power places it fi rmly in the middle 
of this Group Test, losing out to the 
2.4GHz Opteron and the 3.6GHz 
Xeon. However, benchmarks are 
fallible, and we place our trust in 
real-world tests. 

We loaded a 3ds max sample fi le 
scene and turned on Radiosity 
Lighting. The scene took 11 minutes 
and 47 seconds to render – the 
second slowest system, beating only 
the Armari 2GHz Opteron.

Many other factors affect a 
workstation’s performance: hard 
drive speed, memory architecture or 
system optimisation. The IBM 
IntelliStation has an incredibly fast 
dual channel SCSI system built into 
the motherboard, and with an 
impressive transfer rate of 64.8MB 
per second, it has a really fast hard 
drive, even at just 33GB.

The Quadro FX 3000 graphics card 
makes this a good 3D workstation, 
but again the system is not optimally 
confi gured because the identical 
card in the Armari system performs 
signifi cantly better.

At a whacking £7,107, you’d 
expect to be able to get this system 
up and running straight out of the 
box. But sadly, this is far from reality.
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E verything you know about 
workstations says this machine 

is wrong. It’s tiny. It’s bright red. It’s 
not at all upgradeable. It’s ultra-
quiet. It’s gimmicky. You’d be forgiven 
for moving on without giving it a 
second glance, but you’d miss out.

Some designers may require the 
ability to push gazillions of shaded 
polygons around the screen in real-
time, but in truth, the majority don’t 
need that kind of power. A balance 
between moderate processing 
power and moderate 3D acceleration 
in a stable, well-constructed system 
is perfectly acceptable. Furthermore, 
if you’re paying for offi ce space by 
the square foot, why buy systems 
that are heavy, produce a lot of heat, 
and occupy lots of space?

We were sceptical that such a 
compact system could match the 
performance of the other full-sized 
systems on test here, and were also 
concerned about its ability to dissipate 
heat. We needn’t have worried.

The 3D Workstation uses a 
Quadro FX3000 and its graphics 
performance is strictly average, yet 
strangely, it exceeds the OpenGL 
performance of the identical card in 
the IBM system. Measuring DirectX 
performance, both cards were 
comparable, and both performed 
badly. This isn’t the best platform for 
games development or testing.

The dual Opterons perform as 
you’d expect, and rate more-or-less 
at the bottom of the table. However, 
you should fi gure-in the 64-bit 
equation when the software fi nally 
becomes available.

The system isn’t really 
upgradeable. The only spare PCI slot 
is covered by the double-width 
graphics card, and nothing inside the 
case is easy to get to. But Armari has 
included loads of USB slots, and a 
combined seven-in-one fl ash card 
reader. Add to that Firewire and 
external SATA, and for most people 
there shouldn’t be a need to upgrade.

3D Workstation IntelliStation

RESOURCE

Want to see what 
IBM’s IntelliStation  
has to offer in a bit 
more detail? Visit 
http://www.
pc.ibm.com/uk/
intellistation/
index.html and 
take a look at the  
interactive Visual 
Tours that show 
off the entire 
range in three 
dimensions.

CONTACT     01923 225 550   www.armari.co.uk CONTACT      0800 169 1458  www.ibm.com/uk

The 3D Workstation may not be as powerful as the other workstations in 
this round up, and it does look a little quirky, but it is still a pretty serious 
machine that will be as comfortable rendering as it is handling large 
OpenGL-rendered datasets.

VERDICT             
The IntelliStation is a competent all-rounder, but it’s too slow, too 
expensive and untidily assembled. It does, however, have a great 
warranty! In our opinion, there are some far better machines available 
for a fraction of the price.

VERDICT             

MAC No  PC Yes     PRICE   £3,399.28 MAC No  PC Yes     PRICE   £7,107.75
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RM Workstation
Research Machine’s (RM) Nimbus 

terminals took the fun out of 
computing for a whole generation of 
schoolchildren, so it’s surprising to 
see that the company is now re-
branding itself as a supplier of 
professional workstations. What’s 
more, they seem rather good at it. 
Perhaps all those years of working 
within miserly local budgets has 
taught them a thing or two?

The system uses dual Xeon 
processors – the new processors 
with EMT (extended memory 
technology) built in – running at 
3.6GHz. This is Intel’s response to 
AMD’s true 64-bit processors. While 
it’s still not the same as 64-bit 
processing throughout, it does 
enable the CPU to use 64-bit 
memory addressing, and this 
overcomes a primary architectural 
limitation of 32-bit computers – their 

ability to communicate with only 2GB 
of memory (or 3GB with trickery!).

When we were benchmarking 
these processors, the noise levels 
from the machine rose dramatically. 
We assumed it was a misaligned CD, 
but it turned out to be the processor 
fans. RM says that this is due to the 
system’s graduated processor 
performance. The processors only 
deliver the power needed to achieve 
a task – a great power-saving 
feature, but in the design industry 
there will always be long periods of 
time when the processors are 
working fl at out. RM says that it’s 
looking into noise reduction systems, 
which we think it desperately needs.

The processors delivered the best 
scores in all of our tests, and the 
3ds max rendering test proved that 
these scores do translate into real-
world time savings.

The system’s PCI Express FireGL 
7100 graphics card was the group 
winner, exceeding the far more 
expensive Quadro FX4000 in every 
test. The fact that it also produced a 
superlative DirectX rating makes this 
a great all-round development 
platform for games – build models in 
OpenGL, and test them under DirectX.

But there is a drawback. Although 
this machine comes with 2GB of 
memory, the motherboard has only 
four memory slots, and these are all 
occupied. It would have better 
served the user if RM had used 1GB 
sticks instead of 512MB.

With few additional drive bays, 
and only four USB ports, this is not 
the most expandable of the systems 
on test here. Perhaps RM should 
have included more than just a 76GB 
drive. After all, you can buy 200GB 
drives for next to nothing.
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GROUP TEST

MAC No    PC Yes

PRICE 

£4,130

CONTACT

Research Machines
01235 826165  
www.rmt.co.uk

FEATURES

•  Dual Xeon 3.6GHz with EMT
•  2GB 400MHz DDR2 dual 

channel memory
•  256MB FireGL 7100 graphics 

card with dual digital/
analogue outputs

•  76GB Maxtor 7200RPM SATA 
hard drive

•  SoundMax integrated audio
•  Built in RAID
•  Sony 16X dual layer DVD writer
•  Windows XP Pro SP2

FOR

•  Fast
•  Well constructed
•  Versatile

AGAINST

•  One-year warranty only
•  Small hard drive
•  Very noisy

VERDICT

            

The RM Workstation is 
equally as adept at real-time 
graphics as it is at rendering 
and, as 64-bit apps appear, 
will become more powerful. 
RM cut corners on memory 
and a hard drive that 
undermines the machine, 
but it’s by far the best on test.

RESOURCE

Confused about 
the range of 
workstations on 
offer? Not sure 
which kit is best 
for you? Why not 
let Computer Arts 
help you out. Just 
visit www.
computerarts.co. 
uk/compareprices 
and we’ll do the 
hard work for you. 

    A SUPRISINGLY CLEAR WINNER FROM THE RECENTLY REBRANDED RM

ABOVE: Changing markets: Research 
Machines has made a successful move 
into the workstation space.

ABOVE LEFT: With just four USB ports, 
the RM Workstation offers limited 
connectivity options.

RECOMMENDED
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WORKSTATION 3D BOXX PRECISION 670MT 3D WORKSTATION INTELLISTATION RM WORKSTATION

PROCESSOR/S Dual Opteron 2.4GHz Dual Xeon 3.6GHz Dual Opteron 2.0GHz Dual Opteron 2.19GHz Dual Xeon 3.6GHz EMT

MEMORY 2GB dual channel 
DDR 400

2GB 400MHz DDR2 2GB 400MHz DDR 2GB dual channel 
DDR 400

2GB DDR 2

GRAPHICS CARD nVidia Quadro FX4000 nVidia FX1300 nVidia Quadro FX3000 nVidia Quadro FX3000 ATI Fire GL V7100

GRAPHICS INTERFACE AGP 8X PCI Express AGP 8X AGP 8X PCI Express

GRAPHICS MEMORY 256MB 128MB 256MB 256MB 256MB

MONITOR OUTPUTS 2xDVI 2xRGB 2xDVI or VGA 2xDVI 2xDVI

AUDIO nVidia NForce SoundMax Realtek AC97 Realtek AC97 SoundMax

DRIVE/S Pioneer 16x dual layer 
DVD/RW

DVD CD/RW Sony 16x dual layer 
DVD/RW

DVD/RW Sony 16x dual layer 
DVD/RW

USB 6xUSB 2 6 8 3 4

FIREWIRE Yes Yes No Yes Yes

HARD DRIVE 2x74GB 2x160GB 250GB Hitatchi Deskstar IBM-EXSX 36.4GB 76GB Maxtor 

DRIVE SPEED 10,000RPM/68MB/s 7,200RPM/51.6MB/s 7,200RPM/58.4MB/s 10,000RPM/64.8MB/s 7,200RPM/55.4MB/s

DRIVE INTERFACE SATA SATA SATA SCSI SATA

RAID? RAID 1 – mirrored RAID 0 – striped RAID 1 – mirrored Yes – but not confi gured 
by default

Yes – but not confi gured 
by default

OPERATING SYSTEM XP Pro SP 2 XP Pro SP 2 XP Pro SP 2 XP Pro SP 1 XP Pro SP 2

WARRANTY 3 years RTB 3 years NBD 1 year on-site 3 years on-site 1 year on-site

SCORE

PROCESSOR/S Dual Opteron 2.4GHz Dual Xeon 3.6GHz Dual Opteron 2.0GHz Dual Opteron 2.19GHz Dual Xeon 3.6GHz EMT

MEMORY 2GB dual channel 
DDR 400

2GB 400MHz DDR2 2GB 400MHz DDR 2GB dual channel 
DDR 400

2GB DDR 2

GRAPHICS CARD nVidia Quadro FX4000 nVidia FX1300 nVidia Quadro FX3000 nVidia Quadro FX3000 ATI Fire GL V7100

GRAPHICS INTERFACE AGP 8X PCI Express AGP 8X AGP 8X PCI Express

GRAPHICS MEMORY 256MB 128MB 256MB 256MB 256MB

MONITOR OUTPUTS 2xDVI 2xRGB 2xDVI or VGA 2xDVI 2xDVI

AUDIO nVidia NForce SoundMax Realtek AC97 Realtek AC97 SoundMax

DRIVE/S Pioneer 16x dual layer 
DVD/RW

DVD CD/RW Sony 16x dual layer 
DVD/RW

DVD/RW Sony 16x dual layer 
DVD/RW

USB 6xUSB 2 6 8 3 4

FIREWIRE Yes Yes No Yes Yes

HARD DRIVE 2x74GB 2x160GB 250GB Hitatchi Deskstar IBM-EXSX 36.4GB 76GB Maxtor 

DRIVE SPEED 10,000RPM/68MB/s 7,200RPM/51.6MB/s 7,200RPM/58.4MB/s 10,000RPM/64.8MB/s 7,200RPM/55.4MB/s

DRIVE INTERFACE SATA SATA SATA SCSI SATA

RAID? RAID 1 – mirrored RAID 0 – striped RAID 1 – mirrored Yes – but not confi gured 
by default

Yes – but not confi gured 
by default

OPERATING SYSTEM XP Pro SP 2 XP Pro SP 2 XP Pro SP 2 XP Pro SP 1 XP Pro SP 2

WARRANTY 3 years RTB 3 years NBD 1 year on-site 3 years on-site 1 year on-site

SCORE

GROUP TEST
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W e wanted this workstation round up to cover 
machines that would be suitable for a variety of 

creative disciplines. However, we soon realised that most 
projects either don’t require workstation performance, or 
require equipment so specialist that you’d need to build a 
custom machine from the ground up.

Nowadays, when people talk about creative 
workstations, they’re primarily talking about one of two 
areas of creativity: 3D or video. While video can require 
specialist hardware such as encoding and capture cards, 
genlocks and the like, the main attributes in a video 

workstation are large, fast drives, lots of memory and a 
powerful processor. By good fortune, the exact same 
attributes are the core of a powerful 3D machine too, 
although you can add a decent 3D accelerator to the list if 
you plan to handle large data sets. 

We tried to consider the balance of factors in a good 
workstation, and although price was not a major issue, 
value was. In other words, we didn’t mind spending a lot 
of money provided the cost was justifi ed. It quickly 
became apparent that most manufacturers primarily 
cater to the 3D market. With that in mind, we think you 

could knock as much as £1,200 off the price of some of 
these systems if 3D is not important to you.

It was easy to choose the winner. The RM Workstation 
offers outstanding performance in the two main areas of 
processing: 3D acceleration and general number 
crunching. That means that it’ll feel lively and responsive 
as you create your designs and, if you need to do any 
rendering, will make you wait the least amount of time 
per frame. With its EMT Xeon architecture, it also gives 
you the fl exibility to deal with 64-bit memory addressing 
when the software to support it becomes available.  

CONCLUSION

RECOMMENDED

TEAM LinG - Live, Informative, Non-cost and Genuine!
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BUYER’S GUIDE

MONITORS P98

DIGITAL VIDEO SOFTWARE P97

DVD WRITER P98

What sort of designer are you?

If you’re into motion graphics, the latest digital video 
software is a must, bolstered by the best plug-
ins you can afford, a decent DVD writer and a top 
monitor. Check overleaf for our recommendations.

For the best bargains online, remember to take a 
look at www.computerarts.co.uk/compareprices 

MOTION GRAPHICS 
DESIGNER

ILLUSTRATOR
GRAPHICS SOFTWARE P96
PRINTERS P96
LAYOUT SOFTWARE P96
GRAPHICS TABLETS P98

3D ANIMATOR
3D SOFTWARE P97
MONITORS P98
GRAPHICS TABLETS P98

WEB DESIGNER
WEB ANIMATION SOFTWARE P98
MONITORS P98

TEAM LinG - Live, Informative, Non-cost and Genuine!
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EYE CANDY 5: 
TEXTURES
Ten great Photoshop
plug-ins for effects, 
including fur, brick 
wall, reptile skin
and diamond plate
– all for only $99. 

BUYER’S GUIDE

GRAPHICS AND LAYOUT SOFTWARE

 NAME MAC
PC?

DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

ILLUSTRATOR CS Mac 
PC

Industry standard vector graphics software – a vital tool 
for anyone who needs to design for print or the web.

Adobe £511 www.adobe.co.uk 89 ★★★★   Offers smaller improvements across the 
board, but not exactly what you’d call a huge upgrade.

PHOTOSHOP CS Mac 
PC

The design daddy, the creative king, and the industry 
standard professional image editor. 

Adobe £605 www.adobe.co.uk 89 ★★★★   Plenty of improvements across the 
board make this a more versatile tool than ever.

FREEHAND MX Mac 
PC

An easy-to-learn graphics environment for designing 
illustrations and organising data for print/web or Flash.

Macromedia £299 www.macromedia.
com

82 ★★★★★  A rock-solid release that 
offers a plethora of invaluable tools.

INDESIGN CS Mac 
PC

Adobe’s DTP upstart comes of age as QuarkXPress-
killer InDesign approaches industry-standard status.

Adobe £716 www.adobe.co.uk/
products/indesign

67 ★★★★   InDesign now simply amazes – and
utterly trounces QuarkXPress.

PAINTER IX Mac  
PC

The number one natural media tool now delivers an 
Artists’ Oils system, a batch of KPT fi lters, and more.

Corel £249 www.corel.co.uk 102 ★★★★★ If you want realistic digital paint,
there really is no other option.

QUARK XPRESS 
6.5

Mac
PC

Latest iteration offers expanded Print Styles, 
expanded PDF generation and Vista Xtension.

Quark £1,169 euro.quark.com/en 104 ★★★    Not quite the InDesign killer many were 
hoping for, but the tweaks bode well for XPress 7.

SIZEFIXER PC Enlarge your digital images by a staggering 400
per cent with no loss in quality. 

FixerLabs £149 www.fi xerlabs.com 104 ★★★★  Makes some bold claims, but delivers
– you can stretch images to breaking point.

PRINTDEVIZOR 
1.0 

Mac
PC

3D print-fi nish simulator that avoids the expense of 
mock-ups or chromalins.

Stonecube £495 www.stonecube.
com

105 ★★★★  A great idea, especially if you work in this 
fi eld, but it fails to cater for Pantone colours.

PORTFOLIO 7 Mac 
PC

Leading asset-management software, now expanded to 
include a direct-to-web publishing feature.

Extensis $200 www.extensis.co.uk 100 ★★★★  Nothing can touch the power of this long-
respected and valuable asset management solution.

ACROBAT 7 
PROFESSIONAL

Mac 
PC

Assemble multiple fi les, design PDF forms and enjoy 
new-press tools with this latest version.

Adobe £464 www.adobe.co.uk 105 ★★★★  More evolution than revolution, this tool 
balances tweaks with new features.

FOLDUP! 3D 1.5 Mac 
PC

Feature-packed virtual packaging software that can 
turn your 2D designs into fully exportable 3D models.

Xchange 
International

£292 www.comnet-
network.co.jp

105 ★★★★ It’ll only appeal to specialists, but it works 
well and extends Illustrator’s abilities.

INSTANT PDF Mac 
PC

Streamlined Acrobat substitute with automatic PDF 
Queue set-up and job-in-progress monitoring.

Enfocus Europe £140 www.enfocus.com 106 ★★★★ This offers a wide range of functions, is 
relatively simple to use and delivers great results.
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NIK COLOR
EFEX PRO

PC Fantastic set of powerful digital photographic fi lters
for Photoshop and Paintshop Pro.

Nik Multimedia £280 www.nikmultimedia
.com

94 ★★★★  You could create the effects for
yourself in Photoshop, but they’d take longer.

SAPPHIRE Mac 
PC

Generate superb effects with this 175+-strong suite 
of movie-quality plug-ins.

GenArts $1,699 www.genarts.com 98 ★★★★  Without a doubt, the best plug-ins you can 
buy – but they come at a professional price.

PARTICULAR Mac  
PC

Neatly integrated After Effects plug-in suite, comprising 
natural and technical effects.

Trapcode £199 www.trapcode.com 99 ★★★★★  Stunning, beautifully put together
and boasting endless creative possibilities.

EYECANDY 5: 
TEXTURES

Mac 
PC

Ten Photoshop plug-ins, including Fur, Brick Wall, 
Diamond Plate, Marble, Reptile Skin and Swirl.

Alien Skin $99 www.alienskin.com 102 ★★★★  A fun, versatile and (mostly) useful set of 
fi lter effects that’ll suit pros and amateurs alike.

PATTERNMAKER
1.0

Mac 
PC

InDesign plug-in offering 15 individual patterns with 
highly adjustable parameters and a simple interface.

Teacup software £50 www.teacup 
software.com

106 ★★★   An effective way to create interesting 
background patterns for any InDesign document.

BACKDROP 
DESIGNER

Mac 
PC

Create an interesting array of backdrops in Photoshop, 
complete with confi gurable shadows and lighting.

Digital Anarchy $199 www.digitalanarchy.
com

106 ★★★★ Extremely useful, if a little pricey, and the 
interface makes things more diffi cult than necessary.

CREATIVE PACK Mac 
PC

Three great embossing fi lters (Boss Emboss, Organic 
Edges and Wavy Colour), plus Vibrant Patterns.

Flaming Pear $39 www.fl amingpear.
com

106 ★★★ A great set of tools that will help transform 
your images with a painterly look.

XENOFEX 2 Mac 
PC

14 specifi c effects fi lters that make full use of the 
popular Eye Candy interface.

Alien Skin $129 www.alienskin.com 106 ★★★★ A great performer, but the fi lters only 
answer specifi c needs. Great lightning, though.

SCATTERLIGHT 
LENSES

Mac 
PC

Provides a host of interesting diffusion, glow, soft focus, 
fog, stars and glitter effects.

Andromeda $98 www.andromeda.
com

106 ★★★★   A good range of lighting effects that 
work simply and quickly with the minimum of fuss.

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

PLUG-INS

HP DESKJET 
6540

Mac 
PC

Can print up to 30ppm (black) and 20ppm 
(colour). 150-sheet input tray and ink status alert.

Hewlett Packard £118 www.hp.com/uk 103 ★★★★ Not  feature-packed, but delivers good 
results in both colour and black and white.

HP DESKJET  
130NR

Mac 
PC

Large-format (A1+) printer with 64MB RAM,
automated 24-inch roll feed and auto paper cutter.

Hewlett Packard £1,600 www.hp.co.uk 104 ★★★★  An affordable and robust proofi ng 
machine that delivers impressive results.

COLOUR 
LJ 2550N

Mac 
PC

Fast warm-up time, 24ppm (mono) and 4ppm (colour) 
printing times and (upgradeable) 64MB RAM built-in.

Hewlett Packard £459 www.hp.com/uk 105 ★★★  A compact and elegant printer, but it 
desperately needs more memory.

PERFECTION 
2580 PHOTO

Mac 
PC

Colour fl atbed scanner with 2,400x4,800dpi, 
automatic fi lm loader and image-editing software.

Epson £99 www.epson.co.uk 105 ★★★★  A low-priced yet effective scanner that 
produces great images, fast. Great auto-loading.

SAMSUNG 
SLG-550 A4

Mac 
PC

Colour laser with built-in LCD, 1,200dpi resolution, 
duplex printing and PostScript Level 3 facilities.

Samsung £476 www.samsung.co.uk 106 ★★★ Capable font-handling and 1,200-dpi duplex 
printing is a boon, but it’s not for high-end design.

SCANNERS AND PRINTERS

WHAT TO BUY?

RECOMMENDED

RECOMMENDED

RECOMMENDED

EPSON PERFECTION 
2580 PHOTO
Colour fl atbed 
scanner with 
automatic fi lm 
loader and image 
editing software. 
Costs £99.

QUARKXPRESS 6.5
Classic page layout 
software gets a new 
look in version 6.5 
and costs £1,169.

ILLUSTRATOR CS
This industry-
standard graphics 
software is vital for 
all print designers.

TEAM LinG - Live, Informative, Non-cost and Genuine!
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BUYER’S GUIDE

 NAME MAC
PC?

DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

FINAL CUT
PRO 4

Mac Emmy Award-winning tool for editing and fi nishing in 
SD and HD formats. Used to produce many TV shows.

Apple £699 www.apple.com/uk/
fi nalcutpro/

86 ★★★★★  Final Cut Pro 4 is nothing short of 
superb. Excellent bundled applications, too. 

AVID XPRESS 
PRO

Mac 
PC

Sophisticated video editing tool aimed at the higher
end of the mid-range market.

AVID £1,527 www.avid.com/
xpresspro

91 ★★★★  Twice as expensive as Premiere – but
not different enough to warrant the difference.

FINAL CUT
EXPRESS 2.0

Mac Apple’s fl agship consumer video-editing app strikes a 
careful balance between features and affordability. 

Apple £199 www.apple.com/uk/
fi nalcut express

94 ★★★★  The best low-cost editing solution for DV, 
although effects may frustrate Pro users.

DVD 
WORKSHOP 2

PC Consumer-friendly DVD authoring software with many 
professional features, including real-time previews.

Ulead £259 www.ulead.co.uk 97 ★★★  Easy to use, but much of the (cheaper) 
competition has caught up since the release of v1.

FINAL CUT
PRO HD 

Mac The professional editing application with broadcast 
quality credentials is now HD compatible.

Apple £699 www.apple.com/uk 98 ★★★★★  Pro features and top interface
ensure this pro-level app always delivers.

AFTER
EFFECTS 6.5

Mac 
PC

Adobe’s industry standard app now includes better 
motion tracking and grain management tools.

Adobe £664 
(Standard)

www.adobe.co.uk 99 ★★★★   New and improved features make 
this an indispensable tool for the video pro.

PREMIERE
PRO 1.5

PC Video-editing app with improved project management 
and broader support for industry formats.

Adobe £616 www.adobe.co.uk 99 ★★★★   Premiere’s allegiance to Windows 
ensures superior integration with related titles.

MOTION 1.0 Mac Apple’s entry-level motion graphics software comes 
with Behaviors and stacks of effects fi lters.

Apple $299 www.apple.com 102 ★★★★  Simple and intuitive to use, with many 
advanced features, Motion 1.0 delights on all levels.

VIDEO
STUDIO 8

PC This DV editor offers 128 transitions, DVD authoring 
functionality, and fi ve audio fi lters.

Ulead £50 www.ulead.co.uk 103 ★★★★ Offers a wealth of fl exible presets and 
effects fi lters, but unsophisticated editing tools.

POWER
DIRECTOR 3

PC DV editor with great titling functions, plus 122 
transitions and 24 video fi lters.

GoCyberlink £50 www.gocyberlink.
com

103 ★★★   Will certainly get the job done if you’re on a 
budget, but the DVD authoring is as basic as can be.

LET’S EDIT Mac
PC

DV editor offering 96 standard wipe transitions, 
a built-in wipe customiser and 26 video fi lters.

Canopus £99 www.canopus-
uk.com

103 ★★★   Every dialog/menu boasts a wide range of 
options and controls, but it’s not that intuitive to use.

STUDIO PLUS 9 PC Enjoy 126 transitions, 16 video fi lters and DVD 
authoring with this multi-purpose DV editor.

Pinnacle Systems £60 www.pinnaclesys.
com

103 ★★★★   Probably the fastest way to achieve a 
finished production from your raw footage.

PREMIERE
ELEMENTS

PC Benefi t from unlimited video and audio tracks with 
this entry-level version of Premiere Pro.

Adobe £69 www.adobe.co.uk 103 ★★★★   Your work may take longer, but 
the results will speak for themselves.

VIDEO
TOASTER 4

PC A complete TV studio, with post-production suite 
thrown in. Includes LightWave 3D and Aura.

NewTek £2,299 www.newtek.com 105 ★★★★ Impressive specs, but you’ll need a
high-end system to exploit those pro features.

DIGITAL VIDEO
WHAT TO BUY?

RECOMMENDED

3D SOFTWARE
SHAKE 3.5 Mac 

PC
Small but effective update for Apple’s industry-standard 
compositing and visual effects application.

Apple £2,099 www.apple.com/uk/
shake

99 ★★★★★  Excellent colour correction tools 
from Apple’s pricey but powerful app.

3DS MAX 7 Mac 
PC

A popular choice for 3D artists, thanks to its broad 
toolset and Normal Mapping feature.

Discreet £2,695 www.discreet.com 105 ★★★★  Feature-rich, but it’s beginning to show 
its age. Expensive, too, but many pros swear by it.

MAYA 6 Mac 
PC

Acclaimed industry-standard visual effects package 
that delivers a host of great features.

Alias £1,470 www.alias.com 105 ★★★★  A great app for the die-hard character 
animator or effects artist.

CINEMA 4D R9 Mac 
PC

Modular design (character animation, 3D painting, etc) 
gives Cinema 4D the edge in terms of fl exibility.

Maxon £2,199 www.maxon.net 105 ★★★★  A superb all-purpose 3D system 
that can tackle most 3D scenarios.

MOJOPACK Mac 
PC

Compendium of planets, plug-ins, terrain maps and 
tutorials for planet/landscape-generator MojoWorld.

Pandromeda $99 www.pandromeda.
com

105 ★★★  An interesting collection, but hardly a 
substitute for a full-on MojoWorld update.

ZBRUSH 2 PC V2 of this innovative 2D painting/3D modelling hybrid is 
faster than ever and boasts hi-res mesh support.

Pixologic $489 www.pixologic.com 98 ★★★★★  A stunning 3D package that sets
a new standard for detailed polygon modelling.

LIGHTWAVE 8 Mac  
PC

Ten years on, NewTek’s 3D stalwart can still cut the 
mustard, thanks to its strong rendering performance.

NewTek £995 www.newtek.com 105 ★★★★ A great all-rounder, with a relatively easy 
learning curve. Weak character tools, though..

SOFTIMAGE
 XSI 4.5

PC Arguably one of the best balanced high-end 3D apps 
in terms of features. Caters for NURBS.

Softimage £1,082 www.softimage.com 105 ★★★★   Superb rendering and a solid character 
toolset. Not all that easy to use, though.

AMAPI 7 PRO Mac 
PC

Latest iteration of Eovia’s classic app now comes with a 
new NURBS kernel and Dynamic Geometry.

Eovia $799 www.eovia.com 101 ★★★★  A powerful NURBS modeller for the 
professional designer, modeller or animator.

VUE 5 ESPRIT Mac 
PC

The famous 3D landscape generator now comes with 
Radiosity, GI and HDRI rendering.

e-on software £171 www.e-onsoftware.
com

103 ★★★★  Restricted plant generation and 
modelling tools, but a superb rendering engine.

CARRARA 4 Mac 
PC

The latest version of Eovia’s 3D modeller delivers 
improved inverse kinematics and a redesigned timeline.

Eovia £199 www.eovia.com 103 ★★★★  Easy for students and amateur designers to 
learn, but powerful enough to satisfy full-time pros.

PIRANESI 4 Mac 
PC

Distinctive 2D painting app, geared towards enhancing 
3D design. Natural media paintbox included.

Informatix £450 www.informatix.com 104 ★★★★  A true 2D/3D painting hybrid. The ability 
to import 3D objects is a real boon.

XARA X1 PC High-quality 3D modeller that offers unrivalled re-draw 
speeds and a powerful Picture Editor.

Xara £118 www.xara.com 106 ★★★★   It’s hard to fi nd fault with software this 
good and competitively priced. Easy to use, too.

IMAGE
MODELER 4

Mac 
PC

3D image-creating app, with scene-measuring tools 
and the option to export QuickTime VTR fi les.

RealViz 1,410 
euros

www.realviz.com 106 ★ A basic shareware 3D package could perform as 
well as (if not better than) ImageModeler 4.

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

VUE 5 ESPRIT
Just £171 will secure 
you this superlative 3D 
landscape generator.

AVID XPRESS PRO
Sophisticated video 
editing tool for 
professionals, but 
pricey at £1,527.

ULEAD DVD WORKSHOP 2
This DVD authoring for 
the masses, complete 
with real-time preview 
function, costs £259.

3DS MAX 7
Highly versatile 3D
app tailored towards 
the videogames and 
broadcast industries. 
Sets you back £2,695.
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SONIC DVDIT 5 PC DVD writing app that sits between Sonic’s entry-level 
MyDVD and the more advanced ReelDVD.

Sonic £171 www.sonic.com 100 ★★★  A useful introduction to the media for 
savvy creatives, but a little limited.

AHEAD NERO 6 
SUITE

PC A repackaged DVD version of the oft-bundled Nero 
burner, complete with NeroVision Express 2.

Nero 79 euros www.nero.com 100 ★★  An effective entry-level application aimed 
solely at consumers, not professionals.

ROXIO CREATOR 7 PC Complete with pro authoring component DVD 
Builder and a host of useful DVD-authoring features.

Roxio £70 www.roxio.com.uk 100 ★★   A comprehensive suite of tools that 
challenges the options of the Nero bundle.

APPLE DVD 
STUDIO PRO 3

Mac Features include render-free transition preview, 
alpha transitions and Photoshop integration.

Apple £349 www.apple.com 100 ★★★★   There’s no alternative for Mac users 
serious about creating DVD content. 

ADOBE ENCORE 
DVD 1.5

PC Features include DV menu previews, QuickTime fi le 
support and integrated/background transcoding.

Adobe £452 www.adobe.com 100 ★★★★   This app provides a strong
range of design and authoring options.

BUYER’S GUIDE

GRAPHICS TABLETS
NAME MAC

PC?
SHORT DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

NISIS EASYPEN G6 Mac 
PC

USB-friendly tablet: active area 304 x 228mm;
tablet dimensions: 385 x 347 x 12mm

Nisis  £90 www.nisis.com 99 ★★★  Nearly there in terms of features and 
usability, but there are irritating signal issues.

GRAPHIRE3 
CLASSIC XL

Mac 
PC

USB-friendly A5 tablet: active area 209 x 159mm;
tablet dimensions: 276 x 257 x 18mm

Wacom £200 www.wacom.com 99 ★★★★  Great all-round performer from 
Wacom, although not in the Intuos league.

INTUOS2 A5 
PLATINUM

Mac 
PC

USB-friendly A5 tablet: active area 203 x 162mm;
tablet dimensions: 334 x 258 x 14mm

Wacom £300 www.wacom.com 99 ★★★★    An incredible, feature-rich tablet 
that’s hard to fault. A5 tablets don’t get better.

INTUOS2 A4 
REGULAR PLAT

Mac 
PC

USB-friendly A4 tablet: active area 305 x 241mm;
tablet dimensions: 456 x 361 x 14mm

Wacom £400 www.wacom.com 99 ★★★★★  Customisable and easy to use,
this is everything you could want it to be.

WACOM INTUOS3 Mac 
PC

Redesigned A6, A5 and A4 tablets with scroll and 
Express Key functions, and new Pen Tablet System.

Wacom £130-£306 www.wacom.com 102 ★★★★  Wacom’s justly famous; these new 
tablets are set to attract even more admirers.

 MONITORS
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DVD STUDIO PRO 3 Mac Create a complete DVD in under 15 minutes with the 
latest iteration of Apple’s pro DVD creation tool.

Apple £349 www.apple.com/uk 99 ★★★★  Stacks of creative features 
make this perfect for the professional.

GO LIVE CS Mac 
PC

Adobe’s website design application is sometimes 
hailed as the Pepsi to Dreamweaver’s Coke.

Adobe £394 www.adobe.com 89 ★★★★  The refi ned look and the feel of this 
application make it better than ever.

DREAMWEAVER 
MX 2004

Mac 
PC

Build and maintain websites and applications with 
this powerful set of tools.

Macromedia £339 www.macromedia.co.uk 91 ★★★★  Good integration with Contribute; 
fully embraces Cascading Style Sheets.

STITCHER 4 Mac 
PC

Create high quality panoramas and 360-degree 
QuickTime VR animations in minutes.

RealViz 499
euros

www.realviz.com 95 ★★★★  Not the cheapest “sticking together” 
app around, but still one of the best.

TOON BOOM 
STUDIO 2.5

Mac 2D animation package that covers everything from 
scene-planning to preparing output for delivery.

Toon Boom $374 www.toonboom.com 98 ★★★★  A fantastic all-round package for 
anyone interested in 2D animation.

FRAME FORGE 3D 
STUDIO

Mac 
PC

Professional quality storyboarding 3D software – import 
scripts, pose fi gures, set up cameras, and more...

Innoventive 
Software

$349 www.frameforge3d.com 100 ★★★★   If you need to visualise your fi lm 
before shooting, this is an easy solution.

SWIFT3D PC The latest version of the Flash 3D app has matured
– check out the enhanced modelling environment.

Electric Rain $189 www.eran.com 102 ★★★   Approachable and easy to master with 
a great modelling environment.

FLASH STUDIO 
PRO2

PC Enjoy more power and greater functionality in this 
latest iteration of the industry’s leading SWF2EXE app.

Multidmedia £130 www.multidmedia.com 103 ★★★★  An essential Flash utility for 
designers who know their limitations. 

CAPTIVATE PC Redeveloped version of RoboDemo, a screen capture 
program ideal for distance learning applications.

Macromedia $499 www.macromedia.co.uk 103 ★★★★  Provides streamlined and 
professional results via a simple interface.

WEB, ANIMATION, CD/DVD

DVD WRITERS/AUTHORING

WHAT TO BUY?

RECOMMENDED

RECOMMENDED

RECOMMENDED

INTUOS3
The artist’s choice
– far more accurate 
for drawing than a 
mouse, and keenly 
priced from £130.

ADI MICROSCAN A904
A great choice if 
you’re looking for
a 19-inch LCD
under £400.

ADOBE ENCORE 
DVD 1.5
Encore includes 
everything you need 
to make movie-style 
DVD menus for £452.

SWIFT 3D
Add an  extra 
dimension to your 
Flash work with this 
fi ne 3D application, 
costing $189.

BENQ FP23W Mac 
PC

23-inch widescreen LCD can display 1,920x1,200 
pixels and boasts a contrast ratio of 500:1. 

BenQ £1,275 www.benq.co.uk 102 ★★★★  An impressive monitor that delivers 
in terms of both resolution and picture quality.

MICROSCAN A904 Mac 
PC

19-inch LCD with a resolution of 1,024x768 and 
500:1 contrast ratio.

ADi £395 www.adiuk.com 104 ★★★   A good budget entry monitor, with a 
punchy image that’s fi ne for low-level usage.

GALLERY 2010 
PLATINUM

Mac 
PC

20.1-inch LCD with a resolution of 1,600x1,200 and 
600:1 contrast ratio.

Formac £746 www.formac.com 104 ★★★  Gorgeous for day-to-day use, but lack 
of adjustability will dissuade graphics pros.

MULTISYNC 
LCD2180UX

Mac 
PC

21-inch LCD with a resolution of 1,600x1,200 and a 
400:1 contrast ratio.

NEC £1,291 www.nec.co.uk 104 ★★★★  A gorgeous display, compact yet 
easy to confi gure for precise image control.

SDM-P234 Mac 
PC

23-inch LCD with a resolution of 1,920x1,200 and a 
400:1 contrast ratio.

Sony £1,622 www.sonystyle.com 104 ★★★    Style-wise, it looks great, but design 
faults (that backlit logo on the bezel) irritate.

COLOREDGE
CG21

Mac 
PC

21.3-inch LCD with a resolution of 1,600x1,200
and a 400:1 contrast ratio.

Eizo £1,526 www.eizo.co.uk 104 ★★★★    A masterpiece – if colour 
accuracy is an issue, look no further.

APPLE 30-INCH
HD MONITOR

Mac 
PC

High-defi nition (2,560x1,600 pixels) display with 
400:1 contrast ratio and 170-degree viewing angle.

Apple £2,998 www.apple.com 106 ★★★★   A beautifully engineered display 
that’s ideal for professionals. Pricey, though.

 

RECOMMENDED

RECOMMENDED
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If you’re new to digital art and are looking to use your 
skills with natural media in a digital format, Painter IX 
is an essential purchase. 

Painter can replicate almost any form of natural 
media from watercolour to oils; mirroring the look and 
feel of their traditional counterparts, but with all the 
advantages of an editable digital format. 

The most noticeable improvements in this ninth 
Painter release are in the responsiveness and speed 
of its wide range of brushes and tools. Corel has 
worked closely with PC processor manufacturers
Intel and AMD, as well as a group of Apple hardware 
gurus, to fi nd out how to squeeze the most out their 
systems. As a result, the brushes are noticeably faster 
– in some instances up to ten times faster – which 
makes working with complex brushes much more 
responsive and intuitive. 

What’s new?
For keen artists, Corel Painter’s brushes are without 
doubt the most important feature and it’s this that 
sets Painter apart from other graphics packages. 
Painter IX includes over 30 brush categories, including 
acrylics, watercolour, oil paints, liquid ink, crayons, 
chalk and charcoal.

These effects work just as you’d expect. As with real 
watercolours, Painter’s watercolour brushes interact 
with your painting surface, “soaking” into the paper 
and revealing the textures beneath. 

Painter also offers a wide range of Paper types. 
Varying paper textures enable you to easily achieve a 
range of watercolour effects. A further enhancement 

to the Watercolour feature is the ability for the paint to 
stay “wet” between painting sessions, so now you can 
pick up where you left off or alter the wet fringe of the 
brush for impressive new effects.

But Painter IX’s best innovation is its new Artists’ 
Oils feature. This system imitates the way an artist 
works with an easel and paint brush, and the mixer 
palette makes it easy to mix and blend paints together. 
To load the brush, just dab on to the mixer palette, 
which charges the brush with a limited quantity of 
paint. Apply strokes and the paint will run out 
gradually as you paint. 

Painter IX provides almost every imaginable tool 
from your artists’ studio, enabling you to create 
convincing paint effects with the minimum of fuss.

Exclusive video tutorials 
Bjarne Kondrup, a passionate artist who traded his 
pencil and paper for a digital tablet, has created a 
range of Painter IX tutorials and brushes exclusively 
for Computer Arts readers. His website, Refl ection 
Design (www.refl ection-design.dk), draws constant 
inspiration from a number of online sources and his 
Painter artwork is proof of how, with practice, you can 
create images of an exceptionally high calibre.
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DON THE CDOOOOOOOOOOOOON TH

WELCOME
On this month’s cover CD 
you’ll fi nd an exclusive 
Painter IX starter kit, 
including a 30-day trial of 
Corel Painter IX, 60 minutes 
of video tutorials from 
Painter expert Bjarne 
Kondrup and a 100-minute 
VTC Corel Painter 8 video 
tutorial (for those of you who 
haven’t upgraded to Painter 
IX yet). You’ll also fi nd an 
exclusive seven-page 
Photoshop and Painter 
tutorial on page 25.

In addition, you’ll fi nd 15 
stock images courtesy of Flat 
Earth stock photography and 
ten fonts from URW, as well 
as the latest software demos 
of Mimic Pro 3.0, Twixtor and 
the latest version of Acrobat 
Reader 7. That should keep 
you busy. Enjoy!

Joe Russ
joseph.russ@futurenet.co.uk
NEW MEDIA CONTENT EDITOR

Everything you need to get started with Corel’s natural media painting/illustration app

FULL PRODUCT MAC & PC

PAINTER IX STARTER KIT

Painter IX provides faster, more responsive brushes and
tools to improve your natural media work still further.
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ON THE CD

VIDEO TRAINING MAC & PC

Painter 8 training courtesy of VTC
Make the most of Painter 8 with this professional training CD

VTC has created over 300 computer-
software training CDs, covering subjects 
such as graphics, animation and 
multimedia, internet and web design, 
programming and business applications.

The training tutorials included on this 
month’s cover disc consist of narrated 
QuickTime movies that will take you step by 
step through the process of mastering 
complex software applications such as 
Painter, Illustrator and Photoshop.

These three sample chapters from VTC’s 
Painter 8 CD cover all the basic skills you’ll 
need to get to grips with Corel’s app – the 
software, the workspace and a range of 
brushes. It’s easy to get started. You can 
use any other application simultaneously, 
so just call up one of the VTC chapters as 
soon as you require specifi c help with an 
unfamiliar task.

The fi rst three chapters of each VTC title 
can be freely viewed at www.vtc.com.

UPGRADE OFFER
To buy the full Corel Painter 8 training CD, call 01982 560 711 (UK only) and quote 
CA107 to get your copy for just £49 (inc VAT).

STOCK ILLUSTRATIONS MAC & PC

Flat Earth images
Get your hands on 15 free high-resolution images 

Flat Earth is an affordable royalty-free 
stock library that sells high quality, original 
images and video for use in a range of 
design projects. This month, they’ve 
provided us with 15 of their most popular 
images for you to use, free of charge.

The Flat Earth website currently boasts 
a wide range of images in a resolution to 
suit your needs – low-resolution 256-colour 
GIF images are suitable for web and screen 
purposes, and the high resolution 
(2,800x1,800), 24-bit images are of high 
enough quality to be reproduced in print.

Flat Earth also offers a range of images 
of high enough resolution to be used for 
large-scale designs such as posters and 
exhibition panels. For more information, 
visit www.picture-gallery.com.
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With the advent of the web and, more recently, 
broadband, the “wow” factor of interactive CD-ROMs 
has diminished somewhat. But CD-ROMs can serve 
high quality media, audio, video and high-resolution 
images almost instantaneously without the need to 
wait for hefty downloads. And what about those times 
when you don’t have access to a network connection? 
An interactive CD-ROM is a handy, portable medium 
for distributing your work, wherever you are.

iShell is a multimedia authoring package designed 
to create CD-ROM presentations from scratch. The 
software is similar to Macromedia’s Director in that 
you can integrate different forms of rich media, 
including video, sound and graphics, to create 
standalone presentations.

iShell is an object-orientated programming 
environment, so instead of dealing with lines of code, 
you visually create your projects from a series of 
objects which are “linked” together. For example, you 
might want to make a button that triggers a sound 
when pressed. Simply link a button graphic to a 

mouse-click event and an audio fi le and iShell will 
create the required code for the button to trigger a 
noise in your project. 

If all this talk of buttons and code makes your head 
spin, why not turn to page 66 and let Rick Lecoat take 
you step by step through the process of creating a 
mini-movie player? Once you’ve got your head around 
this object-orientated approach, you’ll quickly realise 
how powerful iShell really is. 

Once you’ve mastered iShell’s basic tools, you can 
try out some of the program’s more advanced features 
– QuickTime integration, for example. Unlike most 
multimedia authoring packages iShell integrates 
QuickTime into the authoring environment, so you
can use QuickTime functions such as streaming, 
dissolves, fi lters and masks. 

In addition, iShell fi les are platform-independent, 
so if you need to redistribute your project you can 
easily use them on both Mac and PC without the
need for conversion. iShell projects can also be 
deployed via QuickTime.

FULL PRODUCT MAC & PC

iSHELL 3

CREATE 
YOUR OWN MEDIA 

PLAYER WITH
OUR iSHELL 3 

TUTORIAL ON…

PAGE 66

 GET A LICENCE FOR iSHELL 3

To retrieve the commercial licence key provided
with this copy of Computer Arts, you must visit the 
Tribeworks website and enter your email address
and the code “iShellArt”.

Visit http://tribeworks.com/License/iShell
ComputerArts.asp, complete the form provided
and your licence key will be sent to you with 
instructions via email.

 UPGRADE TO iSHELL 4

iShell 4.0 boasts a range of new features that enable 
you to publish and deliver your iShell title with ease. 
Using this version, you can wrap all your media and 
documents into one fi le for distribution while providing 
the functionality to burn a cross-platform CD, without 
additional CD burning software. 

An upgrade to iShell 4 for Mac or PC is available
for $495, or $795 for both platforms. Just visit 
http://tribeworks.com.

Design and create interactive CD-ROMS with this full authoring package worth $795
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FULL LISTING

FREE FONTS
Try out ten URW fonts 

worth 1,000 euros, 
absolutely free!

PAINTER IX STARTER KIT (MAC+PC) 
TRIAL SOFTWARE Recreate superb natural media 
effects with this artistic paint package.

iSHELL 3 (MAC+PC) 
FULL SOFTWARE Complete package for creating 
interactive multimedia CD-ROMs.

iSHELL 4 (MAC+PC) 
TRIAL Get a taste of what the latest version of this 
brilliant application can do for you.

TWIXTOR (MAC+PC) 
VIDEO PLUG-IN Apply slow-motion effects to your 
movies with this powerful effects plug-in.

EYE CANDY 5 NATURE (MAC+PC) 
PHOTOSHOP PLUG-IN Add elemental effects such 
as fi re, smoke, water and ice to your work. 

MIMIC PRO 3.0 (MAC+PC) 
TRIAL Keep your character models in synch with 
this top-fl ight animation package.

ADOBE READER 7 (MAC+PC) 
PLUG-IN The latest version of Adobe PDF viewer 
enables you add comments to PDFs.

TEN URW FONTS (MAC+PC) 
FONTS Ten full free fonts from URW fonts.

FLAT EARTH IMAGES (MAC+PC) 
STOCK PHOTOGRAPHY 15 images free for you to 
use, courtesy of Flat Earth.

TUTORIAL FILES (MAC+PC) 
To fi nd this month’s supporting fi les, navigate the 
interface to “In The Mag” and select Tutorials.

PHOTOSHOP PLUG-IN MAC & PC

Eye Candy 5 Nature
Ten Photoshop fi lters to add fi re, smoke, rust, snow, ice to your images

Photoshop plug-ins vary greatly in quality and 
suitability. There are plenty of effects out there that 
can apply bizarre distortions and nauseating colours 
to your work, but only a few – like Alien Skin’s – are 
worth having, providing a range of “must have” 
effects that you can use again and again.

Eye Candy 5 Nature is the second in a series of 
Photoshop fi lters by Alien Skin. The fi rst, Eye Candy 5 
Textures, enabled you to create a wide variety of 
texture effects, including snake and lizard skin, fur, 
brick, stone and wood. Now Eye Candy 5 Nature 
expands the collection with a batch of new and 
equally impressive effects, among them realistic
fi re, smoke, water and ice, and even lighting fi lters. 
All fi lters are customisable (you can tweak intensity, 
colour opacity, etc), and presets are handily included 
for speedy one-click results.

TRIAL SOFTWARE MAC & PC

Mimic Pro 3.0
Put words into your 3D characters’ 
mouths with this lip-synch package

Words don’t come easily to 3D models; in fact, 
lip-synching is probably the most diffi cult 
aspect of character animation. Creating a 
detailed and realistic character model is all 
well and good, but if your character’s facial 
movements don’t match the words coming 
out of their mouths, your characters will 
appear dull and lifeless.

Mimic Pro 3.0 is an animation tool 
dedicated solely to the creation of realistic 
facial animations. Using a WAV audio fi le of 
your character’s voice (in any language), 
Mimic automatically synchronises the 
character’s movements with the audio fi le
you supply. As well as animating the lip 

movements, Mimic Pro 3.0 also enables you 
to create lifelike facial expressions (such as 
winks, nods and smiles) before you export
the animation timeline to Poser. Simple.

Use Nature’s easy-to-apply Squint 
(top) and Snow Drift (above and left) 
to transform your digital imagery. 
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CD DUPLICATION
DB Masters
• Short and long runs
• Competitive prices
• Fast turnaround
• A-Grade CDR 
• Thermal or screen print
Tel: 01795 597 755
Fax: 01795 597 766
Email: info@dbmasters.co.uk
Website: www.dbmasters.
co.uk

ILLUSTRATION,
3D ANIMATION & 
VISUALISATION
Arcana Digital
Animation, imaging and post 
production for broadcasting, 
interactive and print. Folio 
available online or call for a
CD sampler. Studio 15 minutes 
from Victoria. Clients include: 
Bray Leino, Citigate.A.F, DDB, 
Grey, JWT, Lowe, Masius, 
Ogilvy, OWN&P, Proximity, 
Publicis, RKCRY&R, Saatchi, 
TBWA, WTCS, WWAV.
Tel: 020 8466 0655
Email: john@arcanadigital.com
Website: www.arcanadigital.
com
Contact: John Fox

LARGE FORMAT 
PRINTING
Display Print
Services Ltd (dps)
It’s a big world out there and 
competition is fi erce, so how
do you create super-strong 
visual impact and really get 
noticed? By thinking big. Big 
graphics, big messages – and 
big pictures. As a specialist in 
large-format print and display, 
dps has all the know-how to 
transform your ideas into high 

quality reality. We can produce 
anything from point-of-sale 
items up to posters, banners, 
exhibition stands or even wrap 
up whole buildings.

Call us for more details of 
how we can help you to make
a big impression.
Tel: 01373 225555
Email: info@dps.eu.com
Website: www.dps.eu.com
Contact: David Wooster

RECRUITMENT
Corps Business
Corps Business is the most 
established and professional 
recruitment agency in the 
design, advertising and media 
industries. Since 1989, we
have been recruiting the top 
freelance and permanent 
creatives and developers. Our 
strict testing and screening 
procedure ensures that the 
people we supply can do what 
you want, when you want.
Tel: 020 7222 8484
Email: recruit@corps.co.uk
Website: www.corps.co.uk

TRAINING SERVICE
Corps Business
Corps Business is the leading 
UK authorised training centre 
for the top software houses, 
including Adobe, Macromedia, 
Apple, Maxon, Media 100, 
Extensis and Quark Systems. 
You can choose either a group 
or a tailored course, depending 
on your needs and abilities.
Our consultants are all very 
knowledgeable in the software 
and can advise you on which 
course would suit you best.
Tel: 020 7222 8484
Email: train@corps.co.uk
Website: www.corps.co.uk

Escape
Escape offers world-class 
training in 3D computer 
animation and 2D VFX for the 
creative industries and serves 
as a centre of creative 
excellence for both individuals 
and companies alike. The 
course programme has been 
designed in consultation with 
leading industry professionals.

Escape is the UK’s only 
authorised training centre for 
Alias’ Oscar®-winning 3D 
package, MayaR.
Website: www.escape
studios.co.uk 
Tel: 020 7524 7570.

Falmouth College of Arts
Are you passionate about the 
future of digital interactivity? 
The MA in Interactive Art & 
Design at Falmouth College of 
Arts, taught by renowned net 
artist Kate Southworth (www.
gloriousninth.com), offers 
radical new ways of working in 
Web design, digital sound art, 
net art and interactive 
installation art and design.
Tel: 01362 211077
Fax: 01362 213880
Email: admissions@falmouth.
ac.uk

Metro New Media
London’s leading training 
centre for Web design, 3D, 
animation, multimedia,
project management and 
programming
•  All trainers are professionals 

in their fi eld
• State-of-the-art studios
•  All levels from beginner

to advanced 
•  Specialists in customised 

training
• Discreet accredited
Tel: 020 7729 9992

Email: training@metronew
media.com
Website: 
www.metronewmedia.com

Central UK training
•  3ds max and all that 

goes with it
• Discreet certifi ed
•  Low client – tutor ratios

(four normally)
• High impact, short courses
•  Introduction, Intermediate, 

Character Animation, etc
•  Videogames and Texture 

Making
•  We can help you select the 

right courses
• Dedicated forum
•  More on the website, 

including student work.
Come and see.

Tel: 01926 613002
Email: info@central-uk.com
Website: www.central-uk.com 

XChange Training
The UK’s leading training 
specialists for creative 
professionals offer expert 
courses tailored to your training 
requirements. A wide range of
fl exible courses are available, 
including Adobe Acrobat, 
InDesign, Illustrator and 
Photoshop; Colour 
Management; Enfocus 
products for PDF workfl ows; 
FileMaker Pro; Macromedia 
Dreamweaver, Flash and 
Freehand; QuarkXPress and 
various 3D applications.
Tel: 020 7490 4455
Email: info@xchange
training.co.uk
Web: www.xchangetraining.
co.uk

WEB HOSTING
Dedicated Servers
The UK’s leading hosting 
company provides:
•  FREE and UNLIMITED phone 

& email support (24/7/365)
• Service level agreement
• State-of-the-art data centres
• Dedicated Control Panel
• Partner Programme
•  Windows, Linux, Sun, Cobalt 

and Co-location available
•  Host up to 200 Websites per 

server from £ 74.99 per 
month

Tel: 0870 3339738
Fax: 0115 9195514
Email: sales@dedicated-
servers.co.uk
Website: www.dedicated-
servers.co.uk

Netcetera
Formed in 1996, Netcetera is 
one of Europe’s leading Web 
hosting service providers. Our 
services are biased towards 
Microsoft-based Internet 
Technologies – Microsoft 
Certifi ed Partner since 1999. 
Netcetera provides complete 
solutions for Web hosting, 
Domain Name registration, 
ecommerce, e-mail, dedicated 
server hosting, server-based 
applications hosting (ASP) and 
.NETppliance.
Tel: 01624 612948
Fax: 01624 623385
Email: sales@inetc.net
Website: www.inetc.net

TO FEATURE IN THE CREATIVE DIRECTORY, EMAIL CA.ADVERTISING@FUTURENET.CO.UK

THE CREATIVE 
DIRECTORY
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THE BRIEF
Design a professional print-based poster
that successfully communicates a range of 
information about a specifi c product

“This assignment provided students with the 
opportunity to position themselves and gear their 
work towards the current market opportunities in 
information illustration. With a focus on print-based 
media, students were asked to prepare a distinctive, 
innovative and original image that included the kind 
of associated graphics often demanded by today’s 
print-based design practices.

“We hoped that the students would demonstrate a 
comprehensive understanding of information design 
technology and produce work that had a style 
appropriate for the professional work place. Each 
student needed to use research, analysis and 
judgment to transform their creative thinking into a 
suitable image.

“The students were free to investigate and apply
new technologies appropriate to information 
illustration. We wanted each student to display a 
creative and innovative approach to this brief, and to 
do well they needed to have successfully analysed 
the task, worked through a series of design options 
and identifi ed the production problems they could 
encounter before creating the fi nal piece.”

JOHN S FOX
SOFTWARE Form·Z, Illustrator and Photoshop

TUTOR’S VERDICT: “John has a passion for 
aviation and, as a result, has designed and 
produced a poster for the aviation enthusiast 
market. This involved the research, 
development and production of a full-colour, 
side-profi le, highly detailed cutaway and 
ghosted illustration of the Spitfi re, which was 
then incorporated within a poster design. The 
work, produced using modern technology, has 
resulted in a visually interesting solution to a 
traditional subject.”

EXPERT’S VERDICT: “John’s classic technical 
cutaway is presented in a very clear and 
concise manner that immediately catches the 
eye. The use of the “in-fl ight” image in the 
cutaway and the faded title type really adds a 
sense of dynamism to the piece. The solid type 
layout, which is understated and yet very 

legible, helps to balance the three different 
illustrations, and I also like the subtlety of the 
faded background, which echoes the diagonal 
fl ow of the piece and helps present the poster 
as a very “together” composition.”

THE EXPERT
NAME: Dan Moore
OCCUPATION: Dan is an award-
winning director of Studio Output, 
based in Nottingham, UK.
CONTACT: 
www.studio-output.co.uk

BLACKPOOL & FYLDE COLLEGE
It’s tough being a student. So how do talented undergraduates tackle their college 
assignments and, more importantly, do they make the grade? We ask the experts 

TOP OF THE CLASS

GOT A BRIEF? THEN TELL US ABOUT IT!
Let us know about a brief you’re working on at 
college and get positive feedback from a professional 
designer. Please email suggestions for suitable 
briefs to: sophie.embley@futurenet.co.uk, under the 
header “Student Brief proposal”.

THE TUTOR
NAME: Paul C Bennett
COURSE: (BA Hons) Information 
Design and Illustration
WEB: www.blackpool.ac.uk
TEL:  01253 352352
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MATTHEW DOLLEY
SOFTWARE Form·Z, Illustrator, Photoshop and InDesign

TUTOR’S VERDICT: “This layout and 
these images were produced as part of 
an advertising campaign to promote the 
public’s awareness of Seiko watches. 
Through the creative use of imagery
and typography, a successful and 

effective marketing solution was
quickly realised.”

EXPERT’S VERDICT: “These are great 
renderings, but the tinted image and 
layout don’t quite pull together.”

TUTOR’S VERDICT: 
“The purpose of this project 
was to produce a poster and 
video sequence to promote a 
new computer game. The 
results clearly demonstrate 
Arron’s creative visualisation 
abilities and his detailed 
knowledge of modelling 
techniques. The image is 
highly detailed and shows 
expertise in the use of texture 
mapping and lighting 
developed to match the 
environment. This gives 
an ambience to the scene that 
really involves the viewer.”

EXPERT’S VERDICT: 
“A solid, simple layout with 
some great rendered “wear
and tear” detail.”

ARRON PERFETTI
SOFTWARE  Form·Z, LightWave, Photoshop and InDesign

PETER MCMULLAN
SOFTWARE Form·Z, Photoshop, Illustrator and InDesign

GRANT WICKHAM
SOFTWARE Form·Z, Illustrator, Photoshop and InDesign

TUTOR’S VERDICT: “Peter’s objective 
was to produce an information poster 
featuring the Sopwith Camel. His use
of colour, subtle lighting and texturing 
cleverly emulates traditional airbrush 
techniques, but without resorting to a 
clichéd, computer-generated look.”

EXPERT’S VERDICT: “Superb 
illustration work here, although it’s
not quite matched by the type layout. 
However, I really liked the airstream 
motif used as the title bar along the 
bottom of the piece; this could’ve been 
maximised as a larger element.”

TUTOR’S VERDICT: “Grant worked on 
a collaborative project with Automotive 
Engineering MA students at Lancaster 
University. The team considered the 
work produced showed creativity in 
both product and visual design.”

EXPERT’S VERDICT: “Hanging the 
images off a symmetrical composition 
works extremely well in this piece, 
although the graphic and type 
elements become a little lost against 
the white background.”

THE BEST OF THE REST
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CURRICULUM VITAE

DAVID GENTRY

CV

LOCATION: Canterbury, UK
JOB TITLE: Freelance Illustrator
DATE OF BIRTH: May 1977

TRAINING: Self-taught

SOFTWARE: Photoshop

HARDWARE: Pentium 4 PC and laptop, 
both with Wacom Intuos2 A5 tablets

INFLUENCES: I’m often infl uenced by the 
random images and sounds I see and hear 
throughout the day. Listening to music while 
I work can greatly change how a fi nished piece 
looks, dependent on the band or composer. If a 
particular project feels a little daunting I will 
turn to my collection of art books. After 
browsing through the work of design greats 
such as Francis Bacon and Salvador Dali, or the 
modern genius of Phil Hale and Dave McKean, 
I can’t help but come away inspired.

STYLE: Odd and detached. I try to capture a key 
moment or feeling in a simple illustration using 
photographs and drawings. Previous comments 
about my work have ranged from “dark and 
twisted” to “pretty but disturbing”. I’m just trying 
to show everyone the world as it looks in my 
head, full of strange and interesting characters.

TELL US ABOUT YOURSELF: I’m currently 
teaming up with freelance illustrator Vincent 
Chong (www.vincentchong-art.co.uk) to create 
an interactive web experience based on the 
darker side of our artwork. In the future I’d love 
to progress from illustration into the fi eld of 
video games or even short fi lms. I have some 
dark tales to tell, all I need is an audience. I’d 
also love to do more book illustration, I really 
enjoy the process.

CONTACT: To see more of David’s work just visit 
his website at www.sixshards.co.uk or email 
davidgentry@sixshards.co.uk.

WE WANT TO HEAR FROM YOU!
Send us your CV, in the format 
shown, to ca.mail@futurenet.
co.uk, with the subject line “CV”.

 
“A concept piece for a 
possible website. Every 

few months I give my site a 
complete overhaul, changing 
it from the ground up. I try 
to treat the look and design of 
the site as an extension of my 
portfolio so that the whole 
experience stays relevant. 
One day I’ll make a decision 
to stick with a certain design.”

 
“Whenever I get the 
opportunity I try to spend 

a few hours drawing 
and experimenting for the 
sheer pleasure of it. This 
striking image is the result of 
one such occasion. Most of my 
experiments end up as 
textures or inspiration for 
later projects.”

“This is one of a series of atmospheric interior illustrations I created for the novel 
Redskins and Reefers. I’d love to illustrate a cover for a new Stephen King book.”

  
“Each year I think it’s important to try to fi nd the time to enter a few 
competitions. Greed is taken from my latest batch of entries.”
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